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The exercises assume that you have already installed MIKE SHE, and it is correctly
licensed (Demo or a Full License).

These step-by-step exercises are designed to illustrate the basic functionality
available in the user interface and the basic steps required for integrated
groundwater-surface water modelling.

Although these exercises are based on real case studies, they have been
significantly simplified to make the models run quickly. Thus, the parameter values
may not be representative of real world values. Therefore, the exercises are not
intended to illustrate best practices in integrated modelling.

Although the entire exercises will not run in the demo mode, the exercises can be
easily modified so that they will run in the demo mode by reducing the number of
nodes or the simulation length. The necessary changes are noted in the exercises.

As you do the exercises, you should initially take some time to look at the figures on
each page before reading the text. This should help you understand the exercise
instructions.

ring WATER DECISIONS iii



MIK@ MIKE SHE

Powered by DHI

iv Fully Integrated Exercises - © DHI A/S



| 2
Introduction MI KE

1 Introduction

In the hydrological cycle, water evaporates from the oceans, lakes, and rivers, from the
soil and is transpired by plants. This water vapour is transported in the atmosphere and
falls back to the earth as rain and snow. It infiltrates to the groundwater and discharges to
streams and rivers as base flow. It also runs off directly to streams and rivers that flow
back to the ocean. The hydrologic cycle is a closed loop and our interventions do not
remove water; rather they affect the movement and transfer of water within the hydrologic
cycle.

MIKE SHE is an advanced, flexible framework for hydrologic modelling. It includes a full
suite of pre- and post-processing tools, plus a flexible mix of advanced and simple
solution techniques for each of the hydrologic processes. MIKE SHE covers the major
processes in the hydrologic cycle and includes process models for evapotranspiration,
overland flow, unsaturated flow, groundwater flow, and channel flow and their
interactions. Each of these processes can be represented at different levels of spatial
distribution and complexity, according to the goals of the modelling study, the availability
of field data, and the modeller’s choices. The MIKE SHE user interface allows the user to
intuitively build the model description based on the user's conceptual model of the
watershed. The model data is specified in a variety of formats independent of the model
domain and grid, including native GIS formats. At run time, the spatial data is mapped
onto the numerical grid, which makes it easy to change the spatial discretisation.

MIKE SHE uses MIKE HYDRO river to simulate channel flow. MIKE HYDRO includes
comprehensive facilities for modelling complex channel networks, lakes and reservoirs,
and river structures, such as gates, sluices, and weirs. In many highly managed river
systems, accurate representation of the river structures and their operation rules is
essential. In a similar manner, MIKE SHE is also linked to the MOUSE sewer model,
which can be used to simulate the interaction between urban storm water and sanitary
sewer net-works and groundwater. MIKE SHE is applicable at spatial scales ranging from
a single soll profile, for evaluating crop water requirements, to large regions including
several river catchments, such as the 80,000 km2 Senegal Basin. MIKE SHE has proven
valuable in hundreds of research and consultancy projects covering a wide range of
climatological and hydrological regimes.

The need for fully integrated surface and groundwater models, like MIKE SHE, has been
highlighted by several independent studies. These studies show that few codes exist that
have been designed and developed to fully integrate surface water and groundwater.
Further, few of these have been applied outside of the academic community.

MIKE SHE has been used in a broad range of applications. It is being used operationally
in many countries around the world by organisations ranging from universities and
research centres to consulting engineers companies. MIKE SHE has been used for the
analysis, planning and management of a wide range of water resources and
environmental and ecological problems related to surface water and groundwater, such
as:

. River basin management and planning

*  Water supply design, management and optimisation
* lrrigation and drainage

+  Soil and water management

. Surface water impact from groundwater withdrawal
. Conjunctive use of groundwater and surface water
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+  Wetland management and restoration
*  Ecological evaluations
*  Groundwater management
+  Environmental impact assessments
*  Agquifer vulnerability mapping
*  Contamination from waste disposal
+  Surface water and groundwater quality remediation
*  Floodplain studies
+  Impact of land use and climate change
*  Impact of agriculture (irrigation, drainage, nutrients and pesticides, etc.)

The MIKE SHE user interface

£ MIKE Zero - [Karup_basic.she - Modified] m] e
@ File Edit View FRefresh Run Window Help - 8 %

DSE| & %=0[S 2| a]erum| ]
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‘:ug\as newsMIEE SHEWModel InputshGIS Dala\catchmenl.shp|
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Current Layer
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< of Fivers and Lakes *0. ¥
o Overland Flow [as4073 i [E220000 [tm)

- o Unsaturated Flow

- of Saturated Zone
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Map Projection Type:
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WY 0.Jcl Domain and Grid e Hr: Cel Size: Rotatior: _
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- of Climate

= o Land Use

Jado|dx3 palold G

« of Extra Parameters [meter]
6260000 1 - pllag g~ de oo
.
6250000 - - -
245000 - R RRRRRR ™ - - - - - -
6240000 7 S
62350007
6230000 F---------F--mmr s
6225000 (Y SRS s S
5 B 2
B 1
6220000 i ; [ Undefined Value
S > 500000 510000 520000
e [ T ] eter]
Vaﬁdatinn Simulation )\ MIKE 11 Execution Log /
Ready x = 504379 y = 6214300

MIKE SHE's user interface can be characterised by the need to

+  Develop a GUI that promotes a logical and intuitive workflow, which is why it includes

- A dynamic navigation tree that depends on simple and logical choices

- A conceptual model approach that is translated at run-time into the mathematical

model

Fully Integrated Exercises - © DHI A/S
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- Object oriented “thinking” (geo-objects with attached properties)
- Full, context-sensitive, on-line help
- Customised input/output units to support local needs

. Strengthen the calibration and result analysis processes, which is why it includes
- Default HTML outputs (calibration hydrographs, goodness of fit, water balances,
etc.)
- User-defined HTML outputs
- A Result Viewer that integrates 1D, 2D and 3D data for viewing and animation
- Water balance, auto-calibration and parameter estimation tools.

+  Develop a flexible, unstructured GUI suitable for different modelling approaches,
which is why it includes
- Flexible data format (gridded data, .shp files, etc.) that is easy to update for new
data formats
- Flexible time series module for manipulating time-varying data
- Flexible engine structure that can be easily updated with new numerical engines

The result is a GUI that is flexible enough for the most complex applications imaginable,
yet remains easy-to-use for simple applications.

In addition to the MIKE ZERO Project Explorer, the MIKE SHE document consists of 4
parts:

*  Along the top - the Tool bar and drop-down Menus

*  On the left - the dynamic Data tree and tab control

. In the middle - the context sensitive Dialog area

*  Onthe right - the Project Explorer

+  Along the bottom - the Validation area and Mouse-over data area

Tool bar - contains icon short cuts for many MIKE SHE operations that can be accessed
via the Menus. The Tool bar changes depending on the tools that are currently in use.

Data tree - displays the data items required to run the model as it is currently defined. If
you add or subtract hydrologic processes or change numeric engines, the make-up of the
data tree will change.

Dialog area - is different for each item in the data tree.

Validation area - displays information on missing data or invalid data items. Any items
displayed here are hot linked to the Dialog in which the error has occurred.

Mouse-over area - displays dynamic coordinate and value information related to the
mouse position in the map area of any of the spatial Dialogs.

Project Explorer - displays the list of files that are in the current project. This is only
active if the model is opened and edited via a Project File. Otherwise the section is blank.

Powering WATER DECISIONS 3
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2 Getting Started Exercise

2.1  Start MIKE SHE

2.1.1 Launch MIKE Zero

*  From the Program menu select MIKE Zero:

The Program Files menu looks different depending on your operating system and your
settings. In Windows 10 it looks like this:

=

B MiKe View 201

B MiKE Zero 2019
DHI Software Updater
Image Rectifier
Launch Simulation Engine
MIKE 21 C Gnd Generator
MIKE to Google Earth
MIKE Zero
MIKE Zero Documentation Index

MIKE Zero Release Note

MIKE SHE is part of the MIKE Zero suite of modelling tools, which is a global DHI user
interface for managing and manipulating data files and projects for many of the MIKE
Powered by DHI software products. Thus, when you launch MIKE SHE, you are really
launching MIKE Zero. MIKE Zero then provides the framework from which you can run
MIKE SHE or any other product in the MIKE Zero family.

Also notice in the Start Menu icons for

MIKE SDK - this is set of programming functions and documentation that allows you to
manipulate MIKE by DHI input and output files programmatically.

DHI License Administration — this launches a tool for managing your software licenses
MIKE View — This is a tool for evaluating the results of MIKE HYDRO River

Documentation — This links to a directory of all the installed documentation files

Powering WATER DECISIONS 5
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Release notes — Here you can find the latest information on the service packs that have
been installed

MIKE to Google Earth — This tool allows you to map your results onto Google Earth

6 Fully Integrated Exercises - © DHI A/S
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MIKE Zero

MIKE Zero is more than a set of modelling tools. MIKE Zero is a project management
interface, with a full range of tools for helping you with your modelling project.

2.2.1 Install the MIKE Zero examples (only if exercises installed with the
software)

The following section describes how you get started with the exercises if you have
installed them with the software. If you are installing from a USB-drive or similar,
please follow your course instructor’s guidelines.

The versions in the Program Files directory are read-only and provide you with an
uncorrupted version of the example files. The Install Examples button copies all of the
example files from the installation directory into your chosen directory for use in these
exercises. If you want to start over, then you can simply re-install the examples.

. Click on the [Install Examples...] button and then select to install all of the MIKE SHE
example files

. Select your Destination Directory to be the Documents/MIKE Zero Projects
directory

Now you have a local duplicate cop

EMBE[BEEERGE,

Examples
ERR=Tows

71 LITPACK

of the Examples Project for use in these exercises.

1-[)E) MIKE_11
3| {;}j MIKE_21
1-{T)-3) MIKE_21-3_Integrated_Models

[

!

Open an Existing P :
Name h &-{CE MIKE_3

I [

[

[

[

!

MIKE HYDRO River)| | # ) MIKE_FLOOD
MIKE SHE Exampiedl] | &= D MIKE_HYDRO
|-{¥)=) MIKE_SHE

#-{TJ-3) MIKE_ZERO
&5 uas

Destination Directory
C:\WUsers\dng\Documents\MIKE Zero Projects [Z]

[ Install H Cancel ]

Install Examples...

2.2.2 Explore MIKE Zero Features

Some features of the MIKE Zero main dialog are worth knowing about.

Toolbar

O =

New files can be created and existing files opened from the New, , and Open, ,

icons. There is a Save, el , icon that is active when you have a file open. However,
MIKE SHE automatically saves your model whenever you Pre-process the data or Run a
simulation.

Powering WATER DECISIONS 7
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Various other toolbars will be visible and active, depending on which files are open and
the context of your cursor.

File menu
£5 MIKE Zero - [Start Page] |

(&)(File] View Window Help

O New
] Open
Close
Close Project
Save Ctrl+S
Save All Ctrl+Shift+S
Save As...
Save Project As Template...
VCS Control
| Print Setup...
OI! Print Preview...
1 Print... Ctrl+P
1 Modified
1 Recent Files » 18/05/2016
i Recent Projects > 18/05/2016
1 Tod
Recent Log Files > s
Options 4 ‘ Edit Unit Base Groups...
Exit Alt+Fd ‘ Edit Map Projections...
{ Datum Convert...
Data Utility...
Install Examples...
User Settings...
Project Properties... 3
Install Examples...

Under the File menu, there are some useful functions related to the overall setup of MIKE
Zero.

Edit Unit Base Groups - this dialog allows you to change the default units associated
with any parameter in MIKE SHE. The list of parameters is very long because it includes
all parameters for all the MIKE Zero models by default.

. Note on working with Imperial units — By default, MIKE SHE works in Sl units. In
this dialog, you can load a template for US units. This will change all of the displayed
units in the MIKE SHE dialogs to Imperial US units. However, be aware that MIKE
SHE still works internally in SI. Thus, the log files etc are still written in Sl units.

Edit Map Projections — this dialog allows you to add new map projections or edit existing
map projects. The list is quite comprehensive, but your GIS organization may have
special requirements.

User Settings — this dialog contains some useful setting, in particular, it allows you to
change the default directory for new models etc. For example, if you always work on a
shared network drive, you may want to change the default.

Project Properties — if you are using MIKE Zero Projects, then you may want to change,
for example, the default location for your results.

Fully Integrated Exercises - © DHI A/S



Getting Started Exercise

2.2.3

If you are using this exercise in a course, you are welcome to ask your instructor at any

Getting help

time for help.

MIKE

Powered by DHI

However, if you are working on your own, there is an extensive on-line help.

*  On-line Help - The full Help can be accessed from the top Help... menu. For MIKE

SHE, this is the same as the full printed manuals.

[Help |

Help Topics

About MIKE SHE

. F1 Context Help - From within the Dialogs, context sensitive help is available by
pressing the F1 key. This takes you to a specific help page for the dialog that you

are currently viewing in the user interface.

[ MIKE SHE

|

=
Hide
; Getting Stated -

& o

Back Pamt Qpfions

@ Running MIKE SHE
4@ Results and Calibration
@ Suface Water

@ Drainage modeling with MIKE URE|

@ Groundwater
@ Addtional Options
@ Working with Data

A[) The MIKE SHE Reference Guide

- [2] Reference Guide Qverview
- () Setup Data Tab
@ Display

@ Simulation Specification

@ Water Qualty Smulation 5|
- Particle Tracking Specifica
- ECO Lab Template Specii
- (7] User Specified ECO Lab Cf

[7) Species
@ Water Quality Serption and|=
Model Domain and Grid

@ Subcatchments
- 2] Topography
- Climate

&

@ Rivers and Lakes

@ Ovedand Flow

@ Unsaturated Zone

(2] Grounduwater table for lowe|
- Satursted Zone/Subsurfac
@ Sources
@ Storing of Results

[7] Exra Parameters

@ Geometry
@ Water Qualiy Decay Proce
49 Water Qualty Sorption pro

@ Preprocessed Data Tab
@ Results Tab
@ MIKE SHE Editors

@ Technical Reference for Water Mo ™
] ,

Land Use

[V]Paved areas
[V] Check water level befare routing to river

[¥] Specify ma rate of change in storage depth

Inigation (Requires ET and UZ)

The Land Use item in the data tree is used to define the items that are on the land surface that affect the hydrology in your
model area, including

+  Vegetation distribution,
+  Paved areas (Paved Runoff Coeficient (p 114)), and

+ lmrigation.

Paved areas - The Paved areas option allows you to direct a portion of the overland flow directly to the SZ drainage network.
Activating the Paved areas option, creates a sub-tree with the Paved Runoff Coefficient (p. 114). The Paved areas option is
available only when Overland flow is simulated.

Check water level before routing to river - f this option is checked. then MIKE SHE checks to make sure that the water level
in the receiving river is lower than the drain level in the current cell. If the river is higher than the drain level then no paved
runoff will occur.

Specify max rate of change in storage depth - If this option is checked, then MIKE SHE will restrict the rate at which
ponded water is drained to the paved drainage function. This allows you to retain ponded water on a cell and drain it away at
a specified rate to the river.

Irigation - The Irrigation option allows you to specify a demand driven imigation scheme with priorities. Activating the
Irigation option creates several sub-items in the data tree for the irrigation parameters. The Irrigation option requires that
both E on and Ur d Flow be lated. For more information see Irigation Command Areas (p. 116)
Priority Scheme - The priarity scheme is used by the Irrigation madule ta rank the madel areas in terms of priority for
imigation. Twa optians are allowed: Equal Volume or Equal Shortage. If the water is to be distributed based on equal

volume. then all cells with the same prioritv number will receive an eaual amount of water. recardless of their actual

. Reference Manuals - The full documentation in PDF format can be accessed from

,

the Start Menu (Windows 7) or under the Apps in Windows 10.

Powering WATER DECISIONS
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l MIKE View 2017

, MIKEINFO 2016
. MIKE 5DK 2016
J MIKE View 2016
. MIKE Zero 2016
ﬁ DHI License Administration
=% DHI License Updater
23 DHI Software Updater DHI Software Updater
£ MIKE Zero
. Documentation
a LITPACK Documentation Index
a MIKE 3 Documentation Index
a MIKE11l Documentation Index  —
9.3 MIKE 21 Documentation Index
2] MIKE FLOOD Documentation In¢ =
9.3 MIKE HYDRO Decumentation I
9.3 MIKE SHE Decumentation Index |_

Image Rectifier

MIKE 21 C Gnd Generator

MIKE to Google Earth

a MIKE Zero Documentation Index

. Release Notes MIKE Zero
. Tools Ne
. Picasa3 - _
MIKE Zere Documentation Index
4 Back

MIKE Zero Release Note

ch programs ar

Underwater Acoustic Simulator

=

e[ |
{1 ot £27
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@@ 2] C:\Program Files (86)\ © = @& || & MIKE SHE Documentation
o N =

-

Pe

DOCUMENTATION  MORE INFORMATION ~ SUPPORT

Documentation MIKE SHE

The following documentation are available for MIKE SHE

E SHE User Manual, Volume 1: User Guide
SHE User Manual, Volume 2: Reference Guide
SHE Exercise Manual Basic Ex;
E SHE Toolbox, User Guide

es

More information

A top
* Release Note
+ Documentation Index for the MIKE Zero products
Please also see www.mikepoweredbydhi.com for any addifional information on MIKE SHE.
Support
A top

For general support, please see our FACL
If you experience any difficulties, or if you have any guestions, you can contact Client Care by mail, e-mail, phone, or fax

Client Care

DHI

Agern Allé 5
DK-2970 Harsholm
Denmark

mike@dhigroup.com
Tel: +45 4516 9333
Fax: +45 4516 9292

Or you can find your local Client Care with suppert in your local language here.

MIKE Powered by DHI - Agern Allé 5 - DK-2970 Harsholm, Denmark - Tel: +45 4516 9200, Fax: +45 4516 9292
mike@dhigroup.com - www.mikepoweredbydhi.com

MIKE SHE

Fully Integrated Exercises - © DHI A/S
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2.2.4 Technical Support

Not all answers can be found in the documentation and help pages. In these cases, we
are always available to answer questions via our Support Desk at mike @dhigroup.com.

You are also welcome to join our on-line user community at
http://forum.mikepoweredbydhi.com/. Here you can post questions and learn from other
users.

End of Getting Started Exercise.

Powering WATER DECISIONS 11
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3 Setting up a MIKE SHE Flow Model

The purpose of this exercise is to set up an integrated MIKE SHE model using predefined
inputs. Through the exercise, basic MIKE SHE operations are practised and you will
become familiar with various model tools for result processing.

The exercise is divided into two parts.

This section covers the following topics:

. Creating a model

. Setting up the model domain and grid

*  Adding the topography

. Specifying climate and land use

. Setting up the various modules: overland, unsaturated and saturated flow; and
. Controlling the outputs.

The second part, Section 4, covers
*  Running the model, and
. Using some of the post-processing tools to evaluate the results

The models in these exercises are based on the Karup River catchment in western
Denmark.

3.1 Create a new MIKE SHE setup

In the following steps you will be creating and building a new MIKE SHE model of the
catchment based largely on pre-existing data files.

ﬂ Ensure that you have installed the Example files in the previous Getting Started exercise

3.1.1 Create a new MIKE SHE document

All of the MIKE Powered by DHI documents can be created from the File\New\File...

[

menu in the top pull-down menu or by clicking on the New File icon, , in the toolbar.
When the New File Dialog appears,

*  select MIKE SHE in the bottom of the list on the left hand side,

«  select Flow Model (.she) on the right hand side,

«  click OK.

<3 New File =
Product Types: Documents:

=1 MIKE Zero ‘ ‘ '

=1 MIKE HYDRO
(= MIKE 11 el Editor U7 Sail ET Vegetation
1 MIKE 21 {owel) Propert...  Properties ...
= MIKE 3
I MIKE 21/3 Integrated Models
I LITPACK =
= MIKE FLOOD Water Balance  MIKE SHE
= MIKE SHE Calculation ... Toolbox (.mst)

A

Flow Model

Conce

Powering WATER DECISIONS 13
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The default MIKE SHE Setup Dialog will now appear.

The .SHE file contains all the user-specified information required to run MIKE SHE.
However, the file does not contain the actual time series and grid data. MIKE SHE only
stores the path names to the other data files for time-series data and grid data. This
greatly improves the flexibility of the user interface for keeping your model up-to-date with
new data and for running calibration and prediction scenarios

You can use the same New document dialog to select any of the listed file types on the
right hand side, or even navigate to one of the other items on the left hand side. For
example, you may need to create a water balance (.whbl) file during calibration, or a new
dfs0 time series file, which you will find under the MIKE Zero list.

3.1.2 Save the document file

The document file that you just created — in this case the .she document — is unnamed
until you save it.

To save the file:

*  Use the File\Save menu item, or the Save icon =

. In the Save Dialog type in a file name (e.g. MyFirstMSHE — the .she extension will be
added automatically)

*  Click OK

Save x

Save As

Mame: | MyFirstMSHE| |[she ]

Location: | C:\Users\dng'\Documents\MIKE Zero Projects\MIKE_SHEKarup_Basic |

Motes:

Add to Version Control Cancel

3.2  Set up the map overlays

14

In many projects, the first thing you may want to do is to define the maps and overlays
that you are going to use in your project.

MIKE SHE allows you to add graphical overlays using bitmaps, ArcView .shp files, etc.
These overlays will appear on all maps shown in the graphical view in the user interface.

3.2.1 Set the display area

The basic display area of the model map view is defined in the top item of the data tree
Dialog under Display:
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. Use your mouse pointer to select Display

The Display item is located at the top of the data tree to make it easy to add and edit your
background maps. In the Display item, you can add any number of images to your model
setup, in a variety of formats. The images are carried over to the various editors, so you
can keep a consistent display between the set up editor and, for example, the Grid Editor
and the Results Viewer.

The option ' Default map display based on the Model Domain' means that the map view
will be defined by the size of the model domain that you select in the next section of this
exercise.

However, in some cases you may want the displayed map area should be much larger
than the model domain, in which case you can define the map extents in this Dialog.

You can also import the extents from a shape or dfs2 file.

. In this case choose the setting Default map display based on Model Domain.

This is how it will look once you have defined your model domain, further on in this
exercise.

Default map display based on the Model Domain
Import comer coordinates from a grid or map file: Import

Lower Left comner Upper Right comer

X: 1494079 Y: 5220000 . | 526579 Y- 6261000

[meter]

s200000 4T il BpiE Ll —
62550003+ ---------------------- ---------------
6250000 rrrrrrrrrrrrrrrrrrrrr rrrrrrrrrrrrrr
6245000 ] rrrrrrrrrrrrrrrrrrrrrr rrrrrrrrrrrrr
62400003 N+ -------------------- -----------
6235000—~~~~~~«§~ rrrrrrrrrrrrrrrrrrr rrrrrrrrrrrr
6230000 --------------------- -------------

1 e ok, ¥l

6220000

500000 510000 520000

[meter]

3.2.2 Add overlays

Two overlays will be added: A shape overlay showing the catchment and an image
overlay showing a map of the area. In the Foreground Dialog under Display:

. Click on the Add ltem icon
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*  Choose the type “Shape”

*  Add another item, but now choose “Image”

Notice that a plus sign (+) appears beside the Foreground item in the data tree. This
indicates that sub-items have been added in the data tree.

The Background and Foreground options refer to the way the overlays are displayed
relative to the input data specified in the other Dialogs. Typically, you only need the
Foreground display active.

Also, if you have multiple overlays, the order that they are listed defines the order in which
they are displayed. Thus, you don't usually want a bitmap at the top of the list, since it
would hide all of the lower overlays.

Background

Current Layer Type | Display Overlay File
Simulation specification 1 Shape T

# Model Domain and Grid
o Topography

o Climate

o Land Use

o Rivers and Lakes

o Overand Flow

# Unsaturated Flow

o Saturated Zone

o Storing of results

o Extra Parameters

MIKE SHE Fow Model Description

-

EB-E-B-B

3.2.3 Define the shape file

Now click on the plus sign beside the Foreground item in the data tree to expand the data
tree. Then click on the sub-item “Shape: Unknown” to display the sub-Dialog.

In the dialogue you can also
. Choose line-colour

. Increase the line thickness (e.g. 0.5 or 1 mm)
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Display h
Shape File: Item:
| dse\MIKE_SHE'Karup_Basic\Model Inputs\GIS Data\catchment.shp ||| [ 0BJECTID |

Parameters for Points

Point colar; (= Point style: Transparent
Point Eype: Cirde
— | Text Annotation
Color as paint Background: Transparent
Individual color: |=

Parameters for Lines and Polygons

Line color: | NS |~ Line style: Solid ~
Palygon fil style: | Transparent ~
Line thickness: .3
-D Text Annotation
(®) Color as line/polygon Background: Transparent ~
() tndividual color: lig
Units
Units of X- and Y-axes:
meter ~

In the sub-Dialog:

«  click on the browse button, E , and find the file
AKarup_Basic\Model Inputs\GIS Data\catchment.shp

3.2.4 Define the image file

Now click on the subitem “Image: Unknown”. This shows you the following dialogue:

Display

Image File:

| CiVProjects\Karup_exerdse\MIKE_SHE\Karup_Basic\Model Inputs\Maps'imap.bmp |

Area Coordinates

e ¥
Mincoords: | 484935 |m] | 5220029 |[m]
Import geo reference from file...
Maxcoords: | 552440 |Im] | 6264854 |[m]
Image Styles
Display style: Blend colors e Transparentcolor: ||~

«  click on the browse button, E , and find the file
AKarup_Basic\Model Inputs\Maps\map.shp

Since a bitmap image does not contain any geographical information (it is simply a list of
pixel locations and colours), the bitmap must be oriented in space. To do so, you can
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either import the georeferenced coordinates from a world file or provide MIKE SHE with
the coordinates of the lower left and upper right corners of the bitmap.

+  Type in the coordinates as shown in the figure above
»  Click on Display to make the map visible

+  Setthe Display style as Blend Colors, which will blend the map colours with any
other displayed colours. This will prevent the bitmap from hiding the model data.

Add more layers if desired. Line themes for showing the stream (karup_system.shp) are
located in the same folder as the catchment file.

Note that these files will not be visible until you define your model domain, described
further down. Once this is done, you should see the files in all of your map dialogues.
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3.3  Set up the simulation

MIKE SHE includes several simulation modules. The navigation tree in the user interface
depends on your choice of simulation modules.

3.3.1 Select simulation modules

In the Simulation Specification Dialog, make sure that all the Water Movement items are
checked On. Make sure that:

*  Rivers and Lakes are on;
. Finite Difference is selected for the OL and SZ engines, and

«  the Richards equation is selected for the UZ engine.

MIKE SHE Flow Model Description
Doy | Simulation specification

Simulation specification

Model Domain and Grid Humeric Engine
Topography
Climate MIKE SHE
Land Use

Rivers and Lakes

Overtand Flow Wwater Movement [whd)

Unsaturated Fow Overland Flow [OL)
Saturated Zone Finite Dif
Storing of results inite Difference

Extra Parameters

Rivers and Lakes [0C)
Unzaturated Flow (UZ)

Richards equation

Ewapotranspiration (ET)
Saturated Flow [52)

Firite Difference -+

[ Include sdvection-Dispersian [40) 'Water Qualiy

" Setup Data |Processea D | Resuts | o - -,

ﬂ The Simulation Specification Dialog allows you to select which flow components to
include in your simulation. For example, if you want to include only the river and the
exchange to the saturated zone, then you only need to select Rivers and Lakes plus
Saturated Flow.
Not selecting some of the items can be a useful option during the initial model setup stage
when you are setting up and calibrating a complex model.

In this dialog, you chose the numeric engine for the different hydrologic processes.

*  There are three numeric engine options for the unsaturated zone and two each for
both the Overland flow and Saturated Flow.

*  The calculation method for the Evapotranspiration is automatically selected
depending on the Unsaturated Flow option selected.

*  The channel flow numerical method is selected in the MIKE HYDRO Setup.
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3.3.2 Specify the simulation period
In the Simulation period Dialog:

+  Specify the Start date and End date
- Start Date: 1 January 2003
- End Date: 31 December 2007

In this Dialog, you can either type in the dates or select the dates from a drop down
calendar.

MIKE SHE Flow Model Description ~
Desc | Simulationperiod

o Simulation specification
o Simulation title hlatal
¥ Simulation period [JUse hat start data
« Time step control
o OL Computational Control Paramet
o UZ Computational Control Paramet ...
¥ SZ Computational Control Paramet...
# Model Domain and Giid
« Topoaraphy Uze hot start date for simulation start date
o Climate
o Land Use
o PRivers and Lakes
 Overand Flow Start Date | 2003/01/01 00:00 [~
# Unsaturated Flow
o Saturated Zone End Date | 2007/12/31 00:00 b
o Storing of results
o Extra Parameters

O-&

-

Simulation Period

G-

< >

Setup Data |Processed Daiz Results v

Demo Note: If you are using a Demo version, then the maximum length of simulation
is 30 days. In this case you should use a shorter Simulation Period. For example, only
the month of January 2003

If your simulation runs too slowly, then you can reduce the length of the simulation
period without affecting the learning objectives.

requirement. However, it is convenient because the time-varying input data you specify
later is validated against the simulation period. Thus, when you specify a rainfall time-
series file, a check is made to make sure that the time-series covers the simulation
period.

I i Specification of the simulation period at this early stage in the model development is not a

In most cases, MIKE SHE is run as a transient model. If the model is run in steady-state,
then the steady-state solution also follows this simulation period, by generating a series of
identical steady-state solutions for each specified time step.

Typically, you will start the simulation from a Hotstart condition. The Hotstart allows you to
start the simulation from the end of a previous simulation. You will often create a ‘run-in’
simulation that allows the model to dynamically equilibrate. Then, start the actual
simulation at, for example, the end of a dry season.

20 Fully Integrated Exercises - © DHI A/S



Setting up a MIKE SHE Flow Model MIKE i b

Powered by DHI

3.3.3 Define time step parameters
In the Time step control dialog specify:
. Initial basic time step =2 hrs
+  Max allowed OL time step = 0.25 hrs
. Max allowed UZ time step = 2 hrs

*  Max allowed SZ time step =2 hrs

MIKE SHE Flow Model Description
o D (Tmestepcontol
=~ o Foreground )
o Shape: kamp shp Time Steps
; I?isabledd Image: D200_2015b... Initial basic time step 2 [hrs]
ackgrour
Current Layer tax allowed OL time step 0.25 [hrs]
=] Simulation specification I ax allowed U2 time step [hrg]
Simulation title .
o Simulation period Mas allowed S time step [hrs]
« Time step control
j 3; EompLerttaatti.onall ((::Dr:tmll F‘Paramtztt... Increment of reduced time step length
omputational Control Paramet...
o 57 Computational Control Paramet... Increment rate [0-1] 0.05
o Model Domain and Grid
+ Topography o i
o Climate Parameters for Precipitation-dependent time step control
B o Lj”d Use Max precipitation depth per time step (]
Vegetation
« Rivers and Lakes tdax infiltration amount per time step [mm]
o Overland Flow Input precipitation rate requiring its [rarn/hr]
o Unsaturated Flow EB D S
o Saturated Zone
o Storing of resutts
o Extra Parameters
< >
Setup Data |Pmoessed Datz | Resuss ‘

Demo Note: If you are using a Demo version, you should use an SZ time step of 4
hours, as you will otherwise exceed the number of saturated zone time steps.

MIKE SHE uses different time-steps for the different hydrologic processes. Normally, the
Overland flow time-step is the smallest and the Groundwater time-step the largest. The
river time step is controlled in MIKE HYDRO.

The overland flow time step is quite small because it is highly dynamic. The overland time
step has to be the same or larger than the MIKE Hydro Time step

Generally, the time steps are relatively small in this example because the system is quite
sandy and highly dynamic. In a less dynamic simulation, you would normally make the SZ
time step larger.

The Max infiltration amount and the Max precipitation depth per time step are used to
improve the numeric stability of the solution when there is ponded water on the ground
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surface. If the maximum values are exceeded, then the time step will be automatically
decreased until this limit is reached.

3.3.4 Simulation control

We will use the default values for all the solver parameters. Details on these parameters
can be found in the on-line Help.

Overland flow

You should use the default parameters for OL, but change to the Explicit solver. Leave
the Manning equation for calculating overland flow into the rivers.

If you want to calculate flooding, then the explicit solver is required. However, the time
step constraints on the explicit solver are more restrictive.

Solver Type and Solver-specific Parameters

() Successive Ovenelaxation [SOR)

200
0,000
0.0007
0.9

(®) Explicit [Recommended when overbank spiling iz allowed)

b amimum courant number; [0.1 - 0.9] [for adaptive time step]

[ Sub-divide overland Aow cells for multi-cell OL methad

2

Commot stability parameters

Threshold water depth for owverland ow: 0.000 [mn]
Threshold gradient for applying
low-gradient flaw reduction: 0.0001
Owerand-River exchange calculation
(®) Manning equation [using OL flow Manning numbers) [OL to River only)

Ignore bank level for flow ta river, check water levels only

(O Weir formula: [Weir data specified in MIKE 11] [Required for Overbank. spilling)

01

Unsaturated flow

Change Maximum no. of iterations from 50 to 250. Keep the other default UZ solver
parameters.
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Flow Model Description

=+ Simulation specification L\\,
& Simulation title
+ Simulation period
+ Time step contral
+ OL Computational Control Parameters
+ UZ Computational Control Parameters
+ 5Z Computational Control Parameters
+" Model Domain and Grid
' Topography
+ Climate
+ Land Use
+ Rivers and Lakes
+ Ovedand Fow
+ Unsaturated Flow
+ Saturated Zone
+ Storing of results
+ Exra Parameters

EH-E

- BB

] Setup Data  |Processed Data | Results

A
Uz Computational Control Parameter
UZ-5Z Coupling Control
Max. profile water balance error: 0.001 [m]
Richards equation parameters
Iteration Control
Maximum no. of iterations: 250
Iteration stop criteria (fraction of Psi): 0.002
Timestep Reduction Control (UZ Restart)
Max. water balance error in one node (fraction): 0.03
v

Richard’s equation for unsaturated flow may produce water balance errors if the time step
is large and the control parameters are set too loosely. Increasing the iteration control
parameters will however increase the runtime which may not be desirable.

Problems with the water balance are reported in the water movement run log file and
should be checked at the end of every simulation. It is also advisable to run the water
balance tool to make sure the model is performing correctly.

Saturated flow

You should use the default parameters for SZ including the default PCG Transient solver.

Change Maximum no. of iterations from 50 to 100. Keep the other default SZ solver

parameters.

MIKE SHE Flow Model Description
O Display L\»
=« Simulation specification
+ Simulation title
+" Simulation period
+" Time step control
+" OL Computational Cortrol Parameters
+" UZ Computational Cortrol Parameters
I8 57 Computational Cortrol Parameters
+ Model Domain and Grid
/' Topography
« Climate
' Land Use
+ Rivers and Lakes
' Overand Flow
« Unsaturated Flow
' Saturasted Zone
+ Storing of results
+ Extra Parameters

] Setup Data  |Processed Data | Results

Powering WATER DECISIONS

152 Computatonal Control Parameters

Solver Type

(®) Preconditioned Conjugate Gradient, Transient
(") Preconditioned Conjugate Gradient, Steady State
() Successive Overrelaxation Package (SOR)

Iteration Control

Maximum no. of iterations:

Maximum head change per iteration: [m]
0.0005 [m/d]

Maximum residual error:

Sink de-activation in drying cells

Saturated thickness threshold: [m]
Advanced Settings
Gradual drain-activation (Recommended)
[+#] Horizontal Conductance averaging between iterations (Recommended)
Under-elaxation
(®) No undertelaxation (Recommended)
() Under-relaxation with dynamic calculation of factor
() Under-relaxation with constant factor  (0.01-0,99): 0.93

Maximum exchange from river during one time step

Max. fraction of H-point volume:
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Set up the model domain

The model domain and the surface topography are required for all MIKE SHE
components.

The model domain defines the horizontal extent of the model area, as well as the
horizontal discretisation used in the model for overland flow, unsaturated flow and
saturated groundwater flow

34.1

Define the model domain

In the Model Domain and Grid Dialog:

MIKE SHE Flow Mode! Description
1 Display
= f Foreground
o Shape: catchment shp
o Image: kort bmp
Background
Current Layer
o Simulation specification
o Simulation title
o Simulation period
¥ Time step control
o OL Computational Control Paramet...
o UZ Computational Control Paramet...
o SZ Computational Control Paramet...
¥ Mode! Domain and Grid
¥ Topography
o Climate
o Land Use
f Rivers and Lakes
o Overland Flow
o Unsaturated Flow
f Saturated Zone
o Storing of results
o Detailed Time Series Output
o Detailed River Time Series Output
o Grid Series Output
f Extra Parameters

>

_Se'ml)m Processed Data Results

3.4
=]
=]
@
=]
24

(O Catchment defined by Dfs File ]
(® Catchment defined by Shape File

suglas newiMIKE SHE\Model Inputsh\GIS Data\calchmenl.shp| =

Catchment size and orientation
NX: NY:
65 ] [82 |

Cell Size:
[500

Rotation:

m o

I [Deg. Counter clockwise]

Catchment origin and map projection

X0: Y0: Map Projection Type:
(434079 Jiml (6220000 [iml | ETRS_1383_UTM_Zone_32N v|
[meter]

6260000 §--

6255000 1

6250000 -4

6245000 ¢

6240000 7---

6235000

6230000

6225000 -

Il 2
I 1
[ u

ndefined Value

6220000 AR
520000
[meter]

500000 510000

Choose Catchment defined by Shape File

Using the Browse icon, select the file
\Model Inputs\GIS Data\catchment.shp

Set the Shape axis units to “meter” in the dialogue that pops up.

Set the grid dimensions to

- Number of cells in the X direction, NX = 65
- Number of cells in the Y direction, NY = 82
- Cell size =500m

- Rotation = 0

- Origin (X0, Y0) = 494079, 6220000
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Demo note: If you are using a demo version of the software, you will not be able to have
the same amount of cells. Instead use NX =33, NY = 41, and Cell Size = 1000 m.

*  Map Projection Type = ETRS_1989 UTM_Zone_32N

A list of previously used map projections will appear in the drop down menu when
selecting Map Projection Type. To find and use the projection for the first time

. click <Browse...>

*  goto: OpenGISProjections/Coordinate Systems/Projected Coordinate
Systems/UTM/Other GCS/ ETRS_1989 UTM_Zone_32N

*  Click OK
i Map Projection Editing ==
Map projections - organized by: |Folder structure | Map projection: Transverse mercator
ELD_1575_UTM_Zone_35N = | Name: ETRS_1989_UTM_Zone_32N MNew Map Prajection...
ETRF_1989_UTM_Zone_28N
ETRF 1989 UTM_Zone 29N Geographic CS: GCS_ETRS_1989 =
ETRF_1989_UTM_Zane_30N Datum: D_ETRS_1989
ETRF_1989_UTM_Zone 31N Elipsaid: GRS_1980
ETRF_1989_UTM_Zone_32N ————————
ETRF_1989_UTM_Zone_33N Prime meridian; 0 - Greenwich Degres Impart Projection File...
ETRF_1989_UTM_Zone_33N Projection type: Transverse_Mercator Expart Projection File...
ETRF_1989_UTM_Zone_35N
ETRF_1989_UTM_Zane_36N Tm= GREER Eind...
ETRF_1989_UUTM_Zone_37N = Central meridian: 9 Degree
ETRF_1989_UTM_Zone_38N Browse Elipsoids...
ETRS_ 1980_LITM_Zane_ 26N Latitude origin: 0 Degree
ETRS_1989_UTM_Zone_27M False easting: 500000 Meter
ETRS_1989_LITM_Zone 28N False northing: 0 Meter (T E—
ETRS_1989_UTM_Zone_25N ancel
ETRS_1989_UTM_Zone_30N r—
ETRS_1989_UTM_Zone_31N ;JHE P
ETRS _1989_UTM_Zone_32N
ETRS_1989_UTM_Zone_33N
ETRS_1989_UTM_Zone_34N
ETRS_1989_UTM_Zone_35N
ETRS_1989_UTM_Zone_36N
ETRS_1989_UTM_Zone_37M
ETRS_1989_LITM_Zone_38N Used elipsoid:
ETRS_1989_UTM_Zone_38N Name: GRS, 1980
Fahud_UTM_Zone_3aN
Fahud_UTM_Zane_40N ID code:
Fort_Desaix_UTM_20N Semi major axis: 6378137
Fort_Marigot_UTM_20N
Garoua_UTM_Zone, 33N Semi minor axis: 6356752.31414036
Graciosa_Base_SW_1948_UTM_Zone. Inverse flatness: 298.257222101
Grand Comoros UTM 385 i+
< " v

ﬂ The Map Projection Type allows you to use any valid map projection. The only restriction
is that whichever projection you chose, you must be consistent with respect to all other
map inputs. You cannot mix, for example, maps from two different UTM zones.

The NON-UTM option implies local rectangular coordinates, without a map projection.

MIKE SHE automatically assigns values of 1 to the internal cells and values of 2 to the
boundary cells.

When you preprocess the data, the preprocessor calculates the model domain based on
the .shp file and defines the model domain as a dfs2-grid with integer values 1 (internal
point), 2 (boundary point) and zero values for areas outside the model domain. The pre-
processor assigns all of the model parameters based on the dfs2-grid that is calculated
from the polygon that you have specified in this step.

If you wish to change the model domain, all you have to do is modify the .shp file and pre-

process the data again. However, be aware that previously specified data must still cover
the new polygon. If it does not, then either a warning will be issued (saying that some
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MIKE SHE

values were automatically interpolated) or an error will be issued (if it can't interpolate the
data)

Set up the topography

The surface topography is required for all MIKE SHE components. The model topography
defines the upper bound of the groundwater model as well as the upper surface of the
unsaturated zone model. It is also used as the flow surface for overland flow.

Globally, Digital Elevation Model (DEM) data is widely available. Free DEM data at 90m
and 30m resolution is available from the NASA SRTM data. There are also commercial
providers of higher resolution DEM data, including DHI.

For Denmark, DEM data at different resolutions (0.4m, 1.6m and 10m) are freely available
from . Data is provided as raster grid data in ArcGIS or
Maplinfo format. For this model, the 10m-resolution DEM data was downloaded and
resampled to 50m. The data was then converted to a point ArcGIS shapefile.

The resampling can be important. High resolution DEM data will be interpolated in MIKE
SHE. However, the GUI may become very slow if it is continually interpolating high-
resolution data.

3.5.1 Define surface topography

In the Topography Dialog:
*  Choose Grid file (.dfs2) for the Spatial Distribution

*  Select the file
\Model Inputs\Maps\dtm_50m.dfs2

Fully Integrated Exercises - © DHI A/S
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i+ MIKE SHE Flow Model Description
=] o Display
& ‘/ Fereground Spatial Distribution:
- of Shape: catchment shp i fle [ fs2) v
‘- f Disabled Image: D200_2015b...
Background Filename: Attribute;
Current Layer |ew\MIKE SHE“Model inputsiMapstdtm_S0m.dfs2| ... | DTH Edit Create
- Simus"i’r“:‘::;i:m?‘”” [ Show giid data
of Simulation period [meter]
- of Time step control
- o OL Computational Control Paramet... 6260000
of UZ Computational Control Paramet..
L o SZComputational Control Paramet...
- o Model Domain and Grid
I 6255000
- of Land Use
o Vegetation
o of Rivers and Lakes
- of Overiand Flow 6250000
- f Unsaturated Flow
- f Saturated Zone
- f Storing of resuts
w of Extra Parameters 6245000
6240000 [meter]
[ Above 120
B 112-120
[ 104-112
6235000 [ ] 96-104
[ ] 88- 9%
] =8o0- 88
] 72- 80
] 64- 72
6230000 I 56- B4
Bl 48- 56
B 40- 48
B 32- 40
6225000 Bl - 32
Bl 6- 24
Bl s- 16
Il Below 8
6220000 [ Undefined Value
= S 500000 510000 520000
iy et

a Uniform value
« aGrid file (.dfs2),
*  aPoint/Line (.shp) ArcView or ArcGIS map, or
* an ASCII file with distributed xyz values (Point XYZ (.txt)).

I l Spatially distributed data, such as topography can be specified using:

If a .shp file or a xyz-file is used, MIKE SHE will interpolate the data to the mesh defined
in the Model Domain and Grid menu.

Hint: you can always see the Z-value at the cursor position at the bottom of your
Graphical View.

Point/Line - Interpolation method - You can choose between Bilinear, Triangular,

Inverse Distance and Inverse Distance Squared interpolation methods by selecting from

the Interpolation method combo box.

*  The Inverse distance methods are good for scattered data.

«  Bilinear Interpolation is a good method for interpolating from gridded data and the

«  Triangular method is good for interpolating from digitised contour lines.

*  You can use the Online Help to find out more information on the interpolation
methods, by clicking F1. At the bottom of the Help page, are references to Related
Items, which will take you to the detailed descriptions of the interpolation methods.

SURFER - If you want to use interpolation methods not available in MIKE SHE, then you
can use a program such as SURFER by Golden Software. In SURFER, you can save the
interpolated SURFER grid to an XYZ file, and use the bilinear method in MIKE SHE to
reproduce the Surfer interpolation.
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ArcGIS Grid — If you have gridded data from ArcGIS, then you can use the Grd2Mike
Tool (New File\MIKE ZERO\WMIKE Zero Toolbox\GIS) to convert an ArcGIS grid to a dfs2
file.

Product Types: Documents:

75 MIKE Zero

-3 MIKE HYDRO ’ ‘ ’ ‘ \A \A

[ MIKE 11 Time Series  Profile Series  Data Manager  Grid Series  Plot Composer Result Viewer
MIKE 21 (.dfs0) (.dfs1) (.dfsu,.mes... (dfs3,.dfs2) (.plc) (irev)
(£ MIKE 3
MIKE 21/3 Integrated Madels ) A ) A
£ LITPACK N . . . . A

23 MIKE FLOOD .| Bathymetries Climate Ecolab Auto EVA Editor Mesh

[ MIKE SHE | (batsf) Chan... (.ecolab) Calibrati. .. (.eva) Genera...

7 3

Data
Extraction ... |

MIKE Zero Toolbox

5 Concatenation
- & Edraction
- & File Converter

o & Gis
2 Grd2Mike
1% Mike2Grd

EERE]

=2 2 o= 3 3 R

Mew Edit Delete Up Down Fun

Other tips:

The search radius should be sufficiently large to ensure that each grid gets a value.
For this exercise 1000 m is sufficient. However, the minimum search radius is two
times the cell size. Search radii below this will have no effect. In this data set, the
data density is quite high, and changing the search radius will have no effect.

In some cases, such as when the grid is very large or the number of data points is
large, then the interpolation can be time consuming. This can be a problem, since the
grid is re-interpolated every time you enter the Dialog, as well as during the pre-
processing step. To make the model more efficient, you can save the interpolation to
a dfs2 file for use directly. To do this, right click on the map view and select save to
dfs2 file.

After you have saved the dfs2 file, you can then use it instead of the .shp file. Note
though, that the link to the original .shp data is not lost, but simply hidden from view.
This allows you to return to the original data if you want to change the discretisation
of the dfs2 file, for example, if you change the size and shape of the Model Domain
and Grid.
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. If you have high-resolution DEM data, often the most efficient process is to use
ArcGIS to interpolate the DEM data to the grid resolution that you want to use. At the
same time, ensure that the point values are located at the model nodes. This will limit
the amount of re-interpolation in the GUI, and ensure that your model topography is
exactly as you expect.

3.6 Define climate

3.6.1 Define precipitation rate and temporal distribution
The precipitation is the actual amount of measured rainfall:

. Go to Climate in the menu and select the sub-item Precipitation Rate

. For now, choose Uniform Spatial Distribution, which means that the same
precipitation rate will be used all over the model domain.

. Change the temporal distribution from constant to time varying.

MIKE SHE Flow Model Description |«
iy [Precpitadon Rete
Simulation specification
« Model Domain and Grid Spatial Distribution:  Temporal Distribution:
+ Topography Unifarmn w  Time vaning [.dis0]
e — Time Series File
o Reference Evapotranspiration E]
Land Use
Rivers and Lakes 1.00 L
Overand Flow ' ' ' ' ' ' ' ' ' ' 3
Unsaturated Flow 080 - bossenee bossenee bossenee bosseennes Lt ERCCCTTEE PR ELREI PUPRILOR EECPRREeH
Saturated Zone : : : : : : : : : :
Storing of results 060F------ P P P Foemeeees R R e R R |
Extra Parameters : : : : : : : : : :
T s S
0.00 T T T T i
et et [Presiom  rews | .

. Click on the E button to open the file browser
. Navigate to .\Model Inputs\Time\Precipitation.dfs0

*  Keep the default ltem “Precipitation station 1” and click OK
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%5 Open @
Look in: . Time - @ ¥ £ g
= Mame ‘ Date modified Type S
e W flow.dfs0 01/12/201515:22 MIKE Zero Time 5.
EEceie W HeadObservations.dfs0 0112/201515:22  MIKE Zero Time S...
! W PotentialEvap.dfs) 21/11/201518:48 MIKE Zero Time S...
W Precipitation.dfs0 21/11/2015 18:48 MIKE Zerc Time S...
Desktop
=il
Libraries
A
Computer
w
A ] (T r
Metwork
File name: Precipitation dfs0 -
Flesoftyps:  [Time Seres Fies ("cfsl) -
Select tem | Period Infa. [ kem Info. | Constrairts Info
Title: D:-\Projects' Talert Project \Autocalibration' Mshe ' Kamup_v
File Type Mon Equidistart Time Axis
| Item |
Any ltem Type IPrEcip'rtatiun station 1 ﬂl

ﬂ In this case, you are using spatially uniform recharge data. The precipitation file contains
data from several rain gauges. The particular rain gauge to use is selected under the Item
in the browse Dialog. In this case, you are using only the data from Precipitation station 1.
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MIKE SHE Flow Model Description
Display
o Simulation specification
o Simulation title
o Simulation period
o Time step control
o QL Computational Control Paramet. .
o UZ Computational Control Paramet...
o SZ Computational Control Paramet. .
» Model Domain and Grid
o Topography
& o Cimate
o
o Reference Evapotranspiration
o Land Use
& Rivers and Lakes
o Overand Fow
o Unsaturated Fow
o Saturated Zone
o Storing of results
o Detailed Time Series Output
of Detailed River Time Series Output
o Grid Series Qutput
f Extra Parameters

-

&l

O-E-E-E

< >

" Setp Data [ProcessedData | Resuts

Spatial Distibution: — Temporal Distribution:

Urifarmn ~ | | Time vaing [disD]
Time Series File: Create.
‘wenls\Karup - Douglas new'MIKE SHE\Model InputshTime\Precipitation.dfs 0| ... Edit..

[mmiday] ltemname: Precipitation station 1

e — e E—

e I e S e

sl SR

204 oA s M s

RS

2007

10_- EEEERNN ‘l 1 --- - ‘: T .
LRNLL I SR AT M) N
2003 2004 2005 2006

In this model we are using a uniform rainfall rate over the entire catchment. For small
catchments this is reasonable. In large catchments this would not normally be correct. By
selecting Station-based, we can define regions or Theissen Polygons where different rain
gauge data is used. If you have access to gridded rainfall data, for example from radar
rainfall stations, then you can use fully distributed rainfall data as well.

Precipitation is specified the same way data is collected from rain gauges. It can be input

as mean-step accumulated values (e.g. average rainfall per day in units of mm/day) or, as
step accumulated values (e.g. measured rainfall in a tipping bucket rain gauge in units of

mm since the last measurement).
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Finally, your calibration will depend on the frequency of your rainfall data. Your model will
react very differently if you have monthly rainfall averages versus hourly rainfall from a
local gauge. If you update your rainfall frequency, you will normally have to recalibrate
your model.

3.6.2 Add Reference Evapotranspiration

MIKE SHE calculates actual evapotranspiration based on the evapotranspiration rate, the
vegetation properties, and the soil moisture.

In the Reference Evapotranspiration Dialog:
. Use Uniform spatial distribution

. Use Time-varying (.dfs0) Data Type

. Use the browse button to select the file
\Model Inputs\Time\PotentialEvap.dfsO

MIKE SHE Flow Madel Description
Do [Reference Evapotranspiragon

o Simulation specification
of Simulation title Spatial Distribution:  Temporal Distribution

=

o Simulation period Unifarm ~ | Time waring (dfs0)
o Time step control
o OL Computational Control Paramet...

Time Seies File: Create.

¥ U7 Compnation ool Paramet | | [mtsanup - Dvglas newAMIKE SHEbocel InputsTims'PoterdisE v ot .. | | Edit
o SZ Computational Control Paramet... i “PoLE
 Model Domain and Grid [mm/day] temname: Pot. Evap.
+ Topography - - . -
= of Clmate GO T T T T
o Precipitation Rate !
MR e Elazcuepraton 504
+ o Land Use
o PRivers and Lakes 403

o Overand Fow
o Unsaturated Fow

7B

o Saturated Zone 307
o Storing of results
o Detalled Time Series Output 204---
o Detailed River Time Series Output

o Grid Series Output 10+--44F-------- by
 Extra Parameters

00

< >

Selup Data |Processed Datz Results

Reference evapotranspiration can be specified in the same manner as precipitation, that
is, as constant or time-varying values and as uniform or spatially distributed values.

As you’re using Uniform distribution type, this evapotranspiration rate will be used
throughout the model domain.

Evapotranspiration and Precipitation are highly correlated. Reference evapotranspiration
is a function of solar radiation (sunshine), wind speed, relative humidity, and air
temperature. All of these factors are affected by rainfall. Thus, it is desirable, but not
critical, to use Precipitation and Evapotranspiration from the same weather station and at
the same recorded frequency.

3.7 Add land use
3.7.1 Define the vegetation distribution
*  Under Land use select the Vegetation Dialog:
Powering WATER DECISIONS
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¥ Model Domain and Grid
¥ Topography E
o s 6255000

¥ Land Use

 Rivers and Lakes
 Overland Flow 6250000
o Unsaturated Flow
o Saturated Zone

o Storing of results

 Exra Parameters

MIKE SHE

Use Station based Spatial distribution
Specify Grid Codes (dfs2) as the Data Type

Use the browse button to select the file
AModel Inputs\MAPS\Landuse.dfs2

MIKE SHE Flow Model Description
Desie B

= o Foreground
o Shape: catchment.shp Spatial Distribution: ~ Data Type:
o Image: kot bmp Station based v | | Grid codes (.dis2) | [ET parameters ...
Iy g":fn"’;"d Staion Based Distibution Fil:
[ u ver : .
G of - Sevution specsication [tsKarup - Douglas newMIKE SHE\Model inputs\Maps\landuse.dfs2| ... || Edit.. | |Create...
o Simulation title
o Simulation period [meter]
¥ Time step control
 OL Computational Control Paramet.. 6260000 3

 UZ Computational Control Paramet
¥ SZ Computational Control Paramet...

Ve

f Detailed Time Series Output 6245000
 Detailed River Time Series Output
f Grid Series Output

6240000 3N A
6235000
6230000 ]

6225000 7

CANWS

(O

Value

6220000

500000 510000 520000

>

P e mete]

The map now displays your vegetation distribution. The map (dfs2 file) contains 4 different
integer codes that define 4 different areas. You now need to define the vegetation types
and growth function that are associated with the 4 different areas.

3.7.2 Define vegetation types for each vegetation area

Each of the 4 different vegetation areas in the vegetation map appears as a sub-item in
the data tree.

32

Select the Grid code = 1 item
Change the ID to Grass

Set the Temporal Distribution to Vegetation property file

Use the new items icon, to add a line in the Crop Development table.

On the line in the Crop Development table
- Use the browse button to select the vegetation property file (database file):
\Model Inputs\MIKE_SHE_vege.ETV

-  BEFORE closing the dialog,
From the pull-down Veg type combo box pick Grassl
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3 Select a Veg property file and Veg type

SX)

Look in . Model Inputs

i: Name

e | GI5 Data
Recent Places L MAPS

- . MIKE HYDRO
. Obsolete
Desktop | Time
—— W MIKE_SHE_vege ETV

="
Libraries

E:r..!'

Computer

@ < 1

- @F e m
Date modified
31/05/2016 15:23
31/05/2016 11:21
31/05/2016 11:59
31/05/2016 11:25
02/06/2016 13:40
21/11/2015 18:48

Network
File name: MIKE_SHE_vege .ETV

Fies of type ET Vegstation property fie (" stv) -

Veg. type: FGmssJ v] [ 0K ]

Bare soil
HYV-Aman(160d)

HYV-Aman(120d)
Ff Boro (145d)
Aus (120d)

1000 ﬂeat

obacco
meter] Grain
Potatoes
Sugarcane
Homestead
Grass
Spring cereal (28/4)
Winter Wheat (25/9)
Winter Barley (25/9)
Winter rye (25/5)
Winter rape (15/9)
Spring rape (10/5)

Pea (8/5)

Maize (15/5)

Beet (2/5)

Potato fearly, 21/5)

Potato {medium, 21/5)
Potato {ate. 21/5)
Forest
Heat
.
= Grass2

Type

File folder
File folder
File folder
File folder
File folder
MIKE Zerc

x=539795.27 y = 62675236

Set the Start date to 1. Jan. 2000

MIKEaﬂ
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(The start date is set before the simulation start data to ensure a full coverage of

the simulation period).

+  Setthe Recycling Mode to Each Entry

For the remaining three vegetation types, set the Temporal Distribution to Constant and
use the following values for the remaining items:

e Grid code =2: ID=Forest, LAl =6, RD =800 [mm], Kc =1

e Grid code =3: ID=Shrubs,LAI =2, RD =500 [mm], Kc =1

*  Grid code =4: ID=Wetlands, LAl =4, RD =500 [mm],Kc =1

LAl is the Leaf Area Index, which is a measure of the density of the vegetation in area of
leaves per square area of ground [m? leaves/m? ground]. RD is the Root Depth.Kc is the
Crop Coefficient which is effectively a scaling parameter on the Reference ET.
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I8

500000 520000

The Crop Development table allows you to define flexible crop rotation schedules.
The schedule is defined in the Vegetation database, and the Recycling Mode is used to
define how the schedule is repeated during the simulation.

The recycling mode defines what happens when the crop rotation ends.

If no recycling is defined, then the vegetation properties will revert to 0.

Each Entry means that each line in the table is repeated until the next start date.
Entire scheme means that the rotation table starts over again after the last entry.
Entries, then scheme means that the lines are repeated to fill in any gaps, and then
the entire scheme is repeated.

For example,

If you have one crop per year, then you can set up a simple annual schedule in the
Vegetation database. Then if you choose the Each Entry option, the crop schedule
will start over again as soon as it is finished. This is what we have done here.

If you have multiple different crops per year, or a fallow crop in alternating years,
then you could set this up as multiple lines in the Crop Development Table, with two
different vegetation types and schedules.

Note: The recycling does not account for leap years. So, if you have very long simulations
that require precise crop rotation dates, then you may want to set up a 4 year cycle in the
Vegetation database.
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3.8 Add the river module

You will now add an existing MIKE Hydro river setup to the model. Setting up the river in
MIKE Hydro is detailed as a separate exercise in Section 5.

3.8.1 Add the river module

In the Rivers and Lakes Dialog:
*  Use the browse button to select the existing .mhydro file for the Karup catchment:
AKarup_Mhydro\karup_v1.mhydro

MIKE SHE Flow Model Description
0 Do (Riversand Lakes

-« Simulation specification
& Simulation title
+ Simulation period River Simulation File:
+/ Time step control |’rojects\,l(arup_exercise\MIICE_SHE\Karup_Mhydro\karup_\t1.mhydrd | ... | | Edit..
+ OL Computational Cortrol Parameters
+ UZ Computational Control Parameters

& 5Z Computational Cortrol Parameters Inundation Areas
:‘; _T::;g:::m and Grid [[]Flood Codes
 Climate [IBathymetry

+ Land Use
+" PRivers and Lakes
+ Overland Flow
+ Unsaturated Flow
+f Saturated Zone
+ Storing of results
+ Extra Parameters

Demo Note: If you are using a Demo version, instead choose the file
karup_v1l _demo.mhydro, located in the same directory.

3.9  Specify the overland flow parameters
In the sub-items in the Overland Flow Dialog (in the MIKE SHE GUI), specify

+  Manning’s M equal to 2 [m*/s]
. Detention storage equal to 4 [mm], and

. Initial water depth equal to O [m].

MIKE SHE Flow Model Description
Deie [WanningNumper

Simulation sp.Ecrﬁcallu.n Spatial Distribution:
o Model Domain and Grid — -
o Topography
+ Climate Value .
o Tond U] L Jwoas
« Rivers and Lakes
=~ o Overland Flow

Bl Manring Number

o Detention Storage

o Initial Water Depth
+ Unsaturated Flow
+ Saturated Zone
o Storing of results
o Extra Parameters

_5=u|n|)an Processed Data Resulis v

The Karup catchment is quite sandy, and in this simulation there are no serious storm
events. Thus, in reality, overland flow is insignificant for this simulation.
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The detention storage cuts off overland flow when the depth of ponding is less than the
Detention storage. In this case here, all rainfall events below 4mm will not generate
overland flow directly.

You can disable overland flow by specifying a Manning’s M = 0 [m3/s]. Setting the
Manning’s M to zero locally is sometimes a useful way of speeding up the simulation by
turning off the overland flow calculation in areas of permanently ponded water, such as
small reservoirs. However, a Manning’s M of zero will prevent any overland flow from
entering the cell.

The Detention Storage defines the depth of ponding required before Overland Flow
occurs. A high Detention Storage value will effectively turn off Overland Flow. Again, this
is very useful when you want to locally turn off Overland Flow, for example in lakes or
ponds.

You can play with the Overland flow parameters later, if you like. For now use the value
stated above.

3.10 Build the unsaturated zone model

36

The unsaturated zone model calculates recharge to the groundwater model and is closely
linked to the actual evapotranspiration, as the roots remove water from the unsaturated
zone. Soil physical properties are stored in a soil-database. The link between soil-type
distribution maps and soils in the soil-database are established similarly to the link
between vegetation-distribution maps and vegetation types.

3.10.1 Calculation column classification

In the Unsaturated Flow Dialog use the default values.

Initial Conditions M acropore Flaw
(®) Equilibriurn pressure profile [to field capacity] (@ None
() Equilibrium pressure profile [to residual moisture content] () Simple by-pazs fow
() Specified matrix potential () Full macropare flow (Richards and Gravity only]
() Specified water content Time Step Contral
Max MP Infiltration per me step 1 mm
Usze Green and Ampt model for infiltration M ax MP-Matriz Mode exchange per time step 0.5 im
[AEnahle calumn classification [not recommendedf Mai MP-Matri Column exchange per time step 2 (G

Calculation Column Clagsification Type
()1: Autamatic

(0 2 Specified calculation points

(®) % Calculated in all grid points

(0 4: Partial automatic [combination of 1 and 2]

When using Richards Equation or Gravity Flow, the default initial condition for UZ is an
equilibrium pressure profile based on the saturation-pressure curve. However, there are
two options. In temperate areas, the soil moisture below the root zone is typically close to
field capacity. However, in arid areas, the moisture content below the root zone can be
much drier. Thus, there are two options for the initial UZ soil moisture where the
minimum initial water content is 1) field capacity or 2) the residual water content.
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You should avoid Automatic UZ column classification and always use Calculated in
ﬂ all grid points (default).
MIKE SHE allows you to lump similar UZ profiles together to reduce the computation time.
In this case, the results of one column are copied to other similar columns. This option
was very useful in the past when computers were slower. However, this should be
avoided now. The option has been retained to support backwards compatibility and some
special cases.

Demo Note: You must use the Automatic Classification if you are using the demo
version. In the Demo mode, the model size is restricted to a maximum of 155 UZ
computational cells

3.10.2 Define the soil profile distribution map
In the Soil Profile Definitions Dialog:

*  Use Distributed for the Spatial Distribution
. Use Grid codes (dfs2) distribution data type

*  Use the browse button to select the dfs2 grid file
\Model Inputs\Maps\soil.dfs2

Spatial Distribution: ~ Data Type:

[Distibuted v |Gridcodes(dfs2) | -
I

Grid Distrbution File: B

3\Documents\Karup - Douglas new\MIKE SHEWModel inputs\Maps\soiI,dileE} | Edi.. \

[meter]

6260000 %----- :

6255000 -~ : .......................
62500003~ - 2 TR X ...............
6245000 % ...........
6240000 3---- ! ’ . .
6235000 1 - =3 - -
6230000 J------------ et

6225000 -~~~ e T ! .

)
||
L
-

4
3
2
Ui

6220000 ndefined Value

500000 510000 520000

[meter]

2
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The soil map contains three different code values, which now need to be associated with
three soil profiles.

3.10.3 Define soail profiles (horizons)

Each of the 3 different soil areas in the soil map appears as a sub-item in the data tree.
For each soil zone

+  Select the line in the Data Tree (Grid code 1, 2, etc)
+  Setthe Soil Profile depth to 45 m

. Use the browse button to select the UZ soil-database file
AModel Inputs\UNSODA basic soil classes.uzs

. BEFORE clicking OK, select the soil type as follows:

Grid Code =2 Silt Loam
Grid Code =3 Loamy Sand
Grid Code = 4 Loam

. Rename the Profile ID

*  Add 4 lines to the vertical discretization, using the add button
*  Set the vertical discretization as follows:

Yertical Digcretization:

From depth| To depth | Cell height | Mo of cells
1 0 3 0.25 12
2 3 5 05 4
3 5 13 1 a
4 13 45 2 18
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----- MIKE SHE Flow Model Description

& 1 Doy [UZsoil Profile Definiton
= o Foreground
. Frafile ID Grid code value: 2
1 Background Soil Profik:
B O Cument Layer Fromdepth | Todepth | Soilmame | UZ Soil property file
= o Smuation specfication | 0 [ [Sit Loam [ CiUsers\...\Model inputs\UNSODA basic soi classes.uzs| || Edit]
Lo of Simulation title
- f Simulation period
o Time step control
- f OL Computational Control Paramet..
o UZComputational Control Paramet...
" o 5Z Computational Control Paramet
 Model Domain and Grid ertical Discretizatior
s Topography From depth| To depth | Cell height | No of cells
- of Climate 1 1] 3 025 12
i of Land Use 2 3 5 0s 4
S of Vegetation 3 5 13 1 B
- of Grass 4 13 45 2 18
o of Forest
‘o off Shrubs
O s Eypass constants [meter]
- o Rivers and Lakes Masitur bypass fraction .25
- o Overland Flow wiater cantent for reduced 6260000
- o Unsaturated Fow bypss o i
= o Sol Profile Definitions Limit on water content for
i o st L 6255000
of Loamy sand
Lo of Loam ]
o Saturated Zone 230000
1 o Storing of results
- o Detailed Time Series Output 6245000 1
- f Detailed River Time Series Output :
" f Grid Series Output : Y
o Extra Parameters 624000014 e i, SR
6235000 - N amT . - e
62300003+ R
6225000 e o e
6220000 T T
. s 500000 520000
- [meter]
Setup Data Resits

ﬂ To facilitate the process you can add four lines using the add button ). Then select all
the lines in the table (click in the upper right corner of the table). Then copy and paste the
vertical discretization table into the other soil zones.

The UNSODA database is a list of standard soil types developed by the US Department
of Agriculture.
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We are ignoring Bypass Flow in this exercise because of the sandy nature of the soils.
You can use Bypass flow to account for variable flow rates in a soil column due to
heterogeneities in the soil.

In the Unsaturated Flow dialog change the Classification Type to 1: Automatic

In the Groundwater depths used for UZ classification dialog specify Use initial water
table for classification

Define 3 depth classes 1, 5 and 10 meters

Demo Note: If you are using the Demo mode, then you must use the Automatic
classification method, which requires you to specify a water table

The depth to the groundwater table is one of the criteria that are used when the
automatic (lumped) unsaturated zone classification is used.

4

MIKE SHE Flow Model Description
Display
Simulation specification
» Model Domain and Gnd
+f Topoaraphy
o Climate
o Land Use
o Rivers and Lakes
Overdand Flow
o Unsaturated Flow
=1 o Soil Profile Defintions
o Grid code =2
o Grid code =3
of Grid code =4

+ Groundwater depths used for UZ cla:

o Initial Condtions
Saturated Zone
Storing of results
Extra Parameters

Tl

b

Setup Data |Processed Daia Fesulis

_ed for UZ classification

Depth

Water Table for Classification
@ Use initial water table for classification

Specified water table for classification

T A

3.11 Build the saturated zone model

40

Before defining your computational layers you must input a geological model, which is
defined as part of the saturated zone.

A geological model may be defined as a combination of layers and lenses. Once the
geological model is defined you may choose computational layers that are either identical
to the geological layers or you may choose different computational layers. If the
computational layers differ from the geological layers MIKE SHE’s pre-processor will
transfer the hydraulic properties of the geological model to the computational mesh.

3.11.1 Specify the Saturated zone (groundwater) options

In the Saturated Zone dialog:

Select Include subsurface drainage. This will ensure that any springs drain to the

streams.
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*  There are no pumping wells for now, so make sure that the Include pumping wells is
not selected.
. Select Assign parameters via geological layers

MIKE SHE Fow Madel Description
Oy SaturatedZone

« Simulation speciication

# Model Domain and Grid [ Inchude pumping wells
« Topography .
|
o Climate Include subsurface drainage
o Land Use Hudrogeologic parameter distribution
o Rivers and Lakes (®) Assign parameters via geological lapers

# Overand Flow

() Assign parameters via geological units within lapers
# Unsaturated Flow

-

s e g .
Sebanter one Specific Yield in 52 Computational Laver 1
Geological Layers
Geological Lenses (®) Derive from UZ soil parameters when UZ included
Computational Layers () Use specified values
Drainage

Storing of results
Extra Parameters

The geology data can be assigned using both geological layers and geological units. If

ﬂ you choose the geological layers approach then the hydraulic properties are assigned as
spatially distributed within the layer. If you use gridded data or point data, the hydraulic
properties are smoothly interpolated to the model grid.

If you chose the geological units approach, then you must specify a distribution of
geological units for each geological layer, for example, by a polygon file. In this case, all
of the model cells in each polygon are assigned a value for each of the hydraulic
properties.

The geologic units method is often specified when you use the AUTOCAL program for
parameter estimation and automatic calibration. In this case, the parameters for each
polygon can be estimated automatically and the model sensitivity for each parameter
calculated.

ﬂ By default the Specific Yield is derived from the UZ soil properties. The Specific Yield is

calculated as (UZ Saturated Water Content) — (UZ Field Capacity). This ensures that the
fluctations in the water table will be consistent between the UZ and SZ models.

3.11.2 Define the number of geologic layers
In this exercise, we will only have one numerical layer.
In the Geological Layers dialog:

. Keep the existing default layer name Aquifer

I l By default there is already one layer in the model. Additional layers can be added by
clicking on the Add Item icon, _J deleted by clicking on the Delete Item icon, _I or

moved up and down by clicking on one of the Move Item icons, _’Ji]
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MIKE SHE Flow Model Description
Display
Simulation specification
o Model Domain and Grid
o Topography
o Climate
o Land Use
« Rivers and Lakes
Overand Flow
o Unsaturated Flow
= Saturated Zone
Geological Lenses
Computational Layers
Drainage
Storing of results
Extra Parameters

" Setp Data |ProcessedDam | Resuts

»

Geological layers

[+]
[«]

Name

il Aquifer

4l 1 | b

Each of the Geological layers includes one item in the data tree for each of the properties.
Additional layers will add additional sets of items to the data tree.

Increasing the number of saturated zone model layers allows you to better represent
vertical flow and exchange between geologic layers. A fine vertical discretisation may also
be required for solute transport simulations.

MIKE SHE allows you to have any number of layers in the saturated zone. However, the
more model layers you have, the higher the computational effort and the more memory is
needed. If you need more layers, it is always better to start with a few layers and do the
initial calibration. Then add layers as necessary, while ensuring that the model remains
stable and computational effort remains reasonable.

3.11.3 Define layer bottom (lower level)

In the Lower Level Dialog for Aquifer:
*  Select Grid file (.dfs2) in the Spatial Distribution combo box

*  Using the file browse button, E select the file
\Model Inputs\Maps\layerl.dfs2

Fully Integrated Exercises - © DHI A/S



Setting up a MIKE SHE Flow Model

----- MIKE SHE Flow Model Description
Display
Simulation specification
~ o Model Domain and Grid
+f Topography
o Climate
- of Land Use
o Rivers and Lakes
o Overland Flow
- of Unsaturated Flow
o Saturated Zone
- o Geological Layers
= o Aquifer
=4

i of Horizontal Hydraulic Conductivity
o o Vertical Hydraulic Conductivity
. of Specific Yield
L. of Specific Storage
+ Geological Lenses

o Computational Layers

(- o Drainage

+f Storing of resuts

o Extra Parameters

" Setp Data |Processed Daa | Resus |

MIKE::\“

Powered by DHI
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3.11.4 Assign hydraulic properties

[meter]

Il Selow -56
[_1 Undefined Value

The remaining hydraulic properties are listed under the Lower Level item. For each item:

«  Select Uniform under the Spatial distribution combo box and specify the following

values:

- Horizontal hydraulic conductivity = 0.00052 [m/s]
- Vertical Hydraulic Conductivity = 9.3e-5 [m/s]

- Specific Yield =

0.2 []

- Specific Storage = 0.0001 [1/m]

MIKE SHE Flow Model
O Display
+ Simulation specification
-+ Model Domain and Grid
-+ Topography
-+ Climate
-+ Land Use
-+ Rivers and Lakes
-+ Overland Flow
+/ Unsaturated Flow
=+ Saturated Zone
2+ Geological Layers
O+ Aquifer
of Lower Level

v/ Specific Yield
‘-« Specific Storage
+/ Geological Lenses
+/ Computational Layers
-+ Drainage
- Level
.+ Time Constant

P Premie fmdan

<

-+ Horizontal Hydraulic Conducti...
+«f Vertical Hydraulic Conductivity

—ie

Spatial Distribution:

Value

oowsd

I Setup Data |Processed Data | Results
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3.11.5 Define attributes of groundwater computational layers

The computational layers are defined independently of the geological layers. While the
Geological Layers have geological attributes, the Computational Layers include
computational attributes such as initial conditions and boundary conditions. The
properties of the geological layers are mapped and interpolated to the computational
layers during the model preprocessing.

Although MIKE SHE allows you to define Computational Layers independent of your
Geological Layers, in this exercise computational and geological layers will be identical.

In the Computational Layers Dialog:
*  Select Defined by geological layers as the Type of Numerical Vertical Discretization

. Use Minimum layer thickness = 0.5 [m]

MIKE SHE Fow Model Description
Display
o Simulation specification
o Model Domain and Grid
« Topography
o Climate
# Land Use
o Rivers and Lakes
o Overland Flow
o Unsaturated Flow
=] Saturated Zone
o Geological Layers
o Geological Lenses
5
B 1 {Aquifer]
Initial Potential Head
Quter Boundary Conditions
Intemal Boundary Conditi...
o Drainage
Storing of results
Extra Parameters

Type of Humerical Yertical Discretization Battom Elewation Correction

(®) Defined by genlogical layers .

L Adjust top 52 | thicki
Ot ctovrovss (85 i (Y b ks

Name

1

The Bottom Elevation Correction is used when you have multiple computational layers. In
the exercise here, neither are relevant because we have only one SZ layer.

The Minimum layer thickness is used to keep layers from crossing or completely pinching
out, which would cause numerical difficulties.

We recommend that you discretize the top of the SZ model such that the water table is
always in the upper SZ layer. This ensures that the UZ model takes care of vertical UZ
flow and the SZ model takes care of the lateral flow at the water table. To make this
easier to manage, there is an option to adjust the upper SZ layer to be consistent with the
initial water table that you defined. In this case, the upper SZ layer will be pushed down to
the initial water table (minus the minimum layer thickness).

3.11.6 Define groundwater initial conditions

In the Initial Potential Head Dialog:

*  Select Grid file (.dfs2) under Spatial Distribution

. Using the file browse button, E select the file
\Model Inputs\Maps\init-head-500.dfs2

Make sure that the Values relative to ground is turned off.
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You are using an initial head from a previous model run, which gives you a good starting
point. In a real model, you might initially start from a value such as 3 m below the
topography. However, such a value will require a “run in time”, as the model may take
several months to equilibrate.

Demo Note: In the Demo version, you need to run with a different grid size. To
ensure that there is data in all grid cells, choose the file init_head_1000.dfs0 instead.
It is located together with the file used above.

However, in most cases it is more effective to use a Hot Start. If you use a Hot Start, then
the initial condition defined here is ignored, even though it must still be included.

An alternative is to run the model as a steady-state simulation and then use the steady-
state solution as an initial condition. However, the steady state solution still might not be a
reasonable starting point depending on how steady the groundwater table is. For
example, the steady-state condition with pumping active might, in fact be nearly dry.

3.11.7 Define groundwater boundary conditions

The Outer Boundary is defined by the row of cells on the outside of the model domain.
The outer boundary is defined by the Model domain and grid file, as all points with a code
value of 2 (boundary point).

In the Outer Boundary Dialog:

. Press the Add Item Icon, 5

*  Select Zero Flux (default) as the boundary type
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Click on the Add Point icon, | @ | and click anywhere on the map

MIKE SHE Flow Model Description
S o Oulr ‘Outer Boundary Conditions
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Background name
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This now gives you a no-flow boundary condition along the entire outside of the model. If
the entire outer boundary is a no flow boundary, then this step is actually unnecessary
because by default the outer boundary is no flow.

The outside of the model can be divided into boundary sections, by clicking on the Add
Item icon again. Then click on the Add Point icon, | € | again. Finally, click on the map
to define the location of the boundary point end point. The boundaries are specified
clockwise around the model starting at the first point in the table.

The outer boundary conditions are defined independent of the model grid. Thus, if you
change your model grid the boundaries will be interpolated automatically to the new grid
based on the nearest boundary cells to the point locations. If you change the shape or
extent of the grid, you should check that your boundaries have not moved unexpectedly.

Internal boundaries are used to specify such things as lakes and reservoirs that are not
included in MIKE HYDRO River. In this case you could specify a constant head or a
general head boundary for a lake.

Internal boundaries are distinguished from outer boundaries because on the outside of
the model, you can specify flux and gradient boundaries.

3.11.8 Define the subsurface drain reference system

*  Under Drainage, choose Drainage routing based on grid codes
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Drainage routing can be a very complex process. Simply removing the water from the
ﬂ model is the simplest drainage option. However, in most situations, drainage actually

discharges to the river system.

Groundwater Drainage is a very powerful feature of MIKE SHE.

*  The simplest routing method for the drainage is to route it downhill based on the
drain levels. The drainage will enter the river whenever it intersects a river link.
However, this can lead to ponding in local depressions in flat terrains, or
inconsistencies in the drainage directions if the topopgraphy is not hydrologically
correct.

*  More complicated is the second option Drainage routing based on grid codes, where
the drainage is routed downhill but only from certain cells. However, if you specify a
single Drain Code, then the drainage will be to the nearest river.

*  The Distributed drainage options allow you to route drainage to specific MIKE
HYDRO nodes or MIKE Urban sewer manholes.

3.11.9 Define groundwater drainage

In the Drainage Level Dialog:
*  Select Uniform under Spatial Distribution

*  Use the value : -0.5 [m] (Note negative sign)
. Check on “Values relative to ground”

The Values relative to ground tells MIKE SHE that you have drains located 0.5 meter
below ground surface in the entire model domain. In this model, if the groundwater table
is less than 50cm below the topography, groundwater will drain to the nearest river.

In the Time Constant Dialog:
«  Select Uniform under Spatial Distribution

. Use the value = 5.6e-008 [1/5]
E i The drain time constant can be thought of as an empirical factor that accounts for the time

it takes for the water to drain. For example, in the case of agricultural drains, the time
constant could be affected by drain spacing, drain diameter, clogging, etc. In the case of
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natural drainage, the time constant is affected by the distribution of drainage ditches and
channels.

A time constant closer to 1 implies that the water drains more quickly and the drain acts
more like a constant head boundary, when the water table is above the drain level.
Whereas, a value closer to 0 implies that the water drains more slowly. A value of 0 turns
off the drainage.

You can define time-varying drainage parameters if you use a time-varying dfs2 file.

In the Drain Codes Dialog
+  Select Uniform under Spatial Distribution

. Set the Grid Code value = 1

A single drain code will drain all groundwater drainage to the nearest river node.

3.12 Specify output options and calibration targets

48

In MIKE SHE, there are 3 primary outputs:

. Detailed WM time series — This is a point value of a MIKE SHE output at EVERY
time step,for example, Depth of Ponding.

*  Gridded output — This is a 2D or 3D grid of values of a MIKE SHE output at every
STORED time step, for example groundwater head elevation.

»  Detailed river time series — This is a point value of the water level or flow rate in the
defined streams in the model.

Both Detailed Time Series Output types automatically generate an HTML plot of the value
as the simulation progresses. It also allows simulated output to be compared to observed
output and calculates a number of statistics for model error. The HTML plots can be
copied directly into reports.

The Gridded output is stored less frequently to conserve space on your hard disk.
Likewise, many gridded outputs are not saved by default. Gridded output is stored as dfs2
(2D grid time-series files) or dfs3 (3D grid time-series files). If output data is stored too
frequently, you may get very large and unwieldy result files. Thus, before running the
simulation you should consider what and how often you need to save the data

A time series can be created for any point in the model domain from the Gridded Output,
but the frequency of the values will be the same as the Storing Timestep. .

More detail on evalutating the output is in the next step-by-step Exercise.

3.12.1 Storing of results

»  Click on Storing of Water balance data

+  Setthe Storing interval for grid series output to a daily frequency (24 hours) for
Overland, Prec(ipitation) ET UZ, SZ-heads and SZ-fluxes.
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The Water balance items are used during the post-processing of the results to calculate
water exchanges between the various components

The Hot start data is used for starting simulation from a previous result. This is useful
when the run-in time for the simulation is long. In this case, you can run the initial
simulation for a year or two. Then start subsequent simulations from a more reasonable
initial condition. A good rule of thumb is to use a hot start condtion near the end of the dry
season, when water levels are low and conditions are more stable.

3.12.2 Define detailed time series output items

. Select the Detailed WM timeseries output

< Use the Add item icon,

. For each item,

- Setthe name

, to add 4 items to the list

- Select head elevation in saturated zone under Data Type
- Define the X, Y coordinates from the table below:

Name X-coordinate Y-coordinate
Obs 5 518003 6229169
Obs 35 507700 6238357
Obs 37 511408 6241637
Obs 65 502766 6246299

. Define the Depth =5

To add the observation data, you need to

. Check on the Incl. Obs. Data checkbox

«  For each observation point,
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Use the browse button to select the file
\Model Inputs\Time\HeadObservations.dfsO

MIKE SHE

BEFORE clicking OK, you need to select the appropriate Item from the combo
box. (e.g. Obs well 5 for the entry named Obs 5)

s A
£5 Open E
Lookin: [ Time - @@
(= MName - Date medified Type S
b W Flowdisd 01/12/201515:22  MIKE Zero Time S...
RecentPlaces 779 HeadOhb dfsd 01/12/201515:22  MIKE Zero Time 5.,
_'| » PotentialEvap.dfs0 21/11/201518:48 MIKE Zero Time S...
- Precipitation.dfs) 21/11/201518:48 MIKE Zero Time 5...
Desktep
i
Libraries
A
Computer
< T
Network
File name: HeadObservations dfs0 -
Files of type: [Time Series fies (- fs) -

Select tem | Period Info. | hem Info. | Constraints Info.

Title

File Type:

D \Projects'\ TalertFroject’\Autocalibration\Mshe'Karup_v

[Non Equidistant Time Auis

Any Item T

| Obs Well 5

Minimum output time step: this]

Import..|
New Incl.
Name Data type plot X Y Depth Obs. Observed Data File
Data
Obs 5 head elevation in saturated zone & 518003 | 6.22917 5/ [ |C:\Users\... \Time\HeadObservations.dfs0
Obs 35 head elevation in saturated zone %] 507700 | 6.23336 S[ %] C:WUsers\... \Time\HeadObservations.dfs0
0Obs 37 head elevation in saturated zone ™| 511408 | 6.24164 S| M [C:\WUsers\...\Time\HeadObservations.dfs0
Obs 65 head elevation in saturated zone M 502766 | 6.2463e 5/ M C:Wsers\... \Time\HeadObservations.dfs0
[meter]
6260000 -2 ol g+ oo e
6255000 -SRI -1~

6245000

6235000

6230000 7

6225000 7

6250000 -

6240000 ----

6220000

500000

510000

520000
[meter]

The X and Y location can be selected on the map using the E button. This is useful if
you want to create a detailed output of specific output items at a critical locations.

Fully Integrated Exercises - © DHI A/S



Setting up a MIKE SHE Flow Model MIKE

2

=)

Powered by DHI

You are also welcome to add any other points and data items you like.

The New Plot checkbox is used to define whether or not a new html plot is created during
the simulation. For example, if you uncheck the first box, then the first two items will be
plotted on the same graph.

3.12.3 Create a detailed time series for the MIKE HYDRO output

MIKE View is used to evaluate the output from MIKE HYDRO River. However, MIKE SHE
allows you to create a detailed time series with observations during the simulation, similar
to the other MIKE SHE outputs.

Add a detailed discharge time series to the end of the Karup River.

. Under Storing of results select Detailed River timeseries output
*  Specify the name and location below:

- Name: 20.05 (outlet)

- Data type: Discharge

- Branch name: Karup River

- Chainage: 70454

- Incl Obs: check

- File name: .\Model Inputs\Time\flow.dfs0, and then select the item: 20.05

MIKE SHE Flow Made! Descript
¥ Dot [Detsled it dmeseries oupue

of Simulation spscification
o Mode! Domain and Grid Minimum output time step: 0.5 hrs]

o Topoaraphy

&

Climate = Hmr

o Land Use m ||+
o Rivers and Lakes Incl. =

« Overdand Flow Name Data type Branch name |Chainage| Obs. ‘Obs. Data Filename

o Unsaturated Flow " - Dot

o Saturated Zone 1 St. 20.05 (outlet) Discharge Karup river 52000 C:\Users\_\GIS Data\flow dfs0 . Edit... ||(New...

=

o Storing of resuits
o Detailed timeseries output
« Detailed M11 timeseries out
o Grid series output

o Bxdra Parameters

‘« 1 ]

" Setup... [Process. | Resus i

To add a Detailed MIKE HYDRO River time series, you have to know the chainage of the
h-point (for Water Level) or the g-point (for Discharge) ahead of time. If the value is not
exact, then MIKE SHE will look for the nearest point, within a certain search radius. If the
nearest point is outside the radius, the pre-processor will print a warning, but still use the
point. If there is no nearby point, then the output will be moved to the nearest point.

3.12.4 Select gridded outputs

In the Grid series output Dialog many items will already be selected if you have turned on
the storing of Water Balance data.

. Some gridded items of interest are not connected to the water balance data. By
clicking on the check box, turn on

8. Actual evapotranspiration,

- 39. Total Recharge to SZ, (pos. down)

- 44, Water content in the unsaturated zone.and
- 49. Depth to phreatic surface
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End of the Exercise

52

Enable ltem Required for Filename

1 ™ precipitation rate Water Balance Karup_basic.ehe - Result Files\Karup_basic_ET_AlCels.df
2 ] average water content in the rootzone Karup_basic.she - Result Files\Karup_basic_ET_AlCels.df
3 rooting depth Karup_basic.she - Result Files\Karup_basic_ET_AlCels.df
4 ] leaf area index Karup_basic.she - Result Files\Karup_basic_ET_AlICels.df
5 ] crop coefficient Karup_basic she - Result Files\Karup_basic_ET_AlCels. df
[ ] reference evapotranspiration Karup_basic.ehe - Result Files\Karup_basic_ET_UzCells.df
r ] ETrefx Kc Karup_basic.she - Result Files\Karup_basic_ET_UzCells.df
3 (] actual evapotranspiration Karup_basic.she - Result Files\Karup_basic_ET_UzCells.df
9 [] actual transpiration Water Balance Karup_basic.she - Result Files\Karup_basic_ET_UzCells.df
10 ] actual soil evaporation Water Balance Karup_basic she - Result Files\Karup_basic_ET_U=zCells df
11 ™ actual evaporation from interception Water Balance Karup_basic.ehe - Result Files\Karup_basic_ET_UzCells.df
12 ] actual evaporation from ponded water Water Balance Karup_basic.she - Result Files\Karup_basic_ET_UzCells.df
13 (] canopy interception storage Water Balance Karup_basic.she - Result Files\Karup_basic_ET_UzCells.df
14 [] evapotranspiration from SZ Water Balance Karup_basic.she - Result Files\Karup_basic_ET_UzCells.df
15 ] depth of overland water Water Balance Karup_basic she - Result Files\Karup_basic_overland dfs2
16 ] depth of overland water (TS average) Karup_basic.ehe - Result Files\Karup_basic_overland.dfs2
17 ] depth of overland water (TS min} Karup_basic.she - Result Files\Karup_basic_overland.dfs2
18 ] depth of overland water (TS max) Karup_basic.she - Result Files\Karup_basic_overland.dfs2
19 [] overland flow in x-direction Water Balance Karup_basic.she - Result Files\Karup_basic_overland.dfs2
20 ] overland flow in y-direction Water Balance Karup_basic she - Result Files\Karup_basic_overland dfs2
2 ] overland flow velocity (TS average) Karup_basic.ehe - Result Files\Karup_basic_overland.dfs2
22 ] overland flow velocity (TS min) Karup_basic.she - Result Files\Karup_basic_overland.dfs2
23 ] overland flow velocity (TS max) Karup_basic.she - Result Files\Karup_basic_overland.dfs2
24 ] flow from overland to river Karup_basic.she - Result Files\Karup_basic_overland.dfs2
25 ] finoded (yes,no) Water Balance Karup_basic she - Result Files\Karup_basic_overland dfs2
26 ] flow from flooded areas to river Water Balance Karup_basic.she - Result Files\Karup_basic_overland.dfs2
27 ] Overland flow to MOUSE Water Balance Karup_basic.she - Result Files\Karup_basic_overland.dfs2
28 ] External sources to Overland (for OpenMIl) (Water Balance Karup_basic.she - Result Files\Karup_basic_overland.dfs2
29 ] overland water elevation Karup_basic.she - Result Files\Karup_basic_overland.dfs2
30 ] NMean OL Wave Courant number (explicit OL) Karup_basic she - Result Files\Karup_basic_overland dfs2
H ] Max OL Wave Courant number (explicit OL} Karup_basic.she - Result Files\Karup_basic_overland.dfs2
32 ] Max Qutflow OL-OL per Cell Volume (explicit Karup_basic.she - Result Files\Karup_basic_overland.dfs2
33 ] H Water Depth m Karup_basic.she - Result Files\Karup_basic_Flood.dfs2

34 ] P Flux m"3/s/m Karup_basic.she - Result Files\Karup_basic_Flood.dfs2

35 ] Q Flux m*3/s/m Karup_basic she - Result Files\Karup_basic_Flood dfs2

36 ] infitration to UZ (negative) Water Balance Karup_basic.she - Result Files\Karup_basic_2DUZ_AlCells
ar ] exchange between UZ and 5Z (pos.up) Water Balance Karup_basic.she - Result Files\Karup_basic_2DUZ_AlCells
38 ] UZ deficit Water Balance Karup_basic.she - Result Files\Karup_basic_2DUZ_AlCells
39 [ Total recharge to SZ (pos.down) Karup_basic.she - Result Files\Karup_basic 2DUZ_AlCells
40 ] rate of change in UZ storage Karup_basic she - Result Files\Karup_basic_2DUZ_UzCells,
41 ] epsion calculated in UZ Karup_basic.she - Result Files\Karup_basic_2DUZ_UzCells
42 [] [Externalsources to UZ columns (for OpenMI|Water Balance Karup_basic.she - Result Files\Karup_basic_2DUZ_UzCells
43 ] unsaturated zone flow Karup_basic.she - Result Files\Karup_basic_3DUZ.dfs3

44 [ water content in unsaturated zone Karup_basicshe - Result Files\Karup_basic 3DUZ dfs3

45 ] pressure head in unsaturated zone Karup_basic she - Result Files\Karup_basic_3DUZ dfs3

45 Saturation in unsaturated zone Karup_basic.she - Result Files\Karup_basic_3DUZ.dfs3

47 [] [rootwater uptake Karup_basic.she - Result Files\Karup_basic_3DUZ.dfs3

48 ] External sources to UZ nodes (for OpenMl) Karup_basic.she - Result Files\Karup_basic_3DUZ.dfs3

49 [ depth to phreatic surface (negative) Karup_basic.she - Result Files\Karup_basic 2DSZ dfs2

50 ] elevation of phreatic surface Karup_basic she - Result Files\Karup_basic_2DSZ dfs2

1l ] head elevation in saturated zone Water Balance Karup_basic.she - Result Files\Karup_basic_3D5Z.dfs3

52 [] [=aturated thickness of SZ layer Karup_basic.she - Result Files\Karup_basic_3D5SZ.dfs3

MIKE SHE
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4 Running and evaluating MIKE SHE Flow Model

You can start this exercise by either loading a pre-defined MIKE SHE setup file, or using
the model that you developed in the previous chapter.

If you are starting the exercises here, then
*  Use the Open icon to open the Karup_basic.she file

% MIKE Zero - [Karup_basic]
@ File Edit View Refre:

O - | |
| ﬁ,i Open File F Madel Des

This model should be similar to the model you would have obtained by following the step-
by-step instructions in the previous Chapter.

In this exercise, the MIKE SHE filename is defined as YourFilename.she, as it may differ
from the one that you are using.

This exercise will familiarize you with the various output functions in MIKE SHE. However,

the exercise will guide you through only the most basic functionality of the tools, including
the Result Viewer, the Plot Composer, and the Water Balance tool

4.1  Pre-process the data
You have now specified all the input required for the model. Up to this point, all of the
input data has been specified independently of the numerical model. You have specified
only the characteristics of the numerical model that will be run.

Before actually running the model, you must run the Pre-Processor. The Pre-Processor
extracts all of the spatial data that you have included and builds the actual model files.

4.1.1 Run the preprocessor

Click on the . icon to start the Pre-Processor.

& MIKE Zero - [SHEPar2]

® Fle Edt View Refresh Run Window Help
|D@@| s @@ & 2| e)| e uw)
J- = ="' = == " |

The preprocessor will start the MIKE Zero Launch utility.
*  Click OK
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MIKE SHE

e ™

Launch |Pur|:|ose | Result Folder | Parallelizaﬁon|

Simulation

Motification on End of Simulation

[ via E-mail

Via SMS
CPU Priority | Normal mode -
Refreshrate 200 miliseconds

Upon successful completion of the Pre-processing, you should check the model pre-
processor log file to ensure the pre-processing finished without any errors. If the Pre-
processing did fail, then the log file should contain some information to help you locate the
problem.

The Pre-processed log files are by default located in the Result folder under MIKE SHE
exercises.

. Go to the results in Result\YourFilename.she - Result Files folder and double click
on YourFilename_PP_Print.log (the file should open in Textpad)

Scroll to the bottom of the file and check that the last line to ensure that the Pre-
processing was successful.

4.1.2 View the preprocessed data

After successfully running the Preprocessor,
+  Click on the Processed Data Tab located at the bottom of the Navigation Tree.

*  Then, click on the items in the data tree and explore the processed data.
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MIKE SHE Flow Mode! Description
=] Processed data
=] Processed data

Model domain and grid File name: View...
o [ C:\sers\nha\Documents\Karup - Douglas new MIKE SHE Karup_basic.she - Resut Files Karup_basic_PreProcessed.DFS2 |
o) Climate
Land Use [meter]

Rivers and Lakes

OvedandFow [} @2600003--------- 8 ket s g Sied e R AR SR oo SR
Unsaturated Flow 6260000 . i i !

Saturated Zone

6255000 -~ o e, TG . SRR A

6250000 - n WILTY K. 5 e

62400001 ¥ R
62350001
6230000 - e et : S .
6225000 -+~ e D ML Lol o . T
6220000 ; ; ;
500000 510000 520000
B meter]

The pre-processor creates a .fif file that contains the cell values etc. that will be used in

ﬂ the simulation. The processed data has been interpolated to the computational mesh,
exactly as the simulation engine will read it. However, the fif file is a binary format
optimised for use by the numerical engine.

The .fif file embeds all geometric data. Temporal data (time-series data) are not contained
in the .fif file, but are read directly from the source data files during the simulation.

To view the pre-processed data, a parallel set of .dfs2 and .dfs3 files are also created so
that the standard MIKE Zero tools can be used to view the data.

It is the dfs data that is shown in the data tree and listed in the file nhame text box. Clicking
on the View button opens the Grid Editor with the current pre-processed data file loaded —
with all the current overlays.

Spend some time moving around in the Processed Data and make sure you understand
the input data and the relation between Setup Data and Processed Data.

If you want to change any of the values in the Processed Data, you cannot just change
ﬂ the values in the Grid Editor. The values that you see are not the ones that will be used in

the simulation. Therefore to change the values you have to:

. Edit the values in the Grid Editor,

*  Save the parameter to a new dfs2 file, and

*  Then edit the Setup tab parameter to read from the new dfs2 file that you created.

4.1.3 View the river link setup

The MIKE HYDRO network is interpolated to the cell boundaries of the model grid. The
interpolated river locations are called river links.
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In the Processed Data Tab the most recent pre-processed file is automatically loaded
+  Goto the River Links Item in the data tree to view the pre-processed river links:

*  View the location of the river links in the computational mesh.

MIKE SHE Flow Model Description
5 o Prosmeddda [ MIKE SHE River Links and MIKE 11 River Network on Surface topography

=] Processed data

Model domain and grid File name: View...
o Surace topography | C:\Users\niha\Documents'Karup - Douglas new \MIKE SHE'\Karup_basic. she - Resuilt Files\Karup_basic_PreProcessed.DFS2 ]
Climate
Land Use [meter]
=] Rivers and Lakes

Bank minus Ground
Overland Flow
Unsaturated Flow
Saturated Zone

o 62600003----- - pceneise g e e feegne e

E-E-E

62550007 : o Wiadih ................
6250000 7} = i T IY XS met
6245000 42 P g " ...................
6240000 - %h s e
6235000 -+ : B PR BN T
6230000 1

6225000 == e e R

6220000

500000 510000 520000

—_— meter
== e

file can be loaded as a background map in MIKE SHE, or in any of the MIKE Zero display

ﬂ A .shp file of the River Links is also automatically created during the pre-processing. This
tools, such as the Grid Editor, Plot Composer, and Results Viewer.

4.1.4 View the river bank elevations vs topography

A mismatch between the topography and the bank elevations will sometimes lead to poor
OL-River exchange. You can use this item to locate areas were bank elevations are
poorly matched to the topography. Occasional, random areas of mismatch are OK.

The cross-sections are specified in MIKE HYDRO. Each cross-section includes a left and
right bank elevation. These elevations define how the river interacts with Overland flow.

. In our model here, overland flow will flow into the river if the water level on the land
surface is higher than the river level. Water will not spill out of the river.

*  However, if overbank spilling is allowed (Default = off), the river will spill on to the
flood plain if the river water level is higher than the bank and higher than the
topography. This requires the weir formula to be used in the OL Computational
Control Parameters dialogue under Simulation Specifications. The bank levels act as
weirs, and the water level must be higher than this “weir” to cross.

56 Fully Integrated Exercises - © DHI A/S



Running and evaluating MIKE SHE Flow Model MIKE i §

Powered by DHI

In the case where inflow to the river is restricted by the bank elevation, if water ponds
along the edge of your river, it will normally infiltrate and enter the river via baseflow.

A poor match in the elevation is sometimes a sign that your cross-sections are much
wider than your cell size. Typically, the elevation rises away from the river, and if you
define cross sections much wider than the river, then you risk having the bank elevations
defined many metres too high. A good rule of thumb is to define your cross-sections as

the normal bank full level.

If your bank-full cross-sections are much wider than your cell size, or if you want to
simulate large innundated areas, then you may want to use the Flood Code option.

WIKE SHE Flow Model Descrption
5 1 Pocesseddat [ River Bank fevel minus Ground level (max value if multple iver finks percel)
& o Processed data )
Model domain and grid i ew:s>
o Suface topography [ C:\sers\iha \Documents Karup - Douglas new\MIKE SHE Karup_basi.she - Result Fies\Karup_basic_PreProcessed.DFS2 |
® Climate
@ Land Use [meter]
& o Rivers and Lakes
¥ River Links S AR e s ¥ e RS N 2 R
¥ ST Sy ; : |
@ o Ovedand Flow : : :
® Unsaturated Flow
=] Saturated Zone - 9 H H
6255000 - sae B Taeeme e Do e -
6250000 R T S N et
6245000 3 B SR ot R B TR R
6240000 -~ R TR, i S A EnE R AR
| - [meter]
Il Above 10
1 K . ; 5 §- 10
e SR XN . i pe BB o T 6- 8
6235000 : : 1 _ ¥ -
: : B ] 2- 4
: 0- 2
; b i B 2- 0
62300003~ S ot g R Yo g N » B 4- 2
: ¥ s 2 B - 4
: ; B -6
: { Bl -10- -8
i f B -12--10
62250004~~~ e R e ! R F —
: i : Bl 6--14
Bl 13--16
Il Below -18
6220000 : : H [_1 undefined Value
500000 510000 520000
[meter]
SeupDaa  Processed Data |Results

4.2 Run the simulation

In the Toolbar, click on the Water Movement i icon to run the simulation.
This will start the MIKE Zero Launch utility.
. Click OK
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, ,

Launch |Purpose |Resu|tFo|der Ir—m lielizati \‘

Simulation

Notification on End of Simulation

7] ¥ia E-mail

Via SM5
CPU Priority | Normal mode ~
Refreshrate 200 miliseconds

[ OK. ][ Cancel ][ Help ]

The Launch utility allows you to change the CPU Priority and the Results Folder prior to
the start of your simulation.
You can also change the CPU Priority during the simulation by clicking on the yellow
button in the lower right corner of the user interface. You can stop the simulation entirely
by clicking on the red button.

17:2 2000/03/19,09:30 : Time step:55.15 min, avg: 7 BZ Iter/step: 12, avg: 5.6 S

17-2 2000/03/24,06:00 : Time step: 3.64 hra, awg: ; 52 Tter/step: 16, avg: 6.1

17:2 2000/03/31,05:44 : Time step: 4.66 hra, avg: ; SZ Iter/step: 9, avg: 6.2

17:2 2000/03/531,11:52 : Time step: 6.13 min, avg: ; SZ Iter/step: 3, avg: 5.9

17:2 2000/04/01,21:23 : Time step:50.25 min, avg: ; 52 Iter/step: 10, avg: 6.1

17:2 2000/04/09,0€:00 : Time step: 4.42 hrs, avg: ; SZ Iter/step: 18, avg: 6.7

17:2 2000/04/17,0€:00 : Time step: 5.33 hrs, avg: ; S5Z Iter/step: 3, avg: &.@

17-2 2000/04/18,15:55 : Time step:28.27 min, avg: ; 52 Tter/step: 3, avg: 6.3

17:2 2000/04/21,04:00 : Time step: 1.25 hrs, avg: 2.7 ; SZ Iter/step: 5, avg: 6.2 |

17:20:35 2000/04/22,07:48 : Time step:34.75 min, avg: 2.80 hrs; SZ Iter/step: 3, avg: 6.1 / 5\

-

2% 2000/04/22,07:48 1:20 hour{ [ ] )
Validation p Simulation A MIKE 11 Execution Log f{ \ /

4.3 View the results

Upon successful execution of the model you are now ready to view the results. First you

should check the model run log files to ensure the model finished without any errors. The

result files and log files are by default located in the Result folder under MIKE SHE

exercises.

*  Goto the results in Result\YourFilename.she - Result Files folder and double click
on YourFilename_WM_Print.log

»  Scroll to the bottom of the file and check whether the different model components
converged. Note that maximum iterations for some of the components may have
been exceeded. This could be an indication of mass balance errors and we will
check this when we create the water balance.

4.3.1 Locate the detailed time series output results
After successfully running the model:

»  Click on the Results Tab located at the bottom of the Navigation Tree and select
MIKE SHE Detailed WM Time Series.
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Obss [m] o o
Obs 5 [m]

630 75

620

All of the observations should also be visible.
You can add additional detailed time series items now and re-run the model.

The MIKE SHE Detailed Time Series output Dialog, under Simulation Results, lists the
Detailed Time Series results you have chosen to store during the MIKE SHE simulation.

If you have specified more than 5 items for detailed time series output, then you will only
see a page of links on the main Detailed time series page. The links will direct you to
separate .html files with 5 graphs in each.

To plot multiple items on a graph, you can use the New Plot column in the Setup to
combine output in one graph. If you unclick the checkbox, then this item will be plotted on
the same graph as the previous item.

MIKE SHE Flow Model Description
Desie | Detled Time Series Ouput

Simulation specification

- E

o Model Domain and Grid Iiniirriuirm outpt time: step: [hrs]

+ Topography
o Climate Import...
o Land Use r Incl

o Rivers and Lakes Name Data type New | 7§ 4 Y | Depth Obs.
Overland Flow et Data
 Unsaturated Flow 1 |obss head elevation in saturated zone A | g1s003] 62217 0 =HE
Saturated Zone 2 |obs3s head elevation in saturated zone [ 1| 07700] 623836 0 =
(=)~ of Storing of results 3 |obs 37 head elevation in saturated zone A | g11408] 624164 0 ] ea

o Detailed Time Series Output 4 |obsss head elevation in saturated zone A | g0eves] 624638 0 ] [cv

o Detailed River Time Series Output
o Grid Series Output
Extra Parameters I

4.3.2 Locate the MIKE HYDRO detailed time series output results

Similar to the groundwater levels, find the MIKE HYDRO (MIKE 11) detailed time series

$t20.05 [M3/s] @ o
St 20.05 (outlet) [m3/s]

4.3.3 Plot flows using the Plot Composer
It can sometimes be difficult to see how well the model fits the observations on this graph.
Alternatively try to use the Plot Composer for viewing the modelled and observed flow
hydrographs.

*  To open the Plot Composer click New File on the main menu at the top below File
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MIKE SHE

Select the Plot Composer

<3 New File
Product Types:
] MIKE Zero
I3 MIKE HYDRO ‘ ‘ ‘
= MIKET1 T Profile Series  Grid Series
15 MIKE 21 (.dtn,.dfs)  (dtl,.dfsl) (dfs3.dfs.. (
= MIKE3
I3 MIKE 21/3 Integrated Models A A .
IC3 LITPACK - y
=) MIKE FLOOD Result Viewer Bathymetries Climate Ecolab Auta
[E5 MIKE SHE (rev) (batsf) Chan... (-ecolab) Calibrat...
e & & & a
EVA Editor Mesh Data Time Series MIKE Zero
{.eva) Genera...  Extraction... Compara.. Toolbox {.mzt)
Time Series

Click Plot->Insert New Plot Object and select Time Series Plot

Click New Item and browse to the result folder YourFilename.she - Result
Files. Select YourFilenameDetailedTS M11.dfs0. Click the checkbox to select the
item and click OK.

Click New Item again and add the observed flow data .\Model
Inputs\Time\flow.dfsO

If you want, you can change the item names.
Click OK

To change the appearance of the graphs, right click on the graphs and select
Properties (make sure you have selected the figure by clicking on it). Click Curves
and change line colours and markers.

In the X-Axis and Y-Axis tabs you can change the length of the axes as well as some
other settings.

To save the graph as an image click View->Export Graphics->Save to Bitmap

Save the plot composer file in the Model folder as Flow.plc
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Karup basicDetailedTS [i11.6fs0
SHEWMadel InputsTime\flow. it
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43.4

Display the gridded results

The Gridded Data Results Viewer dialog lists the results you have chosen to store in the
MIKE SHE results files. The XY flow vectors check box adds groundwater velocity flow
vectors calculated for each cell.

The Layer no for groundwater items in the top of the dialogue is used to select the

numerical SZ layer number in groundwater outputs.

. In the head elevation in the saturated zone item, check on the Add XY flow vectors
for the plot and then click on the View result... button

-~ MIKE SHE Flow Model Description

Simulation Resukts

- o Mike SHE Detailed Time Series

 Gridded Data Resutts Viewer
Mike 11 Detailed Time Series

Post-Processing

SepDatla | Processed Dala Results I

=

the second time step.

On the menu at the top:

Laver no. for Groundwater items

1

Add XY-
ftem vectors
1 precipitation rate =] View result... J|C:\08 Training\2018\01.
2z depth of overland water [ Wiew result... | C:\08 Training\2018\01 E
3 infittration to UZ (negative) ] [ Wiew result_. ]| C:\OE Training\2016\01.
4 exchange between UZ and SZ (pos.up) [l [ Wiew result... || C:\08 Training\2018101.
5 head elevation in saturated zone 7] View result. C:\06 Training2016\01
& seepage flow SZ -overland = [ Wiew result_. ]| C:\O8 Training\2016\01.
7 seepage flow overland - SZ (negative) [l C:\08 Training\2016\01.
8 groundwater flow in x-direction ] C:\08 Training\2016\01
9 groundwater flow in y-direction =] Wiew result C:\06 Training2016\01.
10 |groundwater flow in z-direction Tl [Wiew result... || C:\DE Training\2016\01.
11 | SZ drainage flow from point M [ Wiew resuft... ]| C:\06 Training\2016\01.
< [ ]

Note that the velocity vectors will not be visible in the initial time step, but appear in

JJ|« MO [l o o[ A |[R @ake 0| 0 L
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you can play through the entire simulation, change the time step or create a video.

To step through the simulation click on " on the menu.

process during a course.

I I Note: Creating an .avi video is very time consuming, so don’t start the video creation
[m] head elevation in saturated zone.REV

6260000 7
6258000 7~
62560001
6254000 7--
6252000 1
62500007 e
- ATt
6248000 -
62460001 3
6244000 7~
62420001 |-
6240000 §--
6238000 -~ T e
6236000 1+ TR
3.7 head elevation in
9234000 saturated zone [m]
1al.: Hl 112-120
6232000 ' I 104-112
: ] 96-104
6230000 -+ 88- 96
] 80- 88
S 72- 80
6228000 28
A 56- 64
6226000 7-- 48- 56
: 40- 48
IR 32- 40
6224000 ; 24- 32
: 16- 24
6222000 1+~ 8- 16
0- 8
Below 0

6220000 -

495000 500000 505000 510000 515000 520000 525000
[m]

Undefined Value

31/12/2007 00:00:00, Time step 1825 of 1825

4.3.5 Display a time series plot at a point
To view time series in points go back to the Gridded Data Results Viewer

. Click View Result... for head elevation in saturated zone. Untick Add XY -flow vectors
if these are ticked

*  Click OK when you are asked if you want to overwrite the existing file.

. Click on the Time Series button ’E on the Results Viewer tool bar

*  Click once inside the map area and then while holding down the Ctrl-key, click on
each additional point where you want time series output. Each selected locations is
marked with a yellow x.

+  Double click on the last point. (if you only want one point then simple double click
without holding down the Ctrl-key)

*  Check Display and press OK to display the time series.
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Items

Ttem Querview

Accumulated unit| Iltem name

1 meter head elevation in salurated zone (38, 44, 1)
meter head elevation in saturated zone (12, 46, 1) L
meter head elevation in saturated zone (20, 57, 1)

meter head elevation in saturated zone (8, 75, 1) L

o
@
B
>
| | ) o ]

JEIEIE

Cancel ey elp

Export to a dfsO file

. Right-click in the time series plot.

. Select Export... in the pop-up window.

. Check Export and press OK.

. Enter an appropriate file name for the dfs0 file and press Save.

Zoam [n

Zoam Cuk

Presious Zoom

Idexk Zoarm

Fan (Shift)
Refrash

v farid

Copy to Clipboard
Save o Metafile, ..
Save to Bitmap. ..
Font. ..

Properties...
Export...

ﬂ The (j,k) coordinates listed at the bottom of the Results Viewer go from 0 to (nx-1) and 0
to (ny-1) in the j and k directions, respectively.

Note that the time series time steps are equal to the storing time steps. The Detailed
timeseries output option within the Setup Data saves the output at every time step.

4.3.6 Extract a profile of water levels

. Press the button ’F on the Results Viewer tool bar to extract a profile from the
simulate output item displayed

. Click in the area of interest to select the points along the profile line. Double click on
the last point of the profile to terminate the profile line. The profile line is indicated
with a thick green line.

Check 3D head elevation in saturated zone and press OK.
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A File Edit View Projects Window Help

=i=2-1 l@ew||aaaz ol s e e A b e [
(m] head elevation in saturated zone REV
6260000 3=~ -
6258000 7
625600011~
6254000
6252000 7
6250000 ) R S S e -
6248000 - e ot
5246000 1| paen SEEEEEEEEEEEEREEEE L, g bt
x|
Profile [kem S election
— Itemn Overvie
Display tem name File name | tem type Unit Glb n
1 ol 30 Yertical Conductivity E:'ProjectziTr MShe mis 1]
2 [ 3D Storage Coefficient E:'ProjectziTr MShe 1/m 1]
51 l 3D Specific Yield E:'ProjectziTr MShe 4] 1]
4 ol 30 Horizontal Conductivity, Y-dir.  |E'ProjectsiTr (MShe mis 1]
5 ol 3D Horizontal Conductivity, X-dir. E'\ProjectsiTr (MShe miz a
[ [ 30 head elevation in ssturated zone |EProjectsiTr \MShe meter 158065
7 ol 30 Caloulstion layers E'ProjectsiTr [MShe meter o
«| | i
[ Dtz M11 items
QK I Cancel | Spply | Help |

To display the computational grid on the profile, in the Projects pull-down menu choose
. Active View Settings -> Profile...
On the Graphical Items tab of the Dialog that appears, under Calculation layers,

*  Check Draw Calculation layer and select Draw as grid to show the computational grid
or Draw as lines to show the upper and lower surface.

. Press OK to view the selection.
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Im] 01/01/2003 00:00:00

2000 3000 4000

4.3.7
result viewer

Graphica toms

90 Nead eevalon in satrated zone
yer 1

W11 ems
—ut

W1 crass sectian

Modify visible overlays and display the finite difference mesh in

First, return to the horizontal view of head elevation in saturated zone, by either closing
the cross-section view or switching via the Window pull-down menu

* In the Projects pull-down menu choose Active View Settings -> Horizontal ...

E MIKE Zero - [head elevation in saturated zone REV:1 - Modified]

. File  Edit  View [ijecls] Window Help
Add Files to Project... e laa e ol

Active View Settings » Haorizontal...
Work Area... Profile...
Video 4 Cross Section...

'I Tirne Series...
5254000__ - ____:r _________ UZ Plat...

Overlay Manager...
5252000__ - ____: _________ Font...
6250000 --1----F-------c--2---

In the Dialog that appears

|H5|PP|

head ele

_________

«  Single click on the Rectangular Grid item: YourFilename_3DSZ.dfs3 to view the

available display options

. Under the Miscellaneous items, check Element Mesh

. Press OK to execute changes
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MIKE SHE

Result Data Properties

[Joraw isslines
Draw labels

[] Element mesh
[ outline grid [ color legend

Result Data Styles  Colors

-+ Rectangular grid:

- Rectangular grid: C:' 2D Grid Styles

- o Shapes: C:\Users'ni & 0raw grid

-1 Vectors: C:\Users'ni Contour type

o Vectors: C:\Users'ni

|Bm:m1ln.r v| |I}awbnxcnnln.lmilhwt{ivida v|
Isolines Miscellaneous

| Smooth edge

Item/Layer
Ttem: |haaddevalinn'r|sall.lalrd ZONE V|
Slice type: |Lawr slicing ~ |
Layerno: 1 3D single layer
< >
OK || Cancel || Aoy || Hep
[m] head elevation in saturated zone.REV
s T f | | |
6260000 ] 1 1
6258000 1 :
6256000 -1 +
6254000 -5 : -+ -
6252000
6250000
62480001 -
6246000 -
6244000 7
62420001
624000041
6238000 3+
6236000
34000 ' head elevation in
62 : saturated zone [m]
| i Il 112-120
6232000 1- ; - B 104.112
] ] ! I mm| 5 96-104
6230000 1- i i - + 88- 96
] ; ] ] ;n = 80- 88
S ramm 72- 80
6228000 1 ; ' ' : GGEE B 64- 72
6226000 : : ) : ' -
X -“,\j T B E 40- 48
1. : 32- 40
6224000 : : : = ol
] - u ] 16- 24
62220001 i T E waw | g i
0 T A I m »
18 IREEE ] 3 | Below 0
6220000 ; ; ; ; H ; ; [_1 undefined value
495000 500000 505000 510000 515000 520000 525000

01/01/2003 00:00:00, Time step 0 of 1825

[m]
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4.3.8 Display other gridded data results

The number of gridded data items that are available depends on which modules were run

and what selections you have made in the Setup. Many of these items are very useful for

evaluating the integrated groundwater surface water interaction. You should explore some
of these output items. For example:

*  Actual evapotranspiration — this is the sum of all the ET components. It is useful for
evaluating the spatial distribution of actual ET.

+  Depth of overland water —typically this is a useful output for finding areas with
permanently ponded water, or areas with closed depressions.

. Seepage flow SZ — overland — this can be used for determining where springs are
occurring in the model.

*  SZexchange flow with river — this is useful to find losing and gaining river reaches.

. SZ drainage flow from point — this output maps the locations where groundwater is
contributing water to the SZ drainage network.

*  Total Recharge to SZ — this is a summary output map of all the items that contribute
inflow to the SZ.

View simulation statistics

2

Statistics used for assessing the model fit are available in the Results menu under Post-
Processing. The statistics are generated in HTML file format and include all the detailed
time series items that have observation data.

The calibration statistics available comprise six standard statistics:

Mean (ME), Mean Absolute Error (MAE), Root Mean Square Error (RMSE), Standard
Deviation of the Residuals (STDRes), Correlation Coefficient (R) and Nash Sutcliffe
Correlation Coefficient (R2).

The equations for calculating the statistics are included in the Help menu and can be
accessed by pressing the F1 key while placing the cursor over the Post-Processing menu
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MIKE SHE Flow Model Description

O ¥ St et T
o Mie SHE Detaled Time Series
o Gridded Data Results Viewer

 Mice 11 Detaied Time Series 2 MIKE SHE [=[&] = ]
& of =
 Simlation Siatisics Gl uigd
Hde Back Pt Opions
Corterts 7
@ Getting Started Statistic Calculations

@ Rurning MIKE SHE
Results and Calibration The statistics contained in the HTML document and the shape file are calculated using the same methods used to calculate statistics for the

@ Suface Water detailed time series output

@ Drainage modeling with MIKE URBAN|

@ Groundwater

@ Addiional Optons The standard calibration statistics calculated based on the differences between the measured observations and the calculated values at the

same location and time. Thus, the error, or residual, for an calculation - observation pair is
Working with Data

() The MIKE SHE Reference Guide
Referance Guide Overview
4® Setup Data Tab
@ Proprocessed Data Tab where E, is the difference between the observed and calculated values at lacation i and time t
=-{) Resuts Tab
® Resuis of Simulation Mean (ME)
() Results Post-processing
&-{() Run Statistics
| Statistc Calouiations

(4.1) E;, = Obs, .- Calc; ,

i

The mean error at location i where n observations exist is

[?] GeoScene3d
@ PT Registration Extraction S(Ew
- [2] PT Pathiine Extraction @2) ME=E=1_
@ MIKE SHE Ediors n

@ Technical Reference for Water Moven|
@ Technical Reference for Water Qualiy| Mean Absolute Error (MAE) -

The mean of the absolute errors at location i where n observations exist is
3kl

43 MAE =[] - i—

Root Mean Square Error (RMSE)

The root mean square error at location i where n obsenvations exist is

[sE o
(44) RMSE, = | J_n;

Standard Deviation of the Residuals (STDres)

‘ 0 S The standard deviation of the residuals at location i where n obsenvations exist is

SepDasa | Processed D2 Results

Note that the statistics are calculated based on the differences between the measured
observations and the simulated values at the time of the observations.

*  To generate statistics for the Karup model click Post-Processing->Simulation
Statistics on the Results tab

+  Change the start date to 1/1/2004 and click the generate statistics button
[ Generate Stafistics ]

»  Take a look at the statistics and assess the model performance

-~ MIKE SHE Flow Model Descript.

& [ Post-Processing Start Date: End Date:
' Simulation Statistics Senerate Statistics| [01/01/200400:00:00 [~ | [31/12/2007 00:00:00 [~ |
Start date for statistical analysis: 01/01/2004
End date for statistical analysis - 31/12/2007
R R2
Name Data type X Y Layer ME MAE BMSE  |STDres (Correlation) |(Nash_Sutclffe)
head elevation in -
Obs 5 caturated zone 518003 |6.22917e+06 |1 0198338 0.198338 0.244818 0.14352  |0.966013 0.716375
head elevation in -
Obs 35 <aturated zone 507700 |6.23836e+06 1 0155847 0.155887 0.184807 0.0993257 [0.988202 0.902199
head clevation in -
Obs 37 caturated zone 511408 |6.24164=+06 |1 0.245205 0.245205 0.264688 0.0996704 0.976132 0.396855
Obs 65 lhead clevation in 302766 |6.2463e+06 |1 -0.14174 0.142771 0.210001 |0.154952 |0.936615 0.795403
saturated zone
St 20.05 (outlet) (Karup discharge in river q- -
River. 69727.00) point 499425 16.25946¢c+06 0300178 0.318553 0.403968 0.270339 |0.981983 0.884483
< >
Setup ... | Processe... Resuts

4.5 Check the water balance

The water balance utility in MIKE SHE is a vital part of the results analysis. The tool is
versatile and can be used both for providing an overview of component inflows, inflows
and storage changes over different periods and subcatchments and for troubleshooting
any numerical issues.
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45.1 Create a new water balance document

[

. Click on the New document icon, , or the File/New/File menu

*  Select MIKE SHE and then the Water Balance Calculation (.wbl) document

*  Click OK
@rewre x|
Product Types: Documents:
@5 MIKE Zero
3 MIKE HYDRO . ‘ ' ' ! ‘
3 MIKE 11 Flow Model  Well Editor UZ Sail ET Vegetation v Simple Shape
3 MIKE 21 (.she) (wel) Properti... Properties (... Editor (.shp)
=3 MIKE 3
5 MIKE 21/3 Integrated Models A
5 LITPACK
£3 MIKE FLOOD | MIKE SHE
" MIKE SHE il Toobo...
Water Balance Calculation
core
4

In MIKE SHE, water balances are calculated by the water balance utility. This is run
ﬂ separately after the simulation. Creating a water balance involves 3 steps:

1. Extract the water balance data from the MIKE SHE output files
2. Create specific water balances from the extracted data
3. Evaluate the water balance output

45.2 Extract the water balance data

*  Use the browse button and find the .sheres file from your simulation in your Result
directory ...\YourFilename.she - Result Files

. Run the water balance extraction by clicking on the Extraction icon, E or by
selecting the drop down window Run and clicking on Extraction. You will be asked to
save your water balance file. If the extraction icon does not appear at all, most likely
the Run toolbar is not activated. Select the drop down window View, Toolbars and

B select the Run toolbar (last entry).

Check to make sure that the Extraction ran successfully, by looking for “Normal
termination” in the message window
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MIKE SHE

® SZWaterbalance.wbl =] =[]

o (Bwacon

“w/ater movement simulation

Flow result catalogue fle; C:AData‘MIKE Zero Projects\MIKE_SHE R esulth521 sk E]
Type of extraction
Area Type: Catchment -

Resolution Type: Area -

Sub-catchment grid codes

Dis2

Gross files

Pre-name of gross files: Use default filename

C:AData"MIKE Zero Projects\MIKE_SHE\ResulthS521.she - Result FileshS21_1_1

Exiraction |[Postpr.. Result

MNormal termination

100 2% 45 seconds
Walidation  #, Simulation l/r

MIKE SHE saves the results in many different files. The results are grouped by process
(e.g. OL, UZ, SZ) and by output type (i.e. 2D or 3D). The extraction process reads all of
the various output files and builds a set of water balance files. These files can be
efficiently read by the water balance utility.

The .sheres file is an ASCII catalogue of all the output files associated with the simulation.

The type of extraction is important, as it defines what subsequent water balances can be
calculated.

*  Area Type — Choosing subcatchment allows you to create water balances for sub-
areas in the model domain. Otherwise, the water balance is for the entire model
area.

. Resolution type — By default the water balance is for the entire catchment or sub-

catchment. The Single-cell option allows you to create maps of some of the water
balance items.

453 Create water balance items

*  On the Postprocessing tab, add two post processing items to the table by clicking on

the new item icon,

*  Change the name of the two items, so that you can distinguish them from one
another

You can set up any number of water balance calculations for a single water balance
extraction. Since these are all stored in the water balance document (.wbl file), you can
re-run the water balance extraction and processing after each simulation.
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o
® sZWaterbalance.wbl - Modified

=~ x Postprocessings
- % Total water balance grap...
- m Time varying water balan... . o
Alternative config file: Usze default Config file
|E:\Program Files (+8E)DHIN201 T\binhShe_Wbl_Config.ps | B
Postprocessing name Comment
il Tatal water balance graphic
2 Titne warying wwater balance
< m ] »
Extraction  Post proce._. 4] [ b
-

=

Hormal termination

45 seconds

|

100 %
A R validation Simulal:ion,-'r
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454 Define a Chart water balance

+  Select Chart output: Total water balance from the list of available Water balance
types

+  Define a file name for the output file, for example TotalWB.txt. If you just type the
name the program will automatically put it in the result folder

*  Run the water balance by clicking on the water balance icon run selected

postprocessing,
&5 MIKE Zero - [SZWaterbalance.wbl - Modified] =
® File Edit View Run Window Help = [|& | x
= | T OKZ ||| 05 ¥ 82

= p Postprocessings
/ Tasevsrce v | | (K@l Water balance graphic

® Time varying water balance

Water balance
Water balance type: [Chart output: Total water balance -
Description: Chart output: General water balance of the entire model {depth-
integrated)
Output period
Use default period 2000/01/01 00:00 = 2010/12/31 00:00 = |z|

Output Timeseries Specifications

Use default output time step 24 Accumulated
Layer Output Specifications
Al layers 0
Sub-Catchment Selection Single-Cell Location
Qutput File
Tt file:  rup_basicé she - Result Files\ TotalWB b E]
Exracion  Post processing -
2010/12/31,00:00 (1l00.0 %) e~
Normal termination ltl
100 % 27 seconds
Validation j Simulation /

Ready Mo Tracking

The Chart output creates a graphic illustrating the water balance items (see next step).
ﬂ The output is sent to an ASCII .txt file, and the graphic is generated automatically by a

utility that reads the txt file.

By default, the water balance is summed for the entire simulation period. However, you

can easily change the water balance period, for example, to create seasonal water

balances, or to remove the initialisation period.

If you defined the extraction on a sub-catchment basis, then you can select from the
available sub-catchments in this Dialog.

4.5.5 View the water balance output

*  Onthe Result tab, select the sub-item for the Chart output
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*  Click on the Open button beside the file path to create and open the water balance
graphic

*  To save the chart as an image file click File->Save Graphics... and select either
Enhanced Metafiles (.emf) or Bitmap Files (.bmp)

Total Error
0

Precipitation
3942

a

Evapotranspiration
2506

Snow-Storage change
i )

& & 0
Canopy-Storage change & & 2 -
0

OL-Storage Y X ST ey Boundary flow
6 A

2

Base flow to River
1 723

Accumulated waterbalance from 01/01/2003 to 31/12/2007. Datatype : Storage depth [millimeter].
Flow Result File : C:\Projects\Karup\MIKE_SHE\Result\Karup_basic.she - Result Files\Karup_basic
Title - Text *

The water balance graphic shown for the full model simulation period includes all of the
non-zero water balance items in the current simulation (except for storage changes, which
are always plotted).

The water balance items are all normalised to units of mm, which allows for easy
comparison between the different components. If you want to convert depths of mm to
volumes, you need to multiply the depth by the internal model area. That is, the total
model area minus the area of the outer boundary cells. If you load the pre-processed data
into the Grid Editor, select the Model and Domain item. Then, you can use the statistics
function in the Grid Editor to find out the number of internal versus external cells.

Note: The sum of the water balance terms in the graphic do not add to zero. This is
because some of the signs have been removed (e.g. Precipitation and ET have the same
sign, but opposite inflow/outflow directions). In the water balance calculation, inflows are
negative and outflows and storage increases are positive.
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45.6 Define a time varying water balance

Return to the Post-processing tab and select the second water balance item

»  Select Total water balance from the list of available water balance types

*  Leave the Output type as Accumulated

*  Select the Output file type as a Time series file

*  Input a filename with the .dfsO extension, for example TotalWB.dfs0. Unless you

browse to another location, the file is automatically saved in the results folder.

. Run the water balance by clicking on the run water balance icon

= & Postprocessings
 Tocwaercdonce oo | | [NIGNVAIVINGIWALEr balance

o Time varying water balance

Water balance

Water balance type: [Total waterbalance -

Description: General water balance of the entire model setup

Output period

Use default period 2000/01/01 00:00 = 201012431 00:00 = |z|
Output Timeseries Specifications

Type:

Use default output time step 24 Accumulated -

Layer Output Specifications
Al layers 0

Sub-Catchment Selection Single-Cell Location

Qutput File

Type: | Time series file ~ | DfsOfile: C:\data\MIKE SHE training material\Karup_t g

Extracion Post proces. .. -

2010/12/30,00:00 {100.0 %) -
2010/12/31,00:00 {100.0 %)

Normal termination -

100 % 27 seconds

Validation A Simulation /

If you chose the Table format for the Output file instead, then the output will be in a tab-
delimited ASCII file that you can open in Excel.

In this exercise we have chosen an Accumulated water balance. This sums the water
balance over the simulation period.

The alternative is to define an incremental water balance, which outputs the water
balance time series at each saved time step.
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4.5.7 View the water balance output

*  Onthe Result tab, select the sub-item for the time series output, Time varying water
balance

*  Click on the Open button beside the file path to create and open the water balance
time series file (.dfs0)

Accumulated water balanee - TOTAL z T T e e e 2 e e e e e e e
- 0 0

2500

—<Precip [millimeter] | —

—e-Canopy Stpr. Change [millimeter] 2 f -
—a-Evapotrans [milimeter]

20007 -4 ii

1500 0L Bou.Ouiow [\mlllrle{e]\[

~8-OL->Ext Sinks (milbmeter]
#-0L>Riv il

1000} ~#-0L Drain.SRiver MOUSE [riilimete
—<-OL Drain=>0L OUT [milimeter]
ter]

i
500 3-S5y

ange-friheter

o JPurmping [Milirieter)
{57 Drain >River [mil

SZ Drain

Lok

s=-Basefiow from river [millmeter]
1000 | —@-Enar fmisimeter

2003 2004 2005 2008 2007 RTE0) o

The water balance time series file includes all of the available water balance items — most
of which are also shown on the chart of the total water balance.

The cumulative water balance sums the items over all of the stored time steps. Scrolling
to the bottom of the file the total precipitation is the same as in the graphical total water
balance chart above. Some items have been lumped together in the chart.

Note, that the sign of the precipitation is negative and ET is positive in the time series file.
This is consistent with the water balance sign convention which is:
*  Outflow — Inflow + StorageChange =0

Thus,

«  Allinflows to the model are negative

*  All outflows from the model are positive

A negative change in storage means that water is accumulating (an ‘Inflow’)
* A positive change in storage means that water is draining (an ‘Outflow’).

One important thing to remember is that the water balance is only an output of the saved
time steps. Thus, the dynamics between the saved time steps are lost.

End of the Exercise
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Building a MIKE HYDRO Model for MIKE SHE

The purpose of this exercise is to get to know MIKE HYDRO by inspecting and
completing a MIKE HYDRO river model for a MIKE SHE model. The model is based on
the stream model for Karup used in the Karup integrated MIKE SHE exercise. The
exercise covers the following topics:

* Adding ariver branch and boundary conditions

. Generating cross-sections from a DEM

*  Routing vs dynamic branches

*  Adding a weir

. Model stability

*  Using MIKE View for result processing

Demo Note: The MIKE HYDRO setup has too many elements for you to save the
model. You can follow the steps in this section for practice, but you will not be able to
save or run the model with the changes.

Open the MIKE HYDRO model setup file

2

Ensure that you have installed the Example files in the previous Getting Started exercise.
Open the MIKE Hydro model by double clicking on the Karup_v1.mhydro file. This could
take a few seconds.

The MIKE HYDRO interface is similar to the MIKE SHE interface, but is more map-
oriented. It includes all the model settings and parameters on the left pane.

A map of the river setup is shown in the middle window. It is possible to shift between the
map and tabulated values by clicking Map or Tabular in the bottom left corner of the map
window.

Model components can be selected either on the left pane or by clicking the tabs above
the map window. Details of the model components are shown in the pane to the right of
the map window.

Icons for zooming in/out and for inspection of stream parameter values are available from
the toolbar above the map.

A Validation pane at the bottom shows any data input errors in setup.

. Click Zoom to working area for a visual inspection of the river setup
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B MIKE Zero - [karup_v1.mhydro - Modified] - o x
@ Fle Edit View Run Tools Window Help

DEH 4 RB ST

T kL

Map Branches Cross sections Structures Boundaries Storages Spatial data

= —* = 2 % g X *
gic (P2 LE | QER E X ¥ ¥

X .
Select | Add Edt Cut Memge Delete | Select Add Move Delete | Select Add/Edt Delete

1810]0x3 Pafoid G|

(X.Y) = (48833852 , 6220065.55) [meter] Map scale: 280340
Setup | Symbology  Result Py

Validation [3

Validation | Simulation

Ready No Tracking Mode NUM

On the left pane the Simulation specification menu allows you to select the type of
modules to include in the model setup. In this case the river module and a hydrodynamic
model run have been selected. Depending on the selections, different data input menus
will be available below.

*  The simulation period and time control are also specified here. However for a MIKE
SHE model run the simulation period is overridden by the simulation period specified
in the MIKE SHE menu (see 3.3.2).

*  Map configuration allows you to specify the coordinate system and include
background maps.

. River network includes details of the river network including control structures.

. Hydrodynamic parameters contains the bed resistance.

. Boundary conditions include boundary conditions and specification of coupling with
MIKE SHE.

. Initial conditions allows for initial flows and water levels to be specified.

*  The Results specification menu allows you to set the output file name and storing
frequency for the output. In dynamic simulations the time step for MIKE HYDRO river
can be quite small, so it is often necessary to reduce the storing frequency.

5.1.1 Set the results directory
The current results directory can be changed under Result specification->Standard results

. Ensure that Use default result folder is ticked

This will create a result folder using the MIKE HYDRO name: karup_v1.mhydro — Result
Files with the results in the Result folder located under MIKE SHE exercises. You can
select a user defined folder instead but make sure you use a sensible name.
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+  Leave the result file name unchanged

Use default result folder
Result folder path:

C:\Work\main'Products'Source\Manuals .M She' \flowmodel\exercises\Exercise Files Test \Kar

[[] Use default names
Storing Frequency  Unit

RR result filename: RR_kamnp res1d 1

Time step ~
HD result filename: KARUPrestd| | - | [24 | Tmestep -
AD result filename: AD_karupresid| | .. 1 Time step ~

5.2  Explore the branch network and add a branch

On the Setup pane select River network -> Branches or click the Branches menu above
the map.

*  Inspect the stream network in the map view.

The appearance of the river can be modified by switching from the Setup pane to the
Symbology pane on the bottom left. Select Tabular view to change symbols and labels.
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Sej.Creek

- Viaard

ersirg

One tributary named Sej Creek is currently missing in the river setup. The river branches
are shown on the background map as blue lines.

*  Add the missing branch by clicking File -> Import -> Import from Shapefile. Select
AKarup_Mhydro\GIS data\Sej.shp

»  Tick Branches and in the combo boxes define the attributes for Branch name, Topo-
ID, Start and End chainage, Chainage unit, Flow direction and Branch type.

Shapefile attributes:
Branch name:  Topo-|ID: Start chainage: End chainage:  Chainage unit: Flow direction:  Branch type:
Branches  [C:\Projects\Kanup_exercise\MIKE_SHEY| | .. | [RverName +[[TopolD  «[[BRS.stat | [BRS.end +||m | [FLOW_DIRZ ~ |[BRS type -
[ Auto connect branches % Maximum distance for aute-connection: |50 meter

. Click Run, then OK, then Close

5.2.1 Convert the branch from Dynamic to Routing

. Select Tabular to view the branch details.

*  Change Sej creek from a Regular branch to a Routing branch in the Branch Type
menu in the Tabular view
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General  User defined chainage points
Definitions
Branch Name Topo ID Start Chainage End Chainage Flow Direction Branch Type
Sej Creek | [model_cross |[o | [12978 Posttive | | Routing v
Connections
Connection type Branch Name Chainage Storage 1D
Upstream Branch v l:l Edit coordinates of vertices.
Downstream Branch o l:l Load shape
- Filtering: | Show all branch types ~
Topo Start End Flow Branch Upstr. connect Upstr. UpStr.
Name 10 Chainage Chainage Direction Type type Mame. Chainage Upstr. st
1 [ |Haderup River |model_cro... |0 10934 Positive ~ | Routing ~ | Branch ~
2 [ |Grndeskov ... |model_cro... |0 16250 Paosttive ~ | Routing ~ | Branch ~
3 [ | Haller River model_cro... |0 15473 Paosttive ~ | Routing ~ | Branch ~
4 [J |Bording River |model_cro... |0 6196 Paosttive ~ | Routing ~ | Branch ~
5 [J | Karup River model_cro... |0 70454 Paosttive ~ | Regular ~ | Branch ~
(3 [0 |MaresvadCr... |model_cro... |0 11083 Paosttive ~ | Routing ~ | Branch ~
b7 nSej Creek model_cro... |0 13976 Paosttive ~ | Regular ~ | Branch ~
< >
Map | Tabular -

A reqular branch will calculate the water level based on the Saint-Venant equation

ﬂ (Kinematic, Diffusion or Dynamic Wave formulations). For detailed simulations, you would
generally use regular branches.
However, often it is convenient to use simpler routing formulations, where the water in the
river is moved down the river — without actually calculating the water levels. Water levels
are calculated afterwards knowing the flow rate in the cross-section and back-calculating
a water level.

The main advantage of the routing methods is their speed. They require less data, they
are numerically stable and you can use long time steps if you want.

The downside is that the calculated water levels are less precise and hydrodynamic
effects are ignored. Water levels are simply calculated based on the amount of water in
the river in the current time step.

You may also combine different approaches, for instance by using simple routing
techniques on the upstream, steep branches and the dynamic wave method on the
downstream low-gradient branches.

For simplicity and to ensure the model runs fast, the existing branches have all been set
as routing branches.

5.2.2 Connect the branch to the Karup River

Return to the map view and
«  Zoom to the confluence with the dragging zoom function in the icon bar
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Branches Cross sections Structures Boundaries Storages Spatial data
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Select | Add Addtrace  Edit Cut Merge  Delete Select  Add Move  Delete Select Add/Edit Delete
Branch el User defined chainage points Branch connection [F]

»  Connect the branch to Karup River by clicking the Add/Edit connnection button s ,
then clicking on the end of the Sej Creek branch and dragging the cursor over to the

Karup River (you will see a cross appear on the Sej Creek, and then a large dot
when you are over the Karup River)

*  Now, go to Tabular view and change the downstream connection chainage for Sej
Creek to chainage 57054 (the location of a cross section)

I SN Y H «

Map  Branches | Crsssections | Stuctures | Boundares  Storages  Spatial data

- —F ¢ 5 2/ — —X 3 X x
R ¢ L LLEC @ €@ 2 | il
Select Add A ace Edit Cut Merge Delete Select Add Move Delete Select | Add/Edit Delete

5.2.3 Routing methods

To view the routing method parameters go to River network -> Routing method Dialog.

*  Onthe last entry select Sej creek and specify a chainage of 13876. No other
changes are required.

In the Routing Method Dialog you only need to specify a chainage close to the end of the
branch. If no other specifications are made, the model will:

*  Calculate water levels using the Manning Equation assuming that the energy slope
equals the bed slope derived from cross-sections (Manning numbers are specified in
the HD11 file default is M=30 [m1/3/s], n=1/M).

*  Use the No-Discharge Transformation option, which implies that inflows are summed
along the branch and transferred to the downstream end of the branch in the same
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time-step. This is the same as a full pipe with a unit of water entering one end and
pushing a unit out the far end.

*  Another discharge computation option is the Muskingum methods. It dampens the
peak flows as they travel downstream, which is necessary when the travel time in the
river is much longer than the time step. For example, in large river networks, it may
take several days or longer for a flood wave to travel from the source to the river

mouth.
Location Water level method
Eranch name: |Sej Creek v| Method: Manning ~
Chainage: | |
ID: [Method 5 |
Flow routing method
Method: No flow routing
Delay parameter: 0
Shape parameter: 0
+ - x
i 1
Branch Chainage D E;‘;Dﬂmmg Delay Shape r.:';theorclievel
1 [0 |Haderup River |~ | 10834 Method 1 Mo flow routing |~ |0 0 Manning w
2 [ |Grindeskov C... |~ 16130 Method 2 Mo flow routing |~ |0 0 Manning w
3 [ |Haller River ~ 15373 Method 3 Mo flow routing |~ |0 0 Manning w
4 [ |Bording River |~ | 6096 Method 4 Mo flow routing |~ | 0 (1] Manning e
# 5 [ |5ejCreek ~ | 13876 Method 5 Mo flow routing |~ |0 0 Manning w
6 [ |Aaresvad Cre... |~ 105983 Method & Mo flow routing |~ |0 0 Manning w

Note: In the routing option calculations are only performed at cross section locations. The

ﬂ Maximum dx = 5000 m specified in the Simulations specifications->Comp control
parameters on the Grid spacing tab is not used. You may include additional routing points
at different locations along a branch, but this will not be covered in this exercise.

In this exercise, you are using the simplest option, where no routing is used. Thus,
whatever water flows into the branch network at the boundaries or as lateral inflow, will be
transferred downstream in the same time-step.

MIKE SHE keeps track of and conserves mass and does not allow water to infiltrate from
the river to the groundwater if the river is empty.

5.3 View and add cross-sections from a DEM

Cross section data can be viewed either by selecting Cross sections under River network
and then Tabular view directly or by selecting a specific cross-section on the map and
then switching to Tabular view. Cross sections are displayed with blue on the map.

Note: The cross section may be difficult to see with the default symbol (black line). It may

therefore be necessary to change the Symbology to show the cross sections with dots
first.
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Cross-sections are saved to a cross-section file .xns11 (see the General tab) which can
also be viewed and edited using the MIKE11 editor. To view the file in the editor double-
click on the cross section file in Project Explorer.

In the cross-section dialog,

*  Cross-sections are identified by a Branch ID and a TOPO ID

+  Cross-section data are relative to the specified Datum value

. Cross-section data are editable in the table

*  The marker values in the table define the extent of the cross-section to be used in
the simulation

Sectiontype: | Open
J Resstance ~] Daum [e
- 1 Resistance
2000 & @167 57629 i Type: ive resstance
11083 £ 1 %918 57438 1 Distribution: Dt
Topo? 49 97.959 56.98 1
o Bfding Aiver 50 2 100 56.934 1
b Gfndeskov Creek o = . o 8 Datum
Hlderup Fiver
Hhter River 52 104082 757 1
b i Rver 53 106122 57535 1 ————Markers
S Creekc 54 108.163 56,068 1
55 110204 161 1
Branch ID Topo ID

t | Processed data plat

Cross-sections for Sej Creek need to be added to the model setup. Survey data are not
available but a detailed Digital Terrain Model (DTM) with a resolution of 1.6 m, available
from can be used instead. For this exercise the DTM
was resampled to 3.2 m to keep the file to a reasonable size. Note the example cross-
section file included with the training material was generated using the original file with the
fine resolution.

. First, set the coordinate system: ETRS_ 1989 UTM_Zone_32N. If you load the file
first, the DEM may be invisible. In that case select Symbology and turn the colours
back on.

*  Go to Map configuration->Background layers and click Append (+) to add another
layer. Browse and select .\GIS data\Sej DEM.asc. This may take a a few seconds
as the file is large. Move the layer up in order to see the DEM.

*  Go to Digital Elevation Model (DEM) and tick on the Use DEM for cross-section
creation.
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[] Use DEM for cress section creation

[] Use DEM for river tracing and catchment delineation
Digital Elevation Model {DEM)

File format: ESRI ASCl e

DEM: |C:\Users\niha\Documents\Kamp - Douglas new \MIKE HYDRO'GIS data\Sej_DEM.asc
Coordinate system: | ETRS_1989_UTM_Zone_32N v|  Z-value unit
Cross sections

Cross section creation
[ Use bilinear interpalation

[#] Use half cell size for spacing between points DEM cell size: 2
Maximum spacing between points: 10

Maximum number of points:

Cross section plots
[] Show DEM tegether with cross section plots

[] Use cell size for spacing between points
Spacing betwesn points: i}

¢ Click Map to view the DEM.

"
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A DEM can be defined in two file formats either as a ESRI ASCII or a dfs2 file. For ESRI
ASCII files the coordinate system and z unit for the file must be specified. If a .dfs2 is
chosen these parameters are taken from the dfs2 file definitions. By ticking Use DEM for
cross section digitisation different options are available in terms of interpolation and
number of points to extract per cross-section. It is also possible to set additional
parameters for using the DEM for river tracing and catchment delineation.

*  To extract cross sections for Sej Creek select Tools->Auto generate cross sections...
from the Tools menu

*  Chose Table of reaches in the combo box,
*  Then click on Import all and then unclick all the branches except Sej Creek
*  Specify an interval of 3000 m and a width of 100 m. Tick Use bilinear interpolation

. Click Generate and close the window

Auto Generate Cross Sections X
Oiption
@) DEM
(®) Equidistant interval: Interval: 1000
\nfidth: 75
() Location from shape file:
Field:
Use bilinear interpolation
() Survey points from shape file:
Z-value field: meter
Cross section D field:
Apply to
Branches: Table of reaches v
+ - Import all Import from file Include all Exclude all
Branch Lowest Highast ) Ll
Include name ch. ch Interval  Width
6 [0 |AamesvadC.. |~ |0 11083 1000 |75
o7 SeiCreek  |v |0 13976 |3000
W
Generate Save log Clear log Close

Click on the Map to view the location and length of the cross-sections.

In Tabular view click General -> Recompute all to compute processed data for the
new cross sections

Before saving the model save the cross section file using a different name. Go to the

folder location, right click on karup1.xns11, copy it, and then change the name to
karup2.xns11.
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. Go back to MIKE HYDRO and select karupl.xnsl11 in Cross sections -> Tabular
view

The cross sections are too wide and only the main channel geometry should be included
in the model. To constrain the extent of the cross section used in the simulation the bank
markers will have to be moved. This can be done in different ways. Embankment lines
can be added either by importing them as shapefiles or by digitising them in MIKE
HYDRO. Alternatively the markers can be modified manually either directly in MIKE
HYDRO or by using the older MIKE 11 cross section editor. For this exercise the cross
sections will be modified in MIKE HYDRO:

. Go to River network->Cross sections and select the Tabular view window
. Click Sej Creek/model cross and select Chainage O
*  Onthe Cross section properties menu select Raw data

Sej Creek is quite small and the DEM is not sufficiently detailed to include the channel
everywhere. As a guide set the width to app. 5-20 m.

On the displayed cross-section, you may need to enlarge the view by dragging the
window bigger. If more than one cross-section is visible, you can remove all but the
current one by right clicking on the cross-section plot and selecting Clear history.

. Click on a point in the cross-section that you want to define as the left hand top-of-
bank. Then, under Marker in the table, click on the highlighted box, [___1. (The point
will be red in the cross-section plot).

. In the dialog that appears, chose the (1) Left levee mark.

Select markers x

(1) Left levee mark
[ (4} Left low flow bank [1 (5) Right low flow bank
[ (2) Lowest point/River alignment

[ User marker

Concs

. Do the same for the bottom of the stream (2 Lowest point/River alignment) and right
bank (3 Right levee bank)

*  Repeat the process for all the cross-sections in Sej Creek
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Cross section properties

General Coordinates Raw data

Processed data

Took and plugins

40 50 60
Herizontal coordinate along cross section [meter]

+ - Update markers Sectiontype: | Open v
Marker s z Resistance ~| Datum: P 1]
4 1 45918 24.256 1 Resistance
47 45.939 24.167 1 Type Relative resistance
48 47.959 24073 1 Distribution Distrbuted -
4 4298 23,355 1
50 2 50 23641 1
51 51.02 21739 1
52 52041 23933 1
53 53.061 24132 1
54 3 54,082 24314 1
55 55102 24378 1 v
Sej creek, 9000
28.5
29
28.5
28
E 27.5
g 27 .
E 26.5 1 %
T 26
E 25.5
25
24.5
24
23.5
0 10 20 30 80 E 100

To ensure that the rivers fit together at the inflow of Sej Creek into Karup River, copy
the cross section from Karup River at 57054 and insert into the end of Sej Creek by
right-clicking on the chosen cross section, choosing Copy and then filling out the
Copy dialogue:

To

Branch
Topo ID

Chainage

Karup River
model_cross

57054

|Sej Creek

|model_cro55

13976

Cancel

Save the MIKE HYDRO project.
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5.4  Add boundary conditions

Boundaries can be viewed either by selecting Standard boundaries directly or by selecting
a boundary point on the map and then switching to Tabular view. The boundaries are
shown with red dots on the map.

Now take a quick look at the boundary specifications in the model. All the upstream ends
(Chainage = 0) are defined as Inflow boundaries with very small inflow. The downstream
mouth of the river is defined as a Q/h relation.

¢ Add another Inflow boundary for Sej Creek (Chainage = 0) with zero inflow by
—

selecting Add “ boundaries on the Boundary menu above the map and clicking on
the upstream end of the branch in the Map window

. Select Tabular and change the type from Water level to Discharge

*  Setthe input type to Time varying and in HD file name click the Browse button.
Navigate to .\karup.dfsO and choose the default item q=0. This specifies a very
small inflow of 0.005 m3/s, which will reduce the risk of the model running dry

Specifying a small influx as a boundary condition will prevent the model from running dry
and will also keep the model more stable. This is only an issue when using a regular
branch with Kinematic, Diffusion or Dynamic Wave formulations.

55 Run a simulation

To test that the model has been set up correctly, it is necessary to run the model. This
section shows you how to run MIKE HYDRO without MIKE SHE. This is a good check to
ensure that your MIKE HYDRO model works correctly. If you want to run the models
coupled, just start the MIKE SHE simulation as you did in the previous exercise.

* In MIKE HYDRO, run the model by selecting Run->Simulation from the main menu

*  Inspect the run messages on the Simulation pane and make sure the model run
finished without errors

If you want to get more interesting results, you can add more water through the
inflow boundaries.

» Navigate to Standard Boundaries in the Setup-tree and choose tabular
view

» For each inflow boundary condition, navigate to the file .\inflow.dfsO
(located together with the Karup.dfsO file that you have previously used)

» For Karup River choose the item “Inflow main” and for the remaining
branches choose “Inflow tributaries”

*  Remember to change the boundary conditions back before running the
model coupled with MIKE SHE!

While this adds more water to your model, there will still not be a lot of variation
when MIKE SHE is not included, as you are adding a constant discharge and
have no variations caused by precipitation, evaporation, infiltration etc.
However, it will show you more clearly the effects of different changes made to
the model, for instance adding a weir as described later on.
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For a fully hydrodynamic solution it is sometimes necessary to run it with an inflow
hydrograph upstream in order to test whether the model is stable for the full flow range. It
is also recommended to generate a result file with small boundary inflows that can be
used as a HOT-start file to prevent initial instabilities.

5.6 View the results

To check the model results, open MIKE View by going to the Start menu and select MIKE

View 2020->MIKE View

+  Load the results by selecting the file type as .resld and the select your latest
simulation results.

&0 MIKE View - [Horizontal Plan - HD_Simulation 1.res1d] - [m]

A LTy TS I T ve

[meter] Standard - HD_Simulation 1.res1d

e ) B |

6254000.0 }

6253000.0 f!
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6248000.0 J \ \d\

6248000.0 I{ \ P~

oo A “ :

6245000.0 ( Y \ E

£244000.0 -r(’ ") {

6243000.0 ’/: ; \ ‘%:

6242000.0 t } J

6241000.0 \ ; “\ /_ ;

8240000.0 ‘i

oot e

6237000.0 r \

6236000.0 \ )

6235000.0 > ; \

6234000.0 j

6233000.0 { L

6232000.0 \ \

6231000.0 \ -\

6230000.0 \

6229000.0 ‘t

6228000.0 \

8227000.0 h

6226000.0 l")

6225000.0 \

6224000.0 \ }

6223000.0 i b

490000.0 495000.0 500000.0 505000.0 510000.0 515000.0 520000.0 525000.0 E:[%:‘gtnenr]n

Ready 497290.94, 622693242

*  Click % to select and plot a time series of discharge at the downstream confluence.
This should show a constant stream flow of 0.035 m3/s

- Click B2 and select a branch to plot a cross section showing the water level. Click
on the branches you want to view and press the Ctrl key and click in the view to
complete the cross sectional plot

- Click ™ torun through the simulation and Il to pause at a desired time

The result below is from running MIKE HYDRO coupled with MIKE SHE.
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[meter] Water level - 2-1-2003 19:00:00

3000

76000

‘5050

2
/fnn
12000

A 1800

£f 42000

Karup River 08050 Karup River 806027600 Karup River Karup River 31755 -57054 1] Karup River 5704270454

00 5000.0 10000.0 15000.0 20000.0 250000 30000.0 35000.0 400000 450000 50000.0 £5000.0 80000.0 850000 700000

5.7 MIKE HYDRO — MIKE SHE coupling

Before running MIKE HYDRO with MIKE SHE, you must ensure that the new branch is
coupled to MIKE SHE. In the Boundary conditions -> MIKE SHE Couplings Dialog, you
specify which MIKE HYDRO branches will be coupled with MIKE SHE. You may choose
to include some of the river branches or all of them, or even just part of a branch.

+  Add Sej Creek by clicking * in Tabular view and selecting Sej Creek in the new line
that appears

. Change DS chainage to 13976 to couple the full length of the branch to MIKE SHE

+  Keep the default conductance option (Aquifer + river bed) and leakage coefficient
(10-5 sec?)

The coupling specification includes the definition of the river-aquifer exchange, including

ﬂ the river bed leakage coefficient. The river leakage can also depend on the hydraulic
conductivity of the aquifer material when the MIKE SHE cell size is much bigger than the
river width.

The exchange between MIKE SHE and MIKE HYDRO is one-way (default setting).
Overland surface water will flow into the MIKE river, but water will not flow back onto the
ground surface if the river floods. Overland flooding can be included, using one of two
options:

«  Cells can be defined by flood codes, where they will be flooded if the elevation of the
MIKE SHE cell is below the water level in the nearest river H-point.

«  Alternatively, you can allow overbank spilling. In this case, the river will discharge the
water onto the ground surface based on a weir formula.
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Include MIKE SHE coupling
Location Overandsiver exchange

Branch name. Weir coefficient
Upstreamehairoge: [0 | Vierexpanenal st
Downsiream chainage Min. upstream height above bank for full weir width
[ Allow averbank spilling from river to overland domain
Min. flow area for overbank spilling: 0
River-aquifer exchange Inundation
Conductance: Aquifer + river bed v Flood ares option No floading ~

— Pt ot

Linear reservoir exchange: | Ganing iver Eeilezeraiiy U=clicn

Bed leskage: Use v data
+ = % Includesllbranches
;
Branch name :Uhsamge Eémge Conductance L% e e :::w a’g"“gr“'f Sp“m - Flood area Food Bedtopography  Bed leakage
exchange Cosk area
1| O [Hadene Aver [~|0 10884 |Aufererve.. |v|1ED5  |Ganingriver v |183 15 01 0 Noflooding |~ |0 Usegiddata | v |Userverdata |~
2 |0 |GindeskovC... |~ |0 16290 | Aufererve.. v 1E05  |Ganingrver v |1838 15 01 0 Noflooding |~ 0 Usegiddata v |Userverdata v
3 [ |HalerRwer v |0 15473 Aquifer +ve... | | 1E05 Ganing fver  ~ | 1.838 15 01 0 Nofiooding |~ |0 Usegiddata | Userverdata |~
1 O BordngFver |~ 0 5196 paufer+mve_ || 1E05 | Ganmgmer v |183 15 01 0 Nofoodng |~ 0 Use grd dota | Use ruer cata
s O |kewpRver  ~|0 54 Aaufererve |~ | 1ED5 | Ganingrver v |1833 15 01 0 Nofooding |0 Usegiddata | v |Userverdata |~
6 |00 [parsvad Cre... |~ |0 1083 |Aufererve.. |v|1EDS  |Ganingriver v |183 15 01 0 Noflooding |+ |0 Usegiddata |v |Userverdata |~
» 7 |O[SeiCesk  v|0 1576 | Aquiferrverb v | 1E05  |Ganingrver v |1838 15 01 O o Noflooding |+ 0 Usegiddata |v |Userverdata v

You will run the MIKE SHE model in the same way as you did in the previous exercise.

First

*  open the karup_basic.she model or your own model from the previous exercise.
Remember to change the name.

»  change the river input to the MIKE HYDRO model you have created in this exercise.

Change the simulation period to 1 year and run the model

5.8 Add a weir structure

You will now add a weir to the main branch Karup River. The weir is a broadcrested weir
located at river chainage 29950. The width is 2 m and the sill level is 31.5 m AOD.

5.8.1 Add the weir dimensions

A number of different weir formulations are available: Broad Crested, Villemonte Formula,
ﬂ Honma Formula and Extended Honman Formula.
The geometry for broad crested weirs can be defined in two different ways:
. Level-Width: The weir geometry is specified as levels (relative to the datum) and
corresponding flow widths. The widths therefore define the area in which water can
flow, and the datum is the bottom level of the opening.

»  Cross Section DB: The weir geometry is specified as a cross section in the cross
section editor. A cross section with a matching branch name, Topo ID and chainage
must exist in the applied cross section file.

Note: Since a weir is defined as a structure causing a contraction loss and subsequently
an expansion loss, the geometry of the weir must be such that the cross sectional area at
the weir is less than the cross sectional area at both the upstream and the downstream
cross section for all water levels.

You can now add the weir. In this exercise, the weir geometry uses the Level-Width
option:

92 Fully Integrated Exercises - © DHI A/S



Building a MIKE HYDRO Model for MIKE SHE

MIKEaﬂ

Powered by DHI

. Go to River Network->Structures and select Weirs->Tabular view

+  Onthe General tab click ¥ to add the weir and change the ID to Karup_spill

*  Change the Branch to Karup River and set the chainage to 29950

. Leave the Type and Weir type unchanged

*  Under Geometry select Level-Width (default) and set the Datum (sill level) to 31.5.

. Specify the weir dimensions by clicking ¥ adding three lines:

- Level=0, Width =0
- Level=0.1, Width = 2
- Level=10, Width =2

General  Fow conditions

Location

Attribute

10: Karup_spil wleir type: Broad Crested ~
Eranch name: Karup River - Valve: Mone ~
Chainage: 29950 Flow block

Type: w

ypE FELET [ Apply flow factor Flow factor: 1
Graphics

Herizantal offset from marker 2: D Plot/Refresh Head loss

Inflowe: Outflow Free Overflow

Geomet

some Positive flow: 05 1 1

Type: Level-Width v )

Dot tesnetor 12 : :

+ -

Level Width
b1 |0
2 |01 2
3 |10 2
£ >
+ - x
D Branch Chainage Type Weir type Valve Geometry type

» 1 | O | Karup_spil Kap River |~ O Requiar + | Broad Crested | None « | Level-Width

*  To check the location of the weir in relation to cross sections go to the Map view. The

location of the weir is shown as a white square.

. If you click the Plot/Refresh button you can see the position of the weir in relation to
the closest upstream and downstream cross-sections.

There is a cross-section 50 m below the weir but none upstream of the weir. As survey
data is not available upstream of the weir, you can create a copy of the downstream cross
section at chainage 30000 and add it upstream of the weir:

*  Goto River network->Cross sections and right click on the cross section in Map view
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Select copy and specify a chainage of 29900
Then, save the setup
Go back to the Weir menu and select Flow conditions in the Tabular view.

Click Calculate Q/h relations

59 Re-run the model

94

To look at the effects of the weir the model will need to be re-run and the results loaded
into Mike View.

To quickly see the effects of the weir, run MIKE HYDRO with the inflow boundaries
changed, as explained previously.

If everything looks fine, run the model in MIKE SHE as before. Remember to change
the names of the MIKE SHE and/or MIKE HYDRO file if you want to keep your old
results.

Re-open Mike View and load the results

Click B and select Karup River. Press the Ctrl key and click in the view to complete
the cross sectional plot. Select Data type = Water level

Note: The Maximum dx = 10000 m specified in the Simulations specifications->Comp
control parameters on the Grid spacing tab is now used for the Karup River branch.
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[meter] Water level - 1-1-2003 02:53:00
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End of the Exercise
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6 Application Example: Impact of Groundwater Pumping

This exercise shows how groundwater pumping affects groundwater levels and stream
flow. The model is based on the MIKE SHE model for Karup developed in the first
exercise. If you have completed the first exercise, you can use your own model.

Otherwise, if you want to use an existing model, ensure that you have installed the
Example files in the previous Getting Started exercise, and have opened the MIKE SHE
exercises.mzp project file. Then,

. Go to the project folder Karup_Basic and open Karup_basic.she

In either case,

. Rename and save the model using the File/Save As... command to another name.
From now on in the exercise, we will refer to this model as YourFilename.she

6.1 Set up a new base case scenario

First, we need to setup and run a new model without groundwater pumping so we can
compare the results when we turn on the pumping.

6.1.1 Redefine the horizontal grid resolution
To analyse the effects of an abstraction we need to refine the grid.
A very powerful feature of MIKE SHE is that you can change the horizontal grid without
redefining your model parameters. Consequently you can perform sensitivity analysis of
your model grid and grid resolution in a way that is impossible with most other modelling
user interfaces.

Note: a finer grid is possible, but the simulation time will increase substantially.

Demo Note: The demo version is restricted to a maximum of 70x70 cells, so you will
not be able to pre-process or run the model with the refined grid but can continue with
the 1000m grid.

In the Model Domain and Grid Dialog of the Setup tab:

. Double the number of grid cells in the X and Y directions
«  SetNX =130 and NY =164

. Change the Cell Size to 250 m
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(O Catchment defined by Dfs File
(® Catchment defined by Shape File

|3ug|as new\MIKE SHE \Model Inputs\GIS Data\catchment.shp‘

Catchment size and orientation
NX: NY: Cell Size: Rotation:
130 | 164 | [250 lm [0 | [Deg. Counter clockwise]

Catchment origin and map projection

X0: YO0: Map Projection Type: i
[434073 |iml 6220000 |im] | ETRS_1383_UTM_Zone_32N v
[meter]

6260000 {oamm =
6250000
6240000 1-

6230000 -

2
1
Undefined Value

6220000 -
500000 520000
[meter]

. To ensure the model data can be converted to 250 m click on the L icon on the
main menu to start the pre-processor.

«  Verify in the pre-processor tab that all of the input data has been converted to a
250m grid

Note: a number of warnings may appear as values are missing in some locations along
the boundary. The pre-processor automatically fills in the gaps with neighbouring values.

6.1.2 Add a new stream flow observation

Add a new stream observation location so that you can observe the impact of abstraction
on the local stream flow.

*  Go to Storing of results on the left pane and select Detailed River Timeseries output

- Click the add button * to add a new line
+  Specify the Name= Q Pindsobro and change the Data type to Discharge

»  Type in the Branch name=Karup River and set the Chainage to 15000 m
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Minimum output time step: [hrs]
Name Data type Branch name Chainage IncI;.n:lbs. Observed Data File
1 20.05 Discharge Karup River 70454 = C:\Projects\...\Time\flow dfs0 | ... || Edit... |New..
2 |Q Pindsobro Discharge Karup River 16000 [m] | .. | Edit...

The specified Chainage needs to be at or close to the location of a MIKE HYDRO river
computational discharge point. The pre-processor will check the distance and if it is
greater than a prescribed tolerance a Warning will be written in the log file.

6.1.3 Add a new groundwater observation

Add a new groundwater observation location so that you can observe the impact of

abstraction on the local groundwater level.

*  Go to Storing of results on the left pane and select Detailed timeseries output

. Click the add button L=

to add a new line

«  Specify the Name= Obh_Pindsobro and change the Data type to Head elevation in
saturated zone

*  Type in the coordinates X=513950 and Y=6230800 and Depth=5 m

Minimum output time step: [hes]

Import...
o Incl.
Name Data type %: Y Depth Obs. Observed Data File
Bict Data
1 Obs 5 head elevation in saturated zone % 518003 | 6.22917 5 [¥] C:Wsers\... \Time\HeadObservations.dfs0 ... || Edi.. [New...
2 Obs 35 head elevation in saturated zone ¥ 507700 | 6.23836 5 M C:\WUsers\... \Time\HeadObservations.dfs0 .. || Edi.. [New...
3 Obs 37 head elevation in saturated zone M 511408 | 6.24164 5 [ [C:Wsers\..\Time\HeadObservations.dfs0 ... | EdR.. |[New...
4 Obs 65 head elevation in saturated zone M 502766 | 6.2463e 5 M C:\Users\... \Time\HeadObservations.dfs0 ... | Edt.. [New..
S Obh_Pindsobro head elevation in saturated zone %] 513950 | 6.2308e 5 | .. | Edk.. [New..
[meter]
6260000 fmmm
6250000 (S
6240000 -~
6230000 -+ -===oe- fsobro
6220000 - T
500000 520000
[meter]

6.1.4 Run the simulation

For this example the simulation period will be reduced to one year, as run times will
otherwise be too long:

* In the Simulation period menu specify the Start date and End date:

- Start Date: 1 January 2000
- End Date: 31 December 2000
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*  Onthe Toolbar, click on the L icon to re-run the Pre-processor and then on the

(711, . .
Water Movement icon to run the simulation

+  Click OK

Note if the simulation is taking too long it can be stopped by clicking the red button below.

17:20:18 => 2000/03/19,09:30 : Time step:55.15 min, avg: 3.01 hrs; SZ Iter/step: 12, avg: 5.6 -
17-20:18 => 2000/03/24,06:00 - Time , avg: 3.04 hrs; SZ Iter/step: 18, avg: 6.1
17:20:20 => 2000/03/31,05:44 : Time , =vg: 3.1% hrs; SZ Iter/step: 3, avg: 6.2

.85 hrs; S5Z Iter/step: 2, avg:
.78 hrs; SZ Iter/step: 10, avg: 6.1
8€ hrs; SZ Iter/step: 18, avg: €.7
36 hrs; SZ Iter/step: 3, avg: 6.
.77 hrs; SZ Iter/step: 3, avg: &.

2000/03/81, : Time in, avg:
2000/04/01,21:
120:27 = 2000/04/03,06:
17:20:23 => 2000/04/17,06:00 : Time
17:20:31 => 2000/04/18,15:55 : Time
17:20:33 => 2000/04/21,04:00 : Time .70 hrs; SZ Iter/step: 5, avg: 6.
17:20:35 => 2000/04/22,07:48 : Time in, avg: 2.80 hrs; SZ Itez/step: 3, avg: &.

: .75
2% 2000/04/22,07:48 1:20 hours [ ] +
validation ), Simulation f MIKE 11Execution Log [

*  Check the model run log files to ensure that the model finished without any errors.

: Time in, avg:
. avg:
. avg:

in, avg:

: Time

. avg:

RMORRR R R R W W

Bk

. Go to the results folder Result\Yourfilename.she - Result Files and double click on
YourFilename_WM_Print.log

»  Scroll to the bottom of the file and check whether the different model components
converged. Likely some of the components will have exceeded the maximum number
of iterations. The impact of this can be evaluated later with the water balance tool.

6.1.5 Check the stream flow and observation borehole time series plots

After successfully running the model:
*  Click on the Results Tab located at the bottom of the Navigation Tree and select
Simulation Results->MIKE 11 Detailed Time Series

*  Click Plot no. 2 to ensure the stream flow plot has been generated and looks
reasonable

Do the same for the groundwater observation borehole:
*  Click on the Results Tab located at the bottom of the Navigation Tree and select
Simulation Results->MIKE SHE Detailed Time Series

»  Click Plot no. 5 to ensure the observation borehole plot has been generated and
looks reasonable

6.2 Create a pumping scenario

Before adding the pumping well, you need to create another scenario setup so that the
model results can be compared.

. Rename and save the model using the Save As... command:
YourFilename_abs.she

The river results will also change, so we also want to create another MIKE HYDRO setup:

*  Goto the Rivers and Lakes menu on the left pane and click the button. This
will open the MIKE Hydro editor.
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. Select Result specifications at the bottom of the left pane click on the Standard
results tab

*  Change the HD result file name to KARUP_abs.res1d

. Click File->Save as.. on the main menu and save the file as karup_abs.mhydro

. Go back to the MIKE SHE Rivers and Lakes menu and use the browse button D
to select the new file

® karup I abs.mhydro EI@
- o Description - 4 Standard resulls
o Simulation period Use default True
o Time step control Result folder C:\data"MIKE SHEt
- o Computational control paramete eed s e Use default 1 False
=1 & Map corfigurations Result folder path RR result file RR_kanupres1d
o Coordinate system
v Backgmunj’:ap C:\dlata\MIKE SHE training materia\Karup_Basic\MIKE_SHE\Model\Model Inputs\MIKE HY Eg ﬁ:’i;'"g F %me aep
. of Image overays (1) F HD result file KARUP_abs res1d
o Shape file oveday (1) HD Storing F 24
« Digital Elevation Mode! (DEM) [] Use default names HD Unit Time step
- o Working area X AD result file AD_karup res1d
=+ & River network LIEEEE AD Storing F 1
# Branches (5) L] AD Unit Time step
- o Routing method (5) RR result filename: RR_kanpresid| |1
- o Mlignment lines (0)
- o Cross sections HD result filename: KARUP absresld 24
= o Structures
e ol Weirs {0) AD result filename: AD_kanup res1d 1
Culverts (0)
- of Fumps (0)
Gates (0)
Direct discharges {0)
Dambreak {0}
! b Frecmdnesas M Sl Use default result folder
d L} > i Use default result folder
< n +
Setup | Symbology  Result Map | Tabular -
Validation ,x

validation | Simulation

On the Toolbar, click on the RE icon to re-run the Pre-processor to ensure that the model
setup is correct.

Demo Note: You will not be able to rename your MIKE HYDRO-model if you are
using the demo version. Instead, to avoid overwriting your results, change the name
of the folder with the results. You can also rename some of the result-files if you find it
convenient.

6.3  Add the groundwater abstraction

In this step, use the Well Editor to add a well beside the stream.
. First go to the Saturated zone data tree item to include abstractions and tick Include
pumping wells

. A new item in the data tree, Pumping Wells, will now appear below Drainage.

*  Select Pumping Wells and click the button to create a new well database
file. This will open the Well Editor in a new window

*  Browse to the folder \Model Inputs and name the file MyWells.wel. Click Save
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MIKE SHE

=
ARR R R R R

1E3)

-

o Geological Layers
Geological Lenses
Computational Layers

o Drainage
Pumping Wells

o Storing of results

Extra Parameters

Setup Data |Processed Dala Resulis 7al = S

MIKE SHE Flow Model Description i~
Simulation specification

Model Domain and Grid

Topography Include pumping wells 1
Climate 3
Land Use Include subsurface drainage

Rivers and Lakes : [

Overland Fow Hydrogecologic parameter distribution

Unsaturated Flow @ Assign parameters via geological layers

Saturated Zone

() Assign parameters via geological units within layers

*  To open the database file click . This will open a new window with the
empty database file

The new file automatically shows a map of the catchment outline and the background
map specified in the Display menu. The overlays are carried over from the model Setup
Tab. You cannot add or modify overlays directly in the Well Editor. This must be done
from the Setup Tab. Right clicking on the map, allows you to control the zoom and a
number of other functions. The interactive map displays all of the wells in the well file.
Clicking on individual wells will select the corresponding item in the table of well locations.
Similarly, selecting an item from the list will change the icon of the well on the map to a
red square.

To add a new well,

- Click the button (=

. Next, in the Filter table, click the add button

to add a new line under Well locations. Then update the line:
Name = Pindsobro

Xcoor = 513900,

Ycoor = 6230750,

Level =62 m and

Depth =60 m.

and add the filter settings:
Top =25 m and
Bottom =15m
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ml Geo Layers Calc Layers
6260000 60~
62550001 % > 82
5 A 50-
6250000 By 5
§ ) :
6245000 3 s 40-
™~ 35-
62400001 £ s
30-
6235000 - 252
VS indsobro
6230000 RN 1 Y 201

X \“ ¥ 152 Aquifer
6225000 L 102
2 :
6220000 5:
500000 510000 520000
[m]
Wel locations OherWeiDta 5] X # & Fiter and pumpng defintion of selected wek OX*s
[ Top [ Bottom] Pumping File or Constant Rate Trraction]
T 7500 1500/0R8  [Csers. \ieabs a0

Edtew| 100

You can see the location of the well on the map view, and the well screen in relation to
the geological layers and lenses, as well as the numerical grid layers.

.+ To specify the abstraction rate, click the browse button [ and select abs.dfs0 and
select Item: Pindsobro. Click OK

5 Open
Loak in: | Time V| G ? ¥ [
~
* Mame Date modified
) W abs.dfs0 16/04/2018 18:35
Quickaccess gy gy, afsp 16/04/2018 18:35
- W HeadObservations.dfsD 16/04/2018 18:35
W PotentialEvap.dfs0 16/04/2018 18:35
Desktop W Precipitation.dfsD 16/04/2018 18:35
m
Libraries
This PC
@
Metwork
File name: abs.dfs0 ~
Files of type: Time series file (".dfs0) e
Select kem  Period Info.  kem Info. Constraints Info.
Title: |Abstraction
File Type: [Non Equidistant Time Axis
ltem
Any ltem Type Pindsobro .

Type

MIKE Zerc
MIKE Zerc
MIKE Zerc
MIKE Zerc
MIKE Zerc

Cancel

oK

+ To view the abstraction rate click the edit button [Edit]. Inspect the .dfs0 file

. Close the abstraction time series file
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MIKE SHE

From the Toolbar at the top and Import it also is possible to import well data from a tab
delimited ASCII file:

£ MIKE Zero - [tmp.wel]

P File Edit View Mask Impott Window Help
=]

= | Import Zeus Adm data

[m]

Import Zeus Lit data

; Import TAB delimited text file
1 4 " -y o

ﬂ Note: Zeus data is a specialized data format from the Geological Survey of Denmark and
Greenland.

Save and close the well file

To view a map showing the location of the abstraction in the MIKE SHE file tick Show
well location map

Run the pumping simulation

Before running the simulation, we need to add the results from the original scenario as
observations in the pumping scenario.

6.4.1

Add the stream flow result file

To see the difference in stream flow with and without abstraction in the MIKE SHE menu
system, add the result file from the model run without the abstraction to the stream plot at
Pindsobro:

6.4.2

Go to Storing of results on the left pane and select Detailed River Timeseries Output

On the second line tick Incl. Obs. Data

Click the browse button [--] and find your detailed time series results for the
previous simulation without the abstraction:
YourFilename_DetailedTS_M11.dfs0

Before closing the Selection dialog, under Items select Pindsobro

Click OK

Add the head result file

To see the drawdown caused by the abstraction, you can add the result file from the
model run without abstraction to the head elevation plot at Pindsobro.

Go to Storing of results on the left pane and select Detailed timeseries output
On the second line tick Incl. Obs. Data

Click the browse button [ and find your detailed time series results for the
previous simulation without the abstraction:
YourFilename_DetailedTS_SZ.dfsO

Under Items select Obh_Pindsobro
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*  Click OK

different ways, depending on whether observation data is available.

1. Inthe first case where no observation data is available, you can add the previous
results as observations.

2. Alternatively, you can add a new line below the results item and unclick the New plot
checkbox. This way it is possible to add both observation data and multiple
simulation results to the same graph. This may be useful during calibration where
you want to compare the results from more than one run to the observations.

I i Adding time series of modelled heads from another model run can be done in two

6.4.3 Run the simulation

On the Toolbar, click on the A7 icon to re-run the Pre-processor and then on the Water
[[11 . .
Movement icon to run the simulation

When the model is finished, check the log file to ensure the model finished without any
errors: YourFilename_abs_ WM _ Print.log

6.5 Analyze the change in stream flow

6.5.1 View the detailed time series output results

To view the stream flow at Pindsobro click on the Results tab at the bottom of the menu
and then Simulation Results-> Detailed River Time Series

The black line shows the discharge at Pindsobro for the current model run with the
abstraction compared with the results from the model run not including the abstraction
(plotted as observation points). It is clear that the abstraction is having a large impact on
stream flows all year round due to the vicinity of the well to the stream and high
connectivity between the stream and aquifer.

Q Pindzobro [m"3/g] o o
Q Pind=obro [m"3/s]

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Mov Dec
2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000

«  To view the groundwater level close to the Pindsobro abstraction click on go to the
MIKE SHE Detailed Time Series, Plot no 5

The graph shows a significant drawdown in head due to the abstraction.
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Obh_Pindsobro[m] o o
Obh_Pindsobro [m]
January I February I March I April I May I June I July I August ISepterﬂberI October IMo\u'emberIDecember
2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000
6.5.2 Calculate the difference in the stream flow
To calculate the difference in flow at Pindsobro without and with pumping:
*  Openthe YourFilename_DetailedTS_M11.dfs0 in the results file folder for the
refined (250m) model without abstraction:
»  Click Edit->Properties in the top Menu
*  Add two new lines to the table by clicking on the button and update the
new lines as follows:
: Item Information
1’\? Mame Type Unit TS Type
1 20.05 Discharge reter®3,/sec Mean Step Accumulated
2 C Pindsobro Discharge meter®3/sec Mean Step Accumnulated
3  Pindsboro_ab |Discharge meter®3/sec Mean Step Accumnulated
4 Diff_g Discharge meter®3,/sec Mean Step Accumulated| ﬂ
< >
Insert Append Delete Item Filtering. ..
*  Click OK
. From the top Menu, use File->Save as.. and save the file as Q_diff.dfs0
Now,
*  Openthe YourFilename_abs_Detailed TS M11.dfs0 in the results file folder for
the refined (250m) model with abstraction:
*  Select the second column named Pindsobro and copy the data to the clip board (*C)
. Return to your Q_diff.dfsO file and paste (*V) the data in the third column
. Save = the file
Now, you need to use the functions option in the Time Series Editor to calculate the
difference in flow between the two columns:
106
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«  click ' on the toolbar at the top

*  Type in the Current Expression textbox: i4=i2-i3

_ -
Calculations
Caleulator | Sub-Series

Edit Expression
Target ttem: :] Insert Operand:
Insert Operatar: :] Insert Function:

Expression
Curent Expression: 4=i243

4 II

ltem Mo

i1: 5t 20.05 (outlet)
i2: Findsobro

i3: Pindsobro_abs
id: Diff_Pindsobro

[0k [ camcel [ Hep

. Click OK and save file

This should immediately fill in the fourth column with the difference between Column 2
and 3.

6.5.3 Use the Plot Composer to plot the impact on stream flow
To plot the flows and the differences using the Plot Composer tool:
. Create a new Plot Composer document from File/New in the top menu or use the
New File icon, and then select the Plot Composer icon in the list of MIKE Zero

documents.

. Insert a new plot using either Plot->Insert New Plot Object and select Time Series

Plot or by clicking on the New Plot icon, | ==, and selecting the Time Series Plot

+  In the Properties dialog that appears, click New Item !
Q_diff.dfs0 from the list

and select your

. Under Any Item Type select Q Pindsobro, Q Pindsobro_abs and Diff_q

*  Click OK
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MIKE SHE

p
DFS File & Item Selection

Files

Path Modified |
v
v PotentialEvap.dfsd .\Karup_Basic\model\Model Input...  01/07/2016 13:50:15
v W TotalWBL.dfs0 .\Result\Karup_basicé.she - Resul... 05/09/2016 11:37:10
v W abs.dfsd .\Karup_Basic\model\Model Input...  08/09/2016 14:01:10
v W karup.dfe0 .\Karup_Basic\model Wodel Input:. )10 {07720 16 14:02:44
v W Karup_basic_II_2DetailedTs_52.dfs0 JResult\Karup_basic_II_2.she -...  29/03/2016 12:32:07 3
v W Karup_basiceDetailedTs_5Z.dfs0 \Result\Karup_basics.she -Resul...  20/09/2016 14:54:59
¥ W HeadObservations.dfs0 .\Karup_Basic\model\Model Input...  01/07/2016 13:58:32 |:|
1 [l | [

Items

Use MName Type Minimum Maximum

[ 5t 20.05 (outlet) Discharge 3.052744 8.532070

Pindsobro Discharge 0.647656 2.055191

Pindsobro_abs Discharge 0.556042 2.053560

Diff_Pindsobro Discharge -0.009168 0.209387

External File...
[ Help ] [ OK ] [ Cancel ]
L A

*  To change the appearance of the graphs, right click on the graphs and select
Properties. Click Curves and change line colours and markers

»  To save the graph as an image click View->Export Graphics->Save to Bitmap
*  Save the plot composer file as Q_diff.plc in the Model folder

You should get a plot looking something like this:

Q Pindsobro [m"3/s]
Q_Pindsobro Abs [m"3/s]
Diff [m"3/s]

237
2.2
2.1

2.0

o.eé
0s]
0.45
03]
021 —

01 e Lol e

T T T T T
January February March April May June July August September October November December
2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000
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6.5.4 Use MIKE View to calculate the change in stream flow accretion

We want to look at the effect of the pumping on stream flow accretion along the Karup
River at different times. To do this:

*  Use Windows Explorer to navigate to the results folder for the MIKE Hydro simulation
with abstraction, and then double click on the file: KARUP_abs.res1d

. Click OK to load all the data

ﬂ This should open the MIKE HYDRO result file in MIKE View. If for some reason this does
not work, you can also open MIKE View from the Program menu and load the file. If the
file is not yet loaded,
* add the MIKE Hydro result file (*.res1d) abstraction to MIKE View using the File/Add
in the top menu.
. Click OK to load the result file

Once MIKE View is open, with the results loaded, we want to plot the stream flow
accretion with and without pumping. To do this:

. Click the profile button b on the main menu to draw a profile

. Click on the middle branch of Karup stream (the branch turns green), press the Ctrl
key, click in the view, and select ‘Yes’ to create the longitudinal plot.

. Select Data Type=Discharge, and click OK

meter Standard - karup_vi_pumping.res1d

62500000 r"
62580000 \
&256000.0
&284000.0

Data Type Selection x
62520000

Result File karup_vi_pumping.resid ~
62500000

J ™
’, Data Type Discharge ~

e212000.0 /{ b
s A \\
6244000.0 +* ) \
C »
£240000.0 X
62220000 T
62260000 ~ 1
6234000.0 $ 4 3
£232000.0 \—‘
62200000
62280000
62260000 \
£224000.0 x E4

480000.0 485000.0 4900000 4950000 500000.0 5050000 510000.0 5150000 5200000 525000.0 5300000 535000.0 540000.0
[meter]

Now, to add the no-pumping MIKE Hydro *.res1D

*  Go back in the main window, choose File and click Add. Now navigate to your no-
pumping result file.

*  Click on the Options icon
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8% MIKE View - [Frofile FIot - RARUF.resid]

i FEile View Plot  Animatiop, Tools W
58 RaRaEY
~—~7

[meter]

Select the Graphical ltems tab

Click the Add button

MIKE SHE

. Then select Dynamic Item, File= Karup.res1d (your file

without pumping) and Item=Discharge. Then click OK.

Axis  Symbols and Fonts Graphical kems Tabular 'ems User defined indicators
0Xr +
Default Actual | Line | Line Display Marker| Market
Name || ey | o P TR |M"k‘" Symbol Nasce | | sty
1 Discharge | 1 [Solid [Color [Type1 =] [Cross 1 [3 [Transp
Insert Item
() static item
Top
(® Dynamic item
< File
Display of dynamic items Placement of legend obsResults.res1d
(@ Animation @ Mo legend Tem
ini Inside drawin Hi
() Minimum Q g Discharge
(O Maximum (O Outside drawing ~ H
[Z]Fill water [#] White back ground
[Joraw history
D Use second y-axis

You may want to chose a different line colour etc, change the Actual name, etc. Then

click OK

Note that you may have press the play button to see the plot.

To save the plot layout, right-click on the map view and select Save complete layout.

Save the file as Stream_flow_acc.CLA

You can then reload this file in future to recreate the plot.

To re-load the file click File->Reload complete layout...and select

Stream_flow_acc.CLA located in .\Result

Click OK and OK to load the MIKE HYDRO result files
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¥, Profile Plot - Karup_abs.resld =R

[meter] Discharge - 24-3-2000 00:00:00 — Discharge with abs.
04 T g [ Discrargs wimout abs

"'] """"""" Ty | Karup River 8080 - 27600 | H o0
f

t t t t t t t t t
0.0 2000.0 4000.0 6000.0 2000.0 10000.0 12000.0 14000.0 16000.0 18000.0 20000.0
[m]

6.6  Analyze the well drawdown

To evaluate the radius of influence of the well, we can look at the well drawdown in space
and time. To do this we need to subtract the no-pumping results from the pumping results.
There are basically two ways to do this.

. Grid Editor - The most direct way is to subtract the files from within the Grid Editor
e Grid Calculator - However, if you want to do this regularly, say at the end of every

simulation you can set up a script using the Grid Calculator Tool in the MIKE SHE
Toolbox.

6.6.1 Calculate drawdown using the Grid Editor
To calculate the difference in groundwater levels at Pindsobro without and with pumping:

*  Open the YourFilename_3DSZ.dfs3 with pumping in your Results directory, and
save the file to a new name (eg Drawdown.dfs3) using the File/Save as... menu

Demo Note: In Demo mode, you will not be able to save any changes to the dfs3 file.

function.
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Now, to subtract the two results files:

MIKE SHE
] - - 0 1 2 3 4 ~
H head elevation in saturated zone
' ' head elevation in saturated AL
zone [m] 162
B ~bove 20 15
= B 7s-80 160
2 ] 7o-75 159
£ 1 ss-70 158
2 [ ] eo-ss 157
o [ ss-s0 155
{=1
£ = ig - gg IE3 1370857 13.99703
2 O .45 154 1370557| 13.74161| 13.70557| 13.70557| 13.81663
= B .40 153 1370557| 13.72761| 13.71663| 13.70557| 1374247
5] B 0-3 152 1370557| 13.71336| 1370706 136934 1367089
B -0 151 1367322| 1371226 1370193 1366779 1361193
Bl 205 150 1367322| 1370863 1367879| 1365205 13.58804
B s 143 1362674 1366024 1369552 13.58825
=EE:DE:J13 145 1362674 1365602| 1364713 1361165
0 50 100 L] Undefined val 147 1362674 1365421| 1360748
(Grid spacing 250 meter) [ alue 126 1362672
06/01/2000 00:00:00, Time step: 5, Layer. 0 145
124 13.60743
143
142
141
140
B .
< >

*  Click Tools->Copy File into Data on the main menu

-
Copy File into Data

==

20 to 3D Layer Mapping
(@ Populate layerno: [0

Populate all layers

Sub-Area Position

File ta Copy
Filename: she - Resutt Files\Kanup_basic_ll_2_3DSZ.dfs3 ... |
ltem Mapping
Source item Maps to Tar
1 head elevation in saturated zone head elevation in
4 1 3

-origin: 0 =

fe-origin: 0 z

Time Position

Date origin: 2000/01,/01 00:00:00 5]

Time step origin: 0 $

Operation

Type: - v

Cancel

Help

_3DSZ.dfs3 results file

Select the File to Copy using the browse button B, and find your no-pumping
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*  Under Operation Type: choose the minus sign, “—*

. Click OK, and then Yes to continue

' ™y
MIKE Zero ]

@ This operation can not be undone, continue?

v Jome ]

e .

This process will change every value in every time step, by subtracting the two values.
The result will be a dfs3 containing only the differences.

You can view the new values by

- Clicking on the Time Step Forward and Backwards buttons £ | to view the
drawdown at different times

«  Zoom in by right clicking on the map

head elevation in saturated
zone [m]

B ~bove 0.0
-04- 0.0
-0.8--0.4
-12--08
-16--1.2
-20--186
-2.4--2.0
-28--24
-32--28
-36--32
-40--35
-44--40
-43--44
52--438
-56--5.2
B Below 55
[ undefined value

(Grid spacing 250 meter)

EENEREECOT O

70 75 a0 a5 a0
(Grid spacing 250 meter) H

25/01/2000 00:00:00, Time step: 24, Layer: 0

data. This is very useful for time varying distributed parameters, such as precipitation that
is interpolated from rain gauge data, or distributed recharge calculated by third party
programs.

B MIKE SHE includes sophisticated tools for managing gridded data as well as time series

*  The grid editor is a split window that can be dragged sideways to make the map
smaller or larger. The table of values on the right side reflects the highlighted grid
shown on the map.
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MIKE SHE

. Ranges of values can be searched for, selected and changed using the select and
- E R P

unselect tools, , plus the Tools/Set Value... Dialog.

Important Note

The grid editor is a generic grid tool for all DHI Software, and was originally developed for
the Marine programs MIKE 21 and MIKE 3. However, this often leads to confusion in the
node and layer numbering because MIKE 21 and MIKE 3 use a different numbering
system.

Node numbering: In the Grid Editor (and in MIKE 21 and MIKE 3) the nodes are
numbered starting in the lower left from (0,0), whereas in the MIKE SHE dialogs and log
files the nodes are numbered starting in the lower left from (1,1).

Layer numbering: In the Grid Editor (and in MIKE 21 and MIKE 3) the layers are
numbered starting at the bottom from 0, whereas in the MIKE SHE dialogs and log files
the layers are numbered starting at the top from 1.

6.6.2 Calculate Drawdown with the Grid Calculator

. To make this conversion, you can:

»  Click on the New File icon, or the File/New/File... top menu. Then select the MIKE
SHE toolbox.

=3 New File X
Product Types: Documents:

1 MIKE Zero
[ MIKE HYDRO e ‘ ‘ ‘ e
= MIKE 11 Flow Model Well Editor UZ Sail ET Vegetation Water Balance
[C5 MIKE 21 {.she) (owel) Propert...  Properties... Calculation ...
1 MIKE 3
£ MIKE 21/3 Integrated Models
= LITPACK

[£5) MIKE FLOOD g
= MIKE SHE Toolbox (.mst)

MIKE SHE Toolbox

. Now select Util/Grid Calculator

& MmsT = B ([

5 Data analysis
& File Converter
& kil
2 Grd Calcultor

-
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*  Add atitle if you want and then click

In the Calculation Setup dialog that appeatrs:

Calculation Setup X
Variable Name Data File Item From| To | ~
1 A C:\Projects\Karup\MIKE SHE Exercise 2\Result\Karup_250m.she - Result Files\Karup 25| | head elevati
2 B C:\Projects\Karup\MIKE SHE Exercise 2\Result\Karup_250m_abs_she - Result Files\Karu| .. | head elevati
3
4
5
6
7
8
0 W
Output specification
Description |D’3Wd°“"” |
File name |Drawdown dfs3 |
ltem type : Water Depth w [tem unit meter ~
Expression
AB
Example: (Levell - Level2) * Conduc
< Back Cancel Help

+  Browse to the two dfs3 head results files (pumping and no pumping) and add them to
the list of items with a Variable name of A and B. Note that you will need to change
the Files of type to Grid series files (.dfs3). And, you will need to select the Item Type

*  Add a Description, if you like, and a Filename, such as drawdown.dfs3
. Select the Item type = Water Depth, with Item Unit = meter

. Now set up the Expression “A-B”. Note that the variable names are case sensitive

. Then, click

*  Onthe last page, click to run the actual conversion.

«  Click OK in the window saying successful completion

. Click to close the tool.

The Grid Calculator is a very useful tool. It allows you to do complex, multi-step,
operations on files. It also has limited statistical functions, as well as a Group function.
Together these allow you to create sophisticated analyses, such as the minimum monthly
water levels over your simulation, or the number of days that are area is flooded per year.

You can also save the Toolbox tool and run it at the end of your simulation. You can also
run the Grid Calculator from a command prompt or batch file directly.
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6.6.3 Plot the drawdown using the Plot Composer

You can look at the drawdown in the Grid Editor, but if you want to create a report plot,
you can use Plot Composer.

However, the Plot Composer does not support dfs3 files. Therefore, first you need to
convert the drawdown file from a .dfs3 file to a .dfs2 file. To make this conversion, you
can:

»  Click on the New File icon, or the File/New/File... top menu. Then select the MIKE

ZERO toolbox
23 New File [
Product Types: Documents:
Ul MIKE Zero A
[ MIKE HYDRO ‘ ‘ ‘ -,
=1 MIKE 11 i ez Profile Series  Grid Series  Data Manager Plot Composer
= MIKE 21 (.dt0,.dfs0)  (.dtl,.dfs1) (.dfs3,.dfs... (.dfsu,.mes... (.plc)
= MIKE 3
=1 MIKE 21/3 Integrated Models ,‘ L
2= LITPACK - - . . '
=1 MIKE FLOOD Result Viewer Bathymetries Climate Ecolab Auto
&= MIKE SHE {.rev) {.batsf) Chan... {.ecolab) Calibrati...
e A A A A
EVA Editor Mesh Data Time Serieg MIKE Zero

{.eva) Genera... Extraction ... Compara...\ Toolbox (.mzt)

Time Series

. Now select Extraction/2D Grid from 3D files

B mazt [o [ = |[ =]

5 Concatenation

£ & Exraction
=% 2D Grid from 30 files
=% Profileseries from 20 files
=% Profileseries from 30 files

*  Add atitle if you want and then click
. Browse to your Drawdown.dfs3 file and click
*  Click again for all time steps, and click again for the default

layer

*  Specify a File Name and Title for the output file (eg Drawdown.dfs2). Then, click

* Onthe last page, click to run the actual conversion.
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Click OK in the window saying successful completion

Click to close the tool.

If you save the tool setup, then you can run it again without having to update it. You can
also run a saved toolbox setup from a batch file.

Now open a new Plot Composer document to create a drawdown map as you did before.

Click Plot->Insert New Plot Object and select Grid Plot

In the Grid Plot Properties menu select the Master File as Drawdown.dfs2
Select the Contours menu

Tick With labels and tick Plot color Legend

Click OK

To view the drawdown at different times first select the Animate menu at the bottom
left I="&.-!'.nin'|.5|te

> B (|0 X |

Use the play menu to move through the file

To change the colours or layout go back to the BEdt menu and right click on the
map. Select Properties. Play with the colour scale.

To add the stream to the map right click on the map and select Add/Remove
layers....

Click the add button | to add a new item

Change File type to Shapefile and in .\Model Inputs\GIS data select
Karup_system.shp

Click

To save the graph as an image click View->Export Graphics->Save to Bitmap

Click File->Save as.. and save the file as Drawdown.plc
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6.7  Analyze the change in water balance

You can use the water balance tool to look at the impact of the abstraction.

6.7.1 Create a new water balance document

4

. Click on the New document icon, , or the File/New/File menu

*  Select MIKE SHE and then the Water Balance Calculation (.wbl) document

x|
Product Types: Documents: E
#-= MIKE Zero
3 MIKE HYDRO . . ' ' .
3 MIKE 11 Flow Model  Well Editor UZ Soil  ET Vegetation [ Simple Shape
£ MIKE21 (.she) (.wel) Properti... Properties (... Editor (.shp)
=3 MIKE3
3 MIKE 21/3 Integrated Models A
3 LITPACK
£3 MIKE FLOOD | MIKE SHE
5 MIKE SHE {| Toolbo...
Water Balance Calculation
A
+  Click OK

* In the Project Explorer select the directory where you want to save the document

*  Then give the file a name (e.g. Waterbalance) and click on the Save icon =

6.7.2 Extract the water balance data

. Use the browse button and find the .sheres file from your simulation in your Result
directory

. Run the water balance extraction by clicking on the Extraction icon, 0 or by
selecting the drop down window Run and clicking on Extraction.

*  Check to make sure that the Extraction ran successfully, by looking for “Normal
termination” in the message window

6.7.3 Define a Chart water balance

*  As there will only be only item it is not ncessary to add more items on the
Postprocessing tab

+  Select Chart output: Total water balance from the list of available Water balance
types.

. Define a file name for the output file, for example Water_balance abs.txt
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. Run the water balance by clicking on the water balance icon run selected

postprocessing,

® Waterbalance.wbl EI@
[E o Posprocessngs
¥ Posiromins [Postprocessing
Water balance
Water balance type [Chan output: Total water balance -

Description: Chart output: General water balance of the entire model (depth-
integrated)

Qutput period
[¥] Use default period 2000/01/01 00:00 = |E| 2000/12/31 00:00 = E

Output Timeseries Specifications

Use default output time step 24 Incremental
Layer Output Specfications
Al lzyers

Sub-Catchment Selection Single-Cell Location

Output File
Tatfile:  she - Result Files\Water_balance_abs bt [:]

EEE

2000/12/27,00:00 |
2000/12/28,00:00 (
2000/12/25,00:00 (
2000/12/30,00:00
2000/12/31,00:00 (1000 %)

Mormal termination

100 %5 9 seconds

Validation j Simulation

The output is sent to an ASCII .txt file, and the graphic is generated automatically by a

I l The Chart output creates a graphic illustrating the water balance items (see next step).
utility that reads the txt file.

By default, the water balance is summed for the entire simulation period. However, you
can easily change the water balance period, for example, to create seasonal water
balances, or to remove the initialisation period.

If you defined the extraction on a sub-catchment basis, then you can select from the
available sub-catchments in this Dialog.

6.7.4 View the water balance output

*  On the Result tab, select the sub-item for the Chart output

. Click on the Open button beside the file path to create and open the water balance
graphic

*  To compare the water balance with abstraction to that without abstraction repeat the
same procedure for the model run without abstraction
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Total Error
0

Precipitation

77

Evapotranspiration
522

Snow-Storage change o & 0
3 Canopy-Storage chagge & -
Boundary flow
—_—
1

Base flow to River
0 144

Accumulated waterbalance from 01/01/2000 to 31/12/2000. Data type : Storage depth [millimeter].
Flow Result File : C:\Projects\Karup\MIKE SHE Exercise 2 results\MIKE SHE Exercise 2\Result\Karup_250m _abs.she - Re
Title : Karup  Text:

Total Error
0

Precipitation

a

Evapotranspiration
5

__Snow -Storage change & & 0
f Canopy-Storage change & -
4 Boundary flow
e
1

0

Base flow to River
146

Accumulated waterbalance from 01/01/2000 to 31/12/2000. Datatype : Storage depth [millimeter].
Flow Result File : C:\Projects\Karup\MIKE SHE Exercise 2 results\MIKE SHE Exercise 2\Result\Karup_250m.she - Result
Title : Karup ~ Text:

The water balances show that during the simulation period a total of 13 mm is abstracted.
Additional optional exercise: Play around with the different water balance options to

see how baseflow, drain flow and saturated zone storage may be changing over time due
to abstraction.
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Note that the water balance items are all normalised to units of mm, which allows for easy

ﬂ comparison between the different components. If you want to convert depths of mm to
volumes, you need to multiply the depth by the internal model area. That is, the total
model area minus the area of the outer boundary cells.

An easy way to calculate the internal model area is to load the pre-processed data into

the Grid Editor, select the Model and Domain item. Then, you can use the statistics
function in the Grid Editor to find out the number of internal (Grid Code = 1) versus

boundary cells (Grid Code = 2).

End of the Exercise
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7 Application Example: Convert to a Rainfall-Runoff model

This exercise shows how to convert the Karup model to a simple rainfall-runoff model that
uses the Linear Reservoir SZ and the Simple 2-Layer UZ methods. This model would be
suitable to run with the MIKE SHE Studio version.

7.1  Create a copy of an existing Karup model

To start this exercise, you can use either your basic Karup setup that you created, or you
can use the pre-defined karup_basic.she model. In either case, make sure to create a
copy of the .she model that you are going to use. Then, open the new .she model.

7.2  Change the numerical methods

The first thing to do is to change the numerical methods for the UZ and SZ model in the
simulation specification.

MHurmeric Engine

MIKE SHE

Wiater Movement (W]

Owerland Flow [OL)

Finite Difference

Rivers and Lakes (OC)
Ineaturated Flow (UZ)

2 Layer UZ w

Ewapotranspiration (ET)
Saturated Flaw (SZ]

Linear Reservoir

[ Inchude Advection-Dispersion (401w ater Quality

£ >

. Set the UZ method to the 2 Layer UZ and the SZ method to Linear Reservoir

This will change the data tree:
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7.3

7.4

124

MIKE SHE Flow Model Description
Display
o Simulation specification
« Model Domain and Grid
T _Subeatchments 3
opograp
o Climate
o Land Use
o Rivers and Lakes
\f Overland Flow
|

2 Layer U7 Soil
o ET Surface Depth
=] ‘( St rA e
o Interflow Reservoirs
%+ Baseflow Reservairs
\f GroundWarter table ror lower LUZ bound. ..

o Storing of results
o Edra Parameters

B

0-&

Setwp Data |Processed Daia | Resuis |

You will see six new entries in the tree:

MIKE SHE

*  Subcatchments — these are the catchment areas for each major stream branch

where you want to separate the flow
* 2 Layer UZ Soil - this is the soil distribution

. ET Surface Depth —this is the thickness of the capillary zone for the UZ soils
. Interflow Reservoirs — these are the shallow, short duration groundwater storages
- Baseflow Reservoirs — these are the deeper, long duration groundwater storages
*  Groundwater table for lower UZ boundary: this is used to define the thickness of

the unsaturated zone.

Define the subcatchments

2

The subcatchments define the discharge areas for the Interflow reservoirs. In this

exercise we will use a single subcatchment.

»  Set the Spatial distribution to Uniform

In the sub-tree item, there is only one option: Use default river links. This option is useful
in real models where you have a complex distribution of subcatchments. Also, the stream
discharge is uniformly distributed to the branches. This option allows you to be sure that

the water discharges to a specific reach.

Define the 2 Layer UZ model

This is in the Unsaturated Flow data tree item. In the 2-Layer UZ soil, use the Distributed
option and then use the same soils distribution file as in the original Karup model.

Browse to the Model Inputs\Maps\soils.dfs2

Then, for each soil use the appropriate soil properties from the UNSODA soils database

file.
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Profile 10: |Silt Loam [UMS0DA) Grid code value, 2

W aber content at saturation 043 Bypass constants )

t &=imurm bypass fraction (0.3
W ater content at field capacity 0.354

Water content for reduced 01
i aber content at wilting point 0103 bypass fow :

. - Lirnit on water content for (0,05
- W .

Saturated hydraulic conductivity 1.9e-006  |[mds] bypass flow
Soil Suction at wetting front 0z [m]

ProfilzID: [Sand (UNSOD)

Grid code value: 3

Water content at saburation 037 Bypass constants _
M awimum bypazs fraction |03
Water content at field capacity 0.o7g . PR
ater content for reduce

. . 01

W ater content at wilting point 0058 bypazs flow
. - I Limit on water content for | 0,05

Saturated hydraulic conductivity £.5e-005  |[m/s] bypass o
Soil Suction at wetting front 02 [m]

Profile [D: |Sand_l,l Loam [UMSODA) Grid code valus: 4

‘wiater content at saturation 037 Bypass constants _
I awimum bypazs friaction |03
Water content at field capacity 0.241 » S
ater content for reduce

- . 01

Wwhater content at wilting point 0076 bypaszs flow
; - Lirnit an water content far | 0,05
¥ / .

Saturated hpdraulic conductivity 6.1e-006  |[mes] sl
Soil Suction at wetting front 0.2 [rr]

The ET Surface Depth is the thickness of the capillary fringe. The default value is 0.1m.
For sandy soils this is probably suitable, but for finer soils is should be thicker.
The ET Surface Depth is used to extract ET directly from the groundwater table, if the
groundwater table is close to the bottom of the root zone.

However, in this exercise, the Linear Reservoir method does not calculate a water table,
Thus, this depth is not used unless the predefined SZ static water table is close to the
Root Zone, so you can leave it at the default value.

7.5 Define the Linear Reservoir groundwater model

7.5.1 Define the Interflow reservoirs

The interflow reservoirs are used to define the quick stream flow response after a rainfall
event. The interflow reservoirs have two outlets — one to the downgradient interflow
reservoir or stream, and one to the underlying baseflow reservoir.

If you have multiple interflow reservoirs, the higher number reservoir discharges “downhill”
into the lower number reservoir. Thus, the interflow reservoirs are essentially, topographic
zones around the streams. The lowest Interflow reservoir discharges to the stream.
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The Interflow reservoirs discharge into the streams branches within the subcatchment.
Typically, you will have multiple subcatchments — often with the subcatchments and
interflow reservoirs being the same.

In this exercise, we will use a single interflow reservoir. However, in most models this
would not be the case.

+  Set the Spatial distribution to Uniform

+  Setthe Specific Yield to 0.129, which is a representative value for the predominant
soil.

. Leave the rest of the default parameters for now.

7.5.2 Define the Baseflow reservoirs

The Baseflow reservoirs represent the slow groundwater discharge to streams. The
Baseflow reservoirs have only a single outlet — the stream.

By default the discharge from the baseflow reservoir is evenly distributed to all stream
nodes in the model. The “Use default river links” allows you to define where the baseflow
should be discharged.

In large catchments you may have several baseflow reservoirs representing large
subcatchments. In this exercise, we will use a single baseflow reservoir.

The two baseflow reservoirs act in parallel. Typically, one will have a longer time constant
than the other. This allows you to capture the slow drainage after a storm, as well as the
dry season flow. The Fraction of percolation to Reservoir 1, allows you to distribute the
amount of water percolating from the Interflow reservoirs to each of the two Baseflow
reservoirs.

+  Set the Spatial distribution to Uniform

»  Setthe Specific Yield in both reservoirs to 0.129, which is a representative value for
the predominant soil.

. Leave the rest of the default parameters for now.

7.5.3 Define the UZ lower boundary depth

The UZ lower boundary is defined by the water table. However, the Linear Reservoir SZ
does not calculate a water table. Thus, you need to define the water table depth for the
UZ lower boundary.

+  Set the Spatial distribution to Uniform
*  Setthe depth to -3 m, and
. Ensure that the Values relative to ground is checked on

7.6 Calibrate the model

126

On the Toolbar, click on the : icon to re-run the Pre-processor and then on the Water

WM . . .
Movement icon to run the simulation
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Evaluate the results and calibrate the model

You will see that the discharge results are not very good. The Linear Reservoir method is
guite easy to calibrate, if you understand how the different parameters affect the
discharge.

Essentially,

The time constants affect the rate of discharge from the reservoirs. You can adjust
the various time constants to match the shape of the observed discharge
hydrograph.

The initial depth governs the initial discharge rate. Usually, the Interflow reservoirs
are started dry. That is the initial depth equals the bottom depth. The Baseflow
reservoirs usually start with a small amount of water.

The threshold depth allows you to have storage that does not discharge to the
stream. In the Interflow reservoirs, water below the threshold will still percolate to the
Baseflow reservoir. In the Baseflow reservoirs, water below the threshold can still be
pumped.

The UZ fraction allows some of the water to be added to ET instead of the stream
The Dead Zone storage allows some of the percolation to be “lost” and not available
for discharge.

The default values for the time constants do not give very good results. You can play with
these values to see how they affect the hydrograph.

After playing with the values you can try the following values which give a reasonable
calibration:

Marne: |Global |

Specific Yield: Interflow Percolation
0129 Time Constant: Time Caonstant:

kil Depth ER— R

5

Ml Threshald Depth:

B ottam Depth: 5 [rn]

5 [m]

Mame; | Global |

Fraction of percolation to rezervoir 1; ||12 |

Fraction af pumping from reserair 1: |EI.5 |

Uze default river links
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Sectc
Time constant for base flow: [d]
Dead storage fraction: I:I

UZ feedback fraction:
Initial depth: [m]

Threshald depth for base flow: DI [m]
Threshald depth for pumping: IEI [m]
Depth to the bottom of the reservair: IEI [m]

Spedific yield: 0.129
Time constant for base flow: [d]
Dead storage fraction: CI

UZ feedback fraction:
Initial depth: [m]

Threshold depth for base flow: _ [m]
Threshald depth for pumping: [m]
Depth to the bottom of the reservoir: [m]

Evaluate the water balance

MIKE SHE

When you compare the water balance with the original model, you will see quite big
differences, for instance in the baseflow to the river and the infiltration. The first water
balance below is for the original model, while the second is for the Rainfall-Runoff model.
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Total Error
o

Precipitation
3942
/ Evapotranspiration
2512

Snmstcr;ne change 0
‘Canopy-5Storage change ;‘
0 Boundary flow
xqirivenmou SE
720 E——
2

Base flow to River
4

Accumulated waterbalance from 01/01/2003 to 31/12/2007. Data type : Storage depth [millimeter].

Flow Result File : C:\Usersinil arup - gl E SHE\Karup_basic.she - Result Files'\Karup_basic
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Total Error
o

Accumulated waterbalance from 01/01/2003 to 31/12/2007. Data type : Storage depth [millimeter].

Precipitation
3942

7/

Snow-5Storage change
0

‘Canopy-Storage change
o

MIKE SHE

Evapotranspiration

Flow Result File : C:\Users\niha\Documents'Karup - Douglas new\MIKE SHE'Karup_basic_RR.she - Result Files\Karup_basic_RR

Title:  Text:

End of the Exercise
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